IDA Indoor Climate and Energy 3.0

EQUA Simulation AB, January 2002
Version: 3.0
Copyright EQUA Simulation AB 2002

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

2

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

Contents
1.

About the Manual ______________________________________________________13

2.

News in ICE 3.0 _______________________________________________________15

3.

Basic Principles of IDA and IDA Indoor Climate and Energy __________________17
3.1.

Introduction ______________________________________________________17

3.2.

The three levels of user interface _____________________________________17

3.3.
Two quick simulations______________________________________________19
3.3.1.
IDA Room ____________________________________________________19
3.3.2.
Standard level _________________________________________________19
3.4.

Forms, dialogs and status bar________________________________________19

3.5.

Selecting an object from the database _________________________________20

3.6.

To open and edit an object __________________________________________20

3.7.

Save in the database _______________________________________________22

3.8.

Several views of the same object _____________________________________22

3.9.

An important object in the standard level – the schedule _________________22

3.10.
Output data in the standard level __________________________________23
3.10.1. Diagram ______________________________________________________23
3.10.2. Reports_______________________________________________________24
4.

IDA Room wizard ______________________________________________________25
4.1.

Getting started with IDA Room ______________________________________25

4.2.

Purpose __________________________________________________________25

4.3.

The model in general _______________________________________________25

4.4.
General usage of IDA Room _________________________________________26
4.4.1.
Starting a new case _____________________________________________26
4.4.2.

Save

______________________________________________________27

4.4.3.

Open

_____________________________________________________27

4.4.4.

Input data report

____________________________________________27

4.4.5.

Start simulation

_____________________________________________27

4.4.6.

Undo and redo

4.4.7.

Help and support

4.4.8.

Load from database

4.4.9.

Create building model

4.4.10.

Exit

___________________________________________27
____________________________________________27
__________________________________________27
________________________________________27

______________________________________________________27

4.5.
IDA Room input___________________________________________________28
4.5.1.
Database______________________________________________________28
5.

Getting started - Standard Level___________________________________________29

3

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

5.1.

Create a new system, building with a single zone________________________29

5.2.

Saving the system__________________________________________________30

5.3.

Selecting input ____________________________________________________31

5.4.

Select type of simulation ____________________________________________37

5.5.

Running a simulation ______________________________________________39

5.6.
Results___________________________________________________________39
5.6.1.
Selection of Time slice __________________________________________40
5.6.2.
Select Diagram ________________________________________________40
5.7.
Additional parameter selections______________________________________42
5.7.1.
The building___________________________________________________42
5.7.2.
The zone _____________________________________________________45
5.7.3.
Zone heating and cooling ________________________________________45
5.7.4.
The window ___________________________________________________47
5.7.5.
Input data report________________________________________________48
6.

Model description ______________________________________________________49
6.1.

The Primary system________________________________________________49

6.2.

The air handling system ____________________________________________50

6.3.

The zone models___________________________________________________52

6.4.

Airflows in the zone ________________________________________________53

6.5.

General information regarding zone cooling and heating room units _______56

6.6.
Waterborne heating devices _________________________________________56
6.6.1.
Floor heating __________________________________________________58
6.7.
Cooling units _____________________________________________________58
6.7.1.
Active beams __________________________________________________59
7.

8.

9.

CAD Import___________________________________________________________61
7.1.

Mapping data from IFC ____________________________________________61

7.2.

Create zones ______________________________________________________62

Getting started with the advanced level _____________________________________65
8.1.

Example 1: Presenting more data in an existing diagram _________________66

8.2.

Example 2: Night setback ___________________________________________67

Frequently asked questions and their answers _______________________________71
9.1.
Program management______________________________________________71
9.1.1.
How do I open and make changes in objects that are selected from lists? ___71
9.1.2.
How can I make my diagrams look better? ___________________________71
9.1.3.
How can I get a copy of a zone? ___________________________________71
9.1.4.
How do I select the type of calculation: temperature, cooling load or energy?71
9.1.5.
Can I compare results from different simulations? _____________________72
9.1.6.
How do I redefine an IDA resource, for example, a wall construction, from its
place of use without first locating it in the IDA resources window? _______________72
9.1.7.
How do I load lighting, equipment, occupant loads, and windows from the
database? 72
4

IDA Indoor Climate and Energy 3.0
9.1.8.
9.1.9.

EQUA Simulation AB 2002

Can I save entire zones in the database? _____________________________72
How do I get out of unsuccessful drawing operations?__________________72

9.2.
Geometry ________________________________________________________72
9.2.1.
How are zones connected to each other and to external faces_____________72
9.2.2.
Is it possible to manually connect a wall or part there of to an external surface
which is far away_______________________________________________________73
9.2.3.
How is the building orientated in relation to the floor plan and the North
arrow? 73
9.2.4.
How is a zone orientated in relation to the building? ___________________73
9.2.5.
Can I define a zone without having to consider the building? ____________73
9.2.6.
How is the information about the building’s height and depth used? _______73
9.2.7.
How can I give coordinates numerically instead of graphically? __________73
9.2.8.
Which view does the editor display for external shading, and how can I enter
side fins? 73
9.3.
Heating and cooling load calculations _________________________________74
9.3.1.
How do I carry out a cooling or heating load calculation? _______________74
9.3.2.
How can I design cooling in cases where the temperature is allowed to exceed
the setpoint?___________________________________________________________74
9.3.3.
How do I define a boiler, which corresponds to a district heating plant? ____74
9.3.4.
It seems to take too much energy to chill the supply air to a specified
temperature – is this really the case? ________________________________________74
9.3.5.
Why does the diurnal mean temperature for cooling load calculations not
change in the wizard when simulation is changed to, for example, January? _________74
9.4.
Airflow in IDA Indoor Climate and Energy ____________________________75
9.4.1.
How do I give the supply airflow at the standard level? _________________75
9.4.2.
How is a pure exhaust air system defined? ___________________________75
9.4.3.
Why are the supply air and exhaust airflows not exactly the same in the AHU,
when I select 1.0 for “Factor supply air / exhaust air” in the zone? ________________75
9.4.4.
How do I force the flow in a CAV system? __________________________75
9.4.5.
Why is the flow not fully zero when the air- or water system is off? _______75
9.5.
Energy calculations ________________________________________________75
9.5.1.
How do I cover the entire volume of the building with zones for an energy
calculation? ___________________________________________________________75
9.5.2.
We get suspiciously low energy consumption, what could be wrong? ______75
9.6.
Other questions about IDA Indoor Climate and Energy__________________76
9.6.1.
How do I build my own AHU? ____________________________________76
9.6.2.
Where is zone temperature defined for displacement ventilation? _________76
9.6.3.
Which air temperature is used for calculating the operative temperature for
displacement ventilation? ________________________________________________76
10.

Tips and tricks_______________________________________________________77

10.1.

Speeding up computation _________________________________________77

10.2.

Numerical instabilities____________________________________________77

11.

IDA Room reference manual ___________________________________________79

11.1.
IDA Room input data ____________________________________________79
11.1.1. Location Page _________________________________________________79
11.1.2. Glazing page __________________________________________________79
5

IDA Indoor Climate and Energy 3.0
11.1.3.
11.1.4.
11.1.5.
11.1.6.
11.1.7.
11.1.8.
11.1.9.
11.1.10.
11.1.11.

EQUA Simulation AB 2002

Internal shading page____________________________________________79
Envelope page _________________________________________________79
Page for wall and floor construction ________________________________79
Simple data tab ________________________________________________80
General tab____________________________________________________81
Geometry and horizon tab ________________________________________82
Walls and floor tab _____________________________________________83
Objects on room surfaces ________________________________________84
Loads and ventilation tab_________________________________________91

11.2.
IDA Room results _______________________________________________92
11.2.1. Project data ___________________________________________________92
11.2.2. Simulation results ______________________________________________93
12.

ICE Reference Manual________________________________________________97

12.1.
General ________________________________________________________97
12.1.1. Introducrion ___________________________________________________97
12.1.2. The Geometry in IDA Indoor Climate and Energy _____________________97
12.1.3. Objects in IDA Indoor Climate and Energy (in alphabetical order) ________99
12.1.4. Objects in IDA Indoor Climate and Energy (in hierarchical order) _______100
12.2.
Building simulation _____________________________________________101
12.2.1. The building’s form ____________________________________________101
12.2.2. Dialog for location_____________________________________________102
12.2.3. Form for climate definition ______________________________________103
12.2.4. Dialog for wind profile _________________________________________104
12.2.5. Choice of Simulation data _______________________________________105
12.2.6. Dialog for project data__________________________________________108
12.2.7. Edit the shape, orientation and surrounding of the building _____________108
12.2.8. Dialog for Pressure Coefficients __________________________________110
12.2.9. Ground conditions _____________________________________________111
12.2.10. Form for energy meter__________________________________________112
12.2.11. Dialog for energy price _________________________________________112
12.2.12. Edit the zone position and size in the floor plan ______________________113
12.2.13.
The building’s geometry ________________________________________114
12.2.14. Floor level dialog______________________________________________114
12.2.15. CAD import __________________________________________________115
12.2.16. IFC mapping _________________________________________________115
12.2.17. Default settings _______________________________________________116
12.2.18. Zone defaults _________________________________________________117
12.2.19. ASHRAE ____________________________________________________119
12.2.20. Weights _____________________________________________________119
12.3.
HVAC Systems_________________________________________________119
12.3.1. The Primary system ____________________________________________119
12.3.2. Air Handling System ___________________________________________120
12.3.3. Form for Heating Coil __________________________________________121
12.3.4. Form for cooling coil___________________________________________122
12.3.5. Form for choice of schedule _____________________________________122
12.3.6. Form for Heat Exchanger _______________________________________123
12.3.7. Edit temperature depending input _________________________________124
12.4.

Zone__________________________________________________________125
6

IDA Indoor Climate and Energy 3.0
12.4.1.
12.4.2.
12.4.3.
12.4.4.
12.4.5.
12.4.6.
12.4.7.
12.4.8.
12.4.9.

EQUA Simulation AB 2002

Zone form ___________________________________________________125
Dialog for controller setpoints____________________________________128
Operative temperatures _________________________________________129
Form for occupant load _________________________________________130
Form for Lights _______________________________________________132
Form for equipment load ________________________________________133
Convective internal mass________________________________________133
Thermal mass_________________________________________________134
Zone geometry________________________________________________135

12.5.
Walls, Floor and Ceiling _________________________________________135
12.5.1. Editing objects on a surface______________________________________135
12.5.2. Geometry for object (2D) _______________________________________136
12.5.3. Room units for cooling and heating _______________________________136
12.5.4. Active Beam _________________________________________________136
12.5.5. Floor Heating_________________________________________________137
12.5.6. Edit Cooling devices ___________________________________________138
12.5.7. Edit waterborne heating devices __________________________________139
12.5.8. Electric radiator _______________________________________________141
12.5.9. Form for window ______________________________________________142
12.5.10. Dialog for Glass construction ____________________________________143
12.5.11. Dialog for internal shading ______________________________________145
12.5.12. Editing an external shading ______________________________________146
12.5.13. Shading control _______________________________________________147
12.5.14. Form for balcony, marquee and screens ____________________________147
12.5.15. Form for Skylight _____________________________________________148
12.5.16. Form for opening (door) ________________________________________149
12.5.17. Chimney_____________________________________________________150
12.5.18. Leak ________________________________________________________150
12.5.19. Wall part ____________________________________________________151
12.5.20. Form for wall, floor and ceiling___________________________________151
12.5.21. Dialog for wall definition _______________________________________153
12.5.22. Dialog for surface _____________________________________________154
12.6.
Mathematical Model ____________________________________________155
12.6.1. Schema for zone (advanced level)_________________________________155
12.7.
IDA Resources and Database _____________________________________156
12.7.1. Forms for IDA-resources________________________________________156
12.7.2. Database objects in IDA Indoor Climate and Energy __________________156
12.7.3. Convert objects to resources _____________________________________157
12.7.4. Make a resource a database object ________________________________157
12.7.5. Convert database objects to resources ______________________________157
12.7.6. Dialog for Schedule ____________________________________________157
12.7.7. Editing a Profile_______________________________________________160
12.8.
Simulation Results ______________________________________________161
12.8.1. Dialog for choice of output ______________________________________162
12.8.2. Result – AHU (Air Handling Unit) temperatures _____________________163
12.8.3. Result – Airflow through the Air Handling Unit______________________164
12.8.4. Result – Primary system’s temperatures ____________________________164
12.8.5. Result – Primary system power ___________________________________165

7

IDA Indoor Climate and Energy 3.0
12.8.6.
12.8.7.
12.8.8.
12.8.9.
12.8.10.
12.8.11.
12.8.12.
12.8.13.
12.8.14.
12.8.15.
12.8.16.
12.8.17.
12.8.18.
12.8.19.

EQUA Simulation AB 2002

Result – Main temperatures______________________________________165
Result – Heat balance __________________________________________166
Result – Air temperature at floor and ceiling ________________________167
Result – Fanger’s comfort indices _________________________________168
Result – Air quality ____________________________________________169
Result – Daylight level _________________________________________169
Directed operative temperatures __________________________________170
Air flow in zone_______________________________________________170
Airborne heat flow into zone _____________________________________171
Result – Purchased Energy ______________________________________171
Result - Used energy ___________________________________________172
Result - Lost work _____________________________________________173
Result – Zone temperatures and loads ______________________________174
Result - Free energy____________________________________________175

12.9.
Diagnostic messages_____________________________________________175
12.9.1. Wall construction not defined in xxx ______________________________175
12.9.2. Intersecting zones xxx and yyy ___________________________________176
12.9.3. Setpoint errors ________________________________________________176
12.9.4. Zone airflow exceeds 20 air changes per hour _______________________176
12.9.5. Selected exhaust air flow in zone xxx is out of the recommended bounds …
176
12.9.6. U-value for envelope element exceeds 5 W/m2K _____________________176
12.9.7. Improper features______________________________________________176
12.9.8. Wrong temperatures ___________________________________________176
12.9.9. The overlapping area of zones xxx and yyy is too complicate ___________177
12.9.10. Unable to create a zone from non-adjacent IFC spaces_________________177
12.9.11. The wall between zones xxx and yyy is defined with different construction 177
12.9.12. The zone ceiling is above the roof_________________________________177
12.9.13. Shading control is not used in xxx_________________________________177
12.9.14. Synthetic climate is only intended for periodic simulations _____________177
12.9.15. The size of the device was changed ...______________________________177
12.9.16. The synthetic climate does not correspond to the selected simulation time _177
12.9.17. Do you want to remove producer-supplied information and use a simplified
model instead? ________________________________________________________178
12.9.18. The object xxx is not inside yyy __________________________________178
12.9.19. Overlapping features xxx and yyy_________________________________178
13.

IDA Reference Manual ______________________________________________179

13.1.
Overview______________________________________________________179
13.1.1. Introduction __________________________________________________179
13.1.2. IDA Applications______________________________________________180
13.1.3. Glossary_____________________________________________________180
13.2.
Modeling ______________________________________________________181
13.2.1. Levels of IDA systems. _________________________________________181
13.2.2. Working with IDA systems ______________________________________183
13.2.3. Quitting the Program ___________________________________________184
13.2.4. Navigation in the IDA system ____________________________________185
13.2.5. Working with objects___________________________________________187
13.2.6. Connections __________________________________________________190

8

IDA Indoor Climate and Energy 3.0
13.2.7.
13.2.8.
13.2.9.
13.2.10.

EQUA Simulation AB 2002

Parameter setting ______________________________________________194
Start Conditions _______________________________________________195
Boundary conditions ___________________________________________195
Preparing output ______________________________________________198

13.3.
Simulating_____________________________________________________199
13.3.1. Running a simulation___________________________________________199
13.3.2. Well-posed problem ___________________________________________199
13.3.3. Simulation data _______________________________________________199
13.3.4. Monitor Dialog _______________________________________________201
13.4.
View the system and the results ___________________________________203
13.4.1. View types ___________________________________________________203
13.4.2. View Options_________________________________________________208
13.4.3. Refreshing the view ____________________________________________209
13.4.4. To print, copy, or save a view ____________________________________209
13.4.5. Graphic Print Options __________________________________________210
13.4.6. Diagrams ____________________________________________________211
13.4.7. Reports______________________________________________________216
13.5.
Advanced features ______________________________________________216
13.5.1. Resources____________________________________________________216
13.5.2. Using a Database ______________________________________________219
13.5.3. Parameter mapping ____________________________________________221
13.5.4. Editing forms _________________________________________________222
13.5.5. Reports______________________________________________________223
13.5.6. Calendar Features _____________________________________________223
13.5.7. Multi-language support _________________________________________226
13.5.8. Batch mode __________________________________________________226
13.6.
Graphical Editor _______________________________________________226
13.6.1. Types of graphical elements. _____________________________________226
13.6.2. Object Symbols _______________________________________________227
13.6.3. Connection Line ______________________________________________227
13.6.4. Shapes ______________________________________________________227
13.6.5. Text elements_________________________________________________228
13.6.6. Fields _______________________________________________________228
13.6.7. Button ______________________________________________________230
13.6.8. Insert a new Element into a Document _____________________________230
13.6.9. Graphical attributes ____________________________________________231
13.6.10. Reading the cursor _____________________________________________233
13.6.11. Selection ____________________________________________________234
13.6.12. To move or reshape graphical elements ____________________________234
13.6.13. Copy, Cut, Paste and Delete _____________________________________235
13.6.14. Drag and Drop ________________________________________________236
13.6.15. Place for inserted element _______________________________________237
13.6.16. Snap to Grid__________________________________________________237
13.6.17. Edit lines ____________________________________________________237
13.7.
User Interface__________________________________________________239
13.7.1. The Main Window_____________________________________________239
13.7.2. The Menu Bar ________________________________________________239
13.7.3. The File Menu ________________________________________________239
9

IDA Indoor Climate and Energy 3.0
13.7.4.
13.7.5.
13.7.6.
13.7.7.
13.7.8.
13.7.9.
13.7.10.
13.7.11.
13.7.12.
13.7.13.
13.7.14.
13.7.15.
13.7.16.
13.7.17.
13.7.18.
13.7.19.
13.7.20.

EQUA Simulation AB 2002

The Edit Menu ________________________________________________240
The View Menu _______________________________________________240
The Insert Menu_______________________________________________241
The Object Menu ______________________________________________241
The Tools Menu_______________________________________________241
The Options Menu _____________________________________________241
The Window Menu ____________________________________________242
The Help Menu _______________________________________________242
About IDA dialog _____________________________________________243
The Toolbar __________________________________________________244
The Status Bar ________________________________________________244
Property Page_________________________________________________244
Messages ____________________________________________________244
Log Window _________________________________________________244
Pop-up Messages ______________________________________________245
Shortcut menu ________________________________________________245
Dialogs in IDA________________________________________________246

13.8.
Diagnostic messages_____________________________________________246
13.8.1. Can not create a math model _____________________________________246
13.8.2. Mapped or calculated parameter value is out of range _________________246
13.8.3. Parameter or variable is out of range_______________________________246
13.8.4. Missing value of parameter ______________________________________247
13.8.5. Missing subobject _____________________________________________247
13.8.6. Resource not found ____________________________________________247
13.8.7. Invalid number of objects _______________________________________247
13.8.8. No document path in source object ________________________________247
13.8.9. An error when searching a subobject ______________________________247
13.8.10. Rank error in previous results ____________________________________247
13.8.11. Unknown variable in the end file _________________________________247
13.8.12. Erroneous end value ___________________________________________247
13.8.13. The result file is missing ________________________________________247
13.8.14. The log file is missing __________________________________________247
13.8.15. The plot file is missing _________________________________________247
13.8.16. Unable to compose report _______________________________________247
13.8.17. Unable to insert _______________________________________________248
13.8.18. Paste failed___________________________________________________248
13.8.19. Unable to run solver ___________________________________________248
13.8.20. No default form _______________________________________________248
13.8.21. Saving an identical resource in a database __________________________248
13.8.22. Replacing a resource in a database ________________________________248
13.8.23. The object was not written to a database ____________________________248
13.8.24. The object in a database is corrupted: the value of the parameter not found 249
13.8.25. Do you want to disconnect the connection? _________________________249
13.8.26. Renaming of an automatically created object ________________________249
13.8.27. The plot file contains an unexpected number of data series _____________249
13.8.28. The plot file contains no column with the specified name ______________249
13.8.29. Can't find the source file ________________________________________250
13.8.30. The value is not a resource ______________________________________250
13.8.31. Wrong values! ________________________________________________250
13.8.32. Unknown object type___________________________________________250
10

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

13.8.33. Unable delete the resource: it is used ______________________________250

11

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

12

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

1. About the Manual
The manual consists of two parts. The ten chapters of the first part should be read through.
The remaining chapters are a reference manual. There is an index to help the reader locate the
information required in the reference part.
Chapters 4 and 5 give step-by-step instructions on how to run the program. Chapters 3 and 6
provide a general overview of program management and the actual simulation models.
Chapter 7 treats import of CAD data and chapter 8 is an introduction to working at the
advanced level. In chapters 9 and 10 a list of frequently asked questions and their answers are
presented together with some tips for getting optimal performance. Chapters 11 and 12 are
reference manuals for the IDA Room wizard and for general issues of the standard level of
IDA Indoor Climate and Energy (ICE). Chapter 13 contains reference material on general
IDA functionality.
Menu and field names appear in normal print but with capital letters in the general text.
Words in Arial signify parameter names in the model.
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2. News in ICE 3.0
The current version contains a large number of improvements, reflecting two years worth of
interaction with interested users. A large fraction of the improvements is a direct reflection of
proposals from users. Here we will touch on the main issues.
The most important improvement for most users is likely to be the treatment of arbitrarily
prism shaped zones. Walls can now be partly internal, partly external and partly overlapping.
Each wall contains information about it’s construction in the different cases and the current
location with respect to other zones and facades determines the construction used. A userdefined part of a wall can also have its own construction and connection properties.
The arbitrary geometry has also made it possible to develop an interface with the emerging
industry CAD standard IFC. This means that 3D models of entire buildings can be imported,
resulting in most significant time savings for the user.
Another major improvement is a complete re-design of the old cooling load wizard. The
present wizard, IDA Room, is used for both cooling and heating load calculation for single
rectangular rooms. IDA Room runs in Microsoft Internet Explorer as a separate process and is
also available directly over the Internet.
Some other improvements in 3.0 are:
-

Increased number and quality of reports, mainly energy
Shading calculation for diffuse radiation
Five-surface skylights in the roof
Multiple ventilation systems at the standard level, serving different zones
Multiple pre-defined air handling units
Supply air flow beams for cooling and heating
Water based floor heating
Chimney for natural ventilation
Awnings controlled by time and wind
Lights controlled by daylight at workplace
Time schedules for heat exchanger and boiler
Leaks through walls and floor at the standard level
Selectable controllers for room units, PI-regulator as default for cooling units
Extended resource database, e.g. more glazings and constructions
Extended climate database
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3. Basic Principles of IDA and IDA Indoor Climate
and Energy
3.1.

Introduction

IDA Indoor Climate and Energy (ICE) is a program for study of the indoor climate of
individual zones within a building, as well as energy consumption for the entire building. IDA
Indoor Climate and Energy is an extension of the general IDA Simulation Environment. This
means that the advanced user can, in principle, simulate any system whatsoever with the aid
of the general functionality in the IDA environment.
In normal circumstance, the system to be simulated consists of a building with one or more
zones and a primary system and one or more air handling systems. Surrounding buildings
might shade the building. The air inside the building contains both humidity and carbon
dioxide. Weather data is supplied by weather data files, or created for a given 24-hour period.
Consideration of wind and temperature driven airflow can be taken. Predefined building
components and other parameter objects can be loaded from a database. This can also be used
to store personally defined building components.
3.2.

The three levels of user interface

The user interface is divided into three different levels, with different support and scope for
the user. At the simplest level, called wizard, the user enters input into one or more forms,
which are displayed in sequence. The user is then given the opportunity of carrying out a
simulation directly, or transferring the data entered to the next level, called the standard level.
Chapter 4 covers the most important points for using the IDA Room wizard (Figure 3.1).

Figure 3.1. One of the tabs of IDA room
At the standard level, the user is given greater freedom to design his building. This level
defines geometry, material, controller settings, loads, etc., in a manner that should be easy to
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handle for the majority of engineers who lack any specific simulation knowledge. Chapter 5
takes the reader through the construction of a system at the standard level (Figure 3.2).

Figure 3.2. Main form for the building at standard level
The simulation model is no longer defined in physical terms at the advanced level, but in the
form of connected component models, whose meaning is defined by equations. At this level
the connection structure and equation parameters can be freely changed, and the individual
time evolution of the variables can be studied. Some of these operations are easy to carry out,
e.g., changing a proportional controller with a thermostat. Others are more complicated and
require a deeper knowledge of the models’ design. All equations, parameters and variables
can be examined at this level, but if changes are made in the model at the advanced level, they
are not reflected at the standard level. That is to say, changes are in many cases lost if a new
model is generated from the standard level. Use of the advanced level is introduced in chapter
8. There are also online help texts in the program for this purpose and several separate reports
that are available on the user’s web page, which is reached from the Help menu, IDA on the
Web, ICE User Support.
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Figure 3.3. Main Form for the building at the advanced level
3.3.

Two quick simulations

Before we go on, we will do two simple simulations in IDA Room and at the standard level to
assist understanding.
3.3.1.

IDA Room

To start IDA Room, first start IDA (double click on the IDA symbol

on the Windows’

in the toolbar. Your web browser is then
desktop) and then press the IDA Room button
started (IDA Room works best in Internet Explorer 5.0 or later) and IDA Room is loaded. It is
also possible to launch IDA Room directly from the Start menu of Windows: select IDA
Software and then IDA Room.
Here, the simplest possible simulation is done by pressing Start simulation in the first tab,
Simple data. IDA Room is designed to be usable by clicking and learning, i.e. reading the
manual should normally not be needed.
3.3.2.

Standard level

It is equally easy to make a first simulation at the standard level. After having started IDA,
press the button for a building with a single zone
in the toolbar. Then start a simulation, a
design summer case, by pressing the green arrow in the toolbar.
In the standard level it is more difficult (and not very efficient) to find one’s way around
without first reading the manual. Skim through the first chapters of the manual before you
start, especially this chapter and Chapter 5.
3.4.

Forms, dialogs and status bar

The Windows part of the program (everything but IDA Room) is built up around forms and
dialogs. The forms contain no Cancel button, i.e., there is no access to earlier versions of a
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form; only the current version and its parameter values exist. Forms do not lock each other,
and so several windows with forms can be open simultaneously (but only the one where work
is in progress is active). Moving its frame can vary the displayed form’s window size. The
scale of the form’s content can also be changed (zoomed). A form can be printed. Simulations
and many other operations can be carried out without having to first close open forms. Forms
can be transferred to other Windows applications as Windows Enhanced Metafiles (emf) as
editable vector graphics.
In IDA Room the forms are standard HTML pages and zooming cannot be done. However,
IDA Room is equipped with an unlimited Undo function.
The Status bar can be found at the bottom of the IDA window. In many cases it explains in
brief the significance of the different areas (list boxes, parameter boxes, etc.), that can be
found under the cursor in the different forms and dialogs. It is recommended that the user get
into the habit of reading the text in the Status bar if anything is unclear.
3.5.

Selecting an object from the database

All input parameters required for a simulation are grouped into so-called objects. A large part
of the input work involves selecting suitable objects from the database, checking them, and
making changes in their content. The majority of objects can be selected by using so-called
combo boxes. Figure 3.4 shows, for example, the combo box for the selection of envelope in
IDA Room. In this example, the user has first clicked on the arrow to the right to access the
list of alternatives. The list now consists of three alternatives – “Light”, ”Medium” and
“Heavy”. ”Medium” was the original selection. By pressing
in the toolbar of IDA Room, a
page is opened showing all the objects of this type contained in the database.

Figure 3.4 Combo box for selection of envelope
If a new object is now selected from the database, e.g., “Manual example”, it will be entered
into the project and the next time the list for envelope is opened, “Manual example” will be
displayed as well. If the parameters in any of these objects are changed, it will only have
consequences within the current project, i.e. the database contents remain unchanged. If the
system is saved, all the objects belonging to it are retained, both the used and unused.
All the objects available for selection in the combo boxes within a system are called IDA
resources. There is no overview of all the IDA resources in IDA Room, but at the standard
level the user can open a special box to display an overview of all the resources within a
project.
3.6.

To open and edit an object

Double clicking on objects selected in the combo boxes does not open them. This operation is
neither defined in the Windows standard nor in HTML forms. In IDA Room, the explanatory
text for a parameter is instead a clickable link. For the Windows part of the program (standard
and advanced levels) a small right arrow is available to the right of each combo box. Click on
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this and select Open in the displayed menu. The same menu is displayed if instead one clicks
with the right mouse button on the combo box.
The right button menu is used regularly in the Windows part of IDA and the user should
familiarize herself with using it. Some of the more advanced commands are only available in
the right button menu.
If, for example, the selected envelope object of the example above is opened in IDA Room
(by clicking on the link “Envelope”), a page for selection of walls and floors is displayed
(Figure 3.5).

Figure 3.5. Page for Envelope in IDA Room
Similarly, at the standard level, a dialog box for selection of parameters of the Location object
is displayed (Figure 3.6, below) when Open has been selected from the right arrow menu of
the Location combobox of the main building form.

Figure 3.6. Dialog for Location object
If a change is made in an object presented in a dialog, clicking on OK carries out the change.
If, instead, you want to create a new object with the changes and keep the old one unchanged
in the project, click on Save as… . A dialog is now opened where the object can be given a
new name and description. The Save as… button in the dialogs save nothing on disk, but in
the project only, as a new IDA Resource. The whole project is then saved on disk via Save or
Save as, on the File Menu.
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Save in the database

Objects of interest for future projects can be normally be saved in the database. The simplest
way to do this, in the standard level, is to right click on the object in the same way as to open
it, but select instead Write to database. If an object with the same name as the one selected
already exists in the database, you will be asked if you really want to replace the existing one.
If, instead, you want to save the object under a new name it is easiest to first create a copy of
the object with the desired name and then save the copy in the database. The copy can either
be created by using Save as… in the dialog as mentioned earlier, or by right clicking on the
object and selecting New resource…
It is not possible to save objects directly to the database from IDA Room. First, transfer the
IDA Room system, which contains the desirable objects to the standard level and then follow
the procedure above.
The database consists of two parts; one that accompanies the ICE system and one that is user
specific and is first created when a change is made in the database. The user specific part
remains unchanged between program upgrades. When the database is opened, this division is
not visible. All objects are displayed simultaneously. The user specific part of the database
“shadows” the one accompanying the ICE system. This means that if an object with the same
name as an already existing object within the ICE system database is saved, only the one that
the user has personally saved will be visible. And if a new version of the system database
contains a changed (perhaps corrected) version of the object the user has himself “replaced”,
it is still only his personal version that is visible.
3.8.

Several views of the same object

Many objects, at the standard and advanced levels, can be presented in a number of different
views. Views are almost without exception represented by different tabs in the window which
presents the object. In the rare cases where there are additional views to an object, views can
be selected from the View menu. Listed below are examples of frequently occurring
alternative views.
General

opens the standard form for the object

Disposition

view to give the advanced user an overview of all object
attributes and their values

Results

view for computed results for the object

Diagram

view to see a curve of the variables’ development over
time

Duration diagram

view to see a curve of the variables’ duration, i.e. results
sorted not with respect to time but in size order.

Report

a compilation in text form

Dialog

open in a dialog

Parameter

view for advanced users

3.9.

An important object in the standard level – the schedule

A schedule is used for giving time dependent input. Most schedules control when something
is turned on or off, respectively. In the case of “on”, the schedule takes the value of 1, and in
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the case of “off”, 0. Certain things, e.g., the size of a window’s opening can be “half open”,
and the corresponding schedule then takes a value between 0 and 1. It may be possible to
“force” other things, and this is expressed by letting the schedules value exceed 1. A few
schedules are also used to give, e.g., a temperature variation in time, that is to say, the value
may be far from the interval between 0 and 1.
Schedules are used both to give one day processes, and to give a process covering a whole
year, i.e., a few schedule objects in the database are only meaningful for long simulations
where week-ends and holidays are of great consequence. One day processes can be specified
with simplified or advanced definitions. A simplified definition is limited to a specified time
for turning something on (the schedule normally assumes the value of 1), and another for
turning off (schedule value restored to 0). This process is repeated every day of the year.
Advanced definitions provide the opportunity to specify a more complicated process over a
one day period, and to combine several one day periods into a one-year process.
Two schedules always exist in all systems: “Always on” and “Always off”, which constantly
give the respective values 1 and 0. To “replay” a complicated schedule to see the values given
at different times, right click and select Open with and then Diagram. By selecting a suitable
Time slice from the Options menu, focus on the time of year that is of interest.
In IDA Room, contrary to the situation at the standard level, the schedule is not a database
object. A schedule in IDA Room is graphically described in each place where it is used and it
always describes a diurnal process. The Loads and Ventilation tab contains several examples
of such schedules. When IDA Room schedules are transferred to the standard level, they can
be saved to database, just like any other schedule.
3.10.

Output data in the standard level

Output from the simulation is presented in so-called result objects in a list box. Two types of
results are presented here: diagrams and reports. A diagram shows the time development of a
few of the variables in the system. The reports are tailor made to summarize the results in
text. Both diagram and text results can be easily moved to other programs for presentation and
later revision. The simplest alternative is perhaps to press the Make report button in the
Results tab of the standard level. Then all generated output objects are compiled into a Word
document.
In IDA Room, a special HTML page with results is generated. This page can also be obtained
in easily printable and editable Word format.
3.10.1.

Diagram

A result object in the standard level is opened, for example, by double clicking on it. Below
the diagram itself there are legends for the variables. (Sometimes the window has to be
maximized or scrolled for these to be visible). Right clicking on the diagram itself and
selecting Properties opens a dialog with diagram and variable properties. Use this to change
scales, variable designations, colors, thickness, and indications. It is also possible to select
different types of diagrams, e.g., a duration diagram. A schedule that multiplies at each point
with the time series in the diagram can also be given for integral and duration diagrams. This
makes it possible to look at, e.g. duration, only during certain parts of the simulation period.
Diagram windows are, formally speaking, IDA forms. This means they can be zoomed ( View
menu), and also saved as Windows enhanced metafiles (Save picture in File menu) and the
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result inserted in, e.g., a Word document. In, for example, Word or PowerPoint the picture
can then be edited, text and colors changed, and so on.
The diagram of the zone’s main temperature in Figure 3.7 is weighted with a schedule
between 8 and 17, and sorted in duration form. Line types have also been adapted for black
and white printing. The diagram is imported to Word as an enhanced metafile.

Figure 3.7. A diagram object imported into Word in editable form
To focus on results for a certain period in a longer simulation, use Time slice in the Options
menu. Select a certain week, month or day, and the selection made will then apply to all the
diagrams subsequently displayed. Note that the selected Time slice only refers to presentation
of already available simulation results. First a simulation covering (at least) the interesting
period must have been done.
All diagrams can also be presented as text so that the information can be easily moved to
Excel, for example. To do this, select Report in the Tools menu when the diagram in question
is open.
3.10.2.

Reports

There are two other types of written reports obtainable, tailor-made summaries of the
simulation results listed among the result objects, and a report which documents the
parameters of a system. Display the latter via Report on the Tools menu, when the main form
for the system is selected.
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4. IDA Room wizard
4.1.

Getting started with IDA Room

The idea is that it should not be necessary to read any instructions to run IDA Room. To start,
click the IDA Room button
in the IDA Toolbar. After the web browser has been
launched, the first display the user encounters is called Simple data. You can select the most
important parameters here and then start a simulation.
Using three other tabs Geometry and horizon, Walls and floor and Loads and ventilation you
can then expand your case description.
4.2.

Purpose

IDA Room is used to calculate cooling and heating loads in buildings. Descriptions of the
room’s shape, heating and cooling devices and system operation are used as input data.
Calculations concern a summer or a winter design day case.
The results are:
A complete heat balance for the room, including cooling and heating power for design
conditions.
•= The resulting indoor climate with regard to air and the operative temperature,
including the directed operative temperatures.
•=

4.3.

The model in general

The building model used in IDA Indoor Climate and Energy and thereby in IDA Room is
very detailed and has been validated against measurements and other calculation software in
several projects. Unlike many similar programs a radiation balance is established based on
view factors for the entire room. This makes it possible to calculate the operative
temperature’s variation in different positions.
The correct dynamic temperature response of the building is calculated. In many other
programs this completely fundamental element of the heat balance is treated by rough
approximations.
IDA works with a variable time step. Sometimes it can be just a few seconds and at night
perhaps an hour or so. This means that the solution sometimes shows rapid transients, which
are realistic but unusual in these type of simulations, e.g. when the room air is heated up at the
start of the working day.
Air movements in the room cannot be calculated with this type of model. Calculating these
requires a CFD-model, which may contain a few million variables. The IDA-model for a
room includes a few hundred variables. As for any computation, the calculation time required
is strongly linked to the size of the model.
4.3.1.1.
A rectangular room
To simplify the user interface, IDA Room is limited to rectangular rooms. The exact geometry
of the room is seldom important for the accuracy. The most important factors are that the
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exposed room surfaces have the right areas and that constructions as well as windows and
glazing have been carefully described.
Complicated glazings are common, especially in the roof. For this reason a special object
called Skylight has been included in the model. By using one or more Skylights, light
apertures of various shape in the roof can be modelled correctly without complicating the
basic user interface.
4.3.1.2.
Design day calculation
A periodic calculation is performed, i.e. the room is exposed to an endless heat wave (or cold
spell). When no significant change occurs from one day to the next the calculation is
terminated and the results from the last day are presented.
The user can define the time of year for the simulation. For heating load studies, there is
rarely any reason to choose anything other than the default January day. However, for cooling
loads, periods other than the proposed July day can determine the correct sizing. There is no
automatic system to find the most severe time of the year.
4.3.1.3.
Surrounding rooms
In the basic case (Simple data tab) the room is considered to be surrounded by other rooms
with the same conditions. In the detailed description of the room there is a possibility to
define walls and floors as exterior surfaces or to link them to a given temperature.
4.3.1.4.
Weather data
Temperatures and moisture data for extremely hot and cold days have been included in the
database for some locations. In addition, many more locations may be found on the IDA ICE
website. The site is accessed from the Help menu of IDA, IDA on the Web, ICE User
Support.
For rooms with, e.g. a great deal of glass to the west or east, the cooling load design days can
occur in the spring or autumn when the sun is low (perpendicular to the window pane). In
these instances one should be aware that the outdoor temperature for an extreme summer day
may be an overly pessimistic assumption and the given outdoor temperature could be adjusted
somewhat. However, the outdoor temperature often has a limited effect on the indoor climate
for summer cases as the dominant loads come from the sun and from internal loads.
4.3.1.5.
Infiltration, thermal bridges, furniture, etc.
Infiltration when fans are running is given by the difference between the supply and exhaust
air flow. When the fans are off, a standard infiltration of 0.1 litres per second and m2 external
wall area is used.
No thermal bridges are included in the calculations. 20 % of the floor area is considered to be
furnished with furniture weighing 25 kg per furnished m2. None of these parameters can be
changed by the user in IDA Room.
4.4.
4.4.1.

General usage of IDA Room
Starting a new case

A new case is created automatically when you start IDA Room. All input data fields have
default values, and a simulation can be started directly by clicking on the button
to reset the program to its starting point, press the button
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Save

You can save the current case by clicking the button on the toolbar with a diskette symbol.
4.4.3.

Open

Click the button on the toolbar with a folder symbol to open an old case.
4.4.4.

Input data report

A complete formatted report with all the input data is generated if you click the report button
on the toolbar.
4.4.5.

Start simulation

The easiest way to start a simulation is to click the button on the toolbar with a green arrow.
In addition, on some tabs there is a button with the text "Start simulation" which provides the
same function.
4.4.6.

Undo and redo

The program features unlimited undo. By clicking the Undo-button on the toolbar you can go
“back” through all the previous commands issued. In the same way you can redo a command
by clicking on the Redo-button.
4.4.7.

Help and support

The button with a question mark starts the display of online help text. If you do not find the
answer to your question by reading through the help text or if you believe that you have found
an error in the program you can receive support through sending a message to
ICE.Support@equa.se.
Take care to provide sufficient information so that the support staff can recreate the situation.
Usually the best thing to do is to send a file with the actual case. Sometimes an HTML based
program can behave differently in different browsers. Consequently, it is useful if you state
the exact version of the web browser software you are using.
4.4.8.

Load from database

Press this button to load input data objects (resources) from the IDA database. All relevant
objects from the database may be loaded into IDA Room, but storing in the database is not
supported from IDA Room. In order to do this the case, containing the data object in question,
must first be transferred to the standard level.
4.4.9.

Create building model

This button launches the current IDA Room case in the standard level.
4.4.10.

Exit

When you have finished, log out of the program by clicking the button on the toolbar with the
red cross. If you exit in any other way you leave a lot of “trash” on the server that can make it
difficult for others to use IDA Room.
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IDA Room input

Input data is entered either from a single page under Simple data or in detail over a number of
pages. You can suitably start by entering Simple data and then refine your description on the
following pages. Once you have chosen to open one of the pages for detailed input data, you
cannot return to the Simple data.
Input data is primarily entered in three ways:
By entering figures in input data fields
By using combo boxes to select data objects
By dragging and moving objects in one of the applets (interactive figures)
All objects can be opened for closer inspection and modification. This is done by clicking on
the corresponding descriptive text (hyperlink).
4.5.1.

Database

IDA Room utilizes the standard IDA database. It contains ready made versions of the
following objects. A selection of objects should already be loaded as a new IDA Room is
started.
Location
Glazing
Internal shading
Envelope
Wall or floor
constructions
Materials

The geographical position of the building and weather data for a
severe summer and winter design day
Optical and thermal parameters of the window glazing
Data for solar shading in the plane of the window, i.e. curtains, internal
or external Venetian blinds etc.
Construction combinations for internal and external walls and floors
Descriptions of the different layers of a construction. The material and
thickness of each layer is stored.
Thermal data for building materials

If the data of a loaded object (a resource) is changed, a new object named “user-defined” is
automatically created. The new object is named by pressing the Save button and entering a
descriptive name.
New objects that have been created in IDA Room cannot be directly saved to the IDA
database. This is done from the standard level.
A full account of all IDA Room input fields is given in Chapter 11 of the manual.
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5. Getting started - Standard Level
5.1.

Create a new system, building with a single zone

To create a building directly in the standard level select New from the File menu in IDA .
This opens the New document dialog (Figure 5.1) in which a selection can be made between
the different IDA applications included in the installation. Select IDA Indoor Climate and
Energy in the list in the upper list box and Building in the lower. Press OK.
An alternative way to reach the same state is by pressing the button

in the toolbar.

Figure 5.1 New document Dialog
A new building is created and displayed on the screen in a form (Figure 5.2). This form
contains all the objects connected to the building.

Figure 5.2 The Building’s Form
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So far, in addition to the single zone the building contains standard versions of both air
handling unit and plant. These can be found in the list in the upper left list box, HVAC
System, in the building’s form.
Open the Site object (Figure 5.3) by clicking on the Site and shading buildings button. This
shows that the building has been given a standard form (rectangular) and height (6.0 m) and
that it is not shaded by any surrounding buildings. Coordinates for building corners are
displayed in a separate window (Property page) which is automatically opened.
The easiest way to change the orientation of the building is to turn the compass needle in the
upper left-hand corner of the Site widow. Select the compass needle and drag the small square
close to the compass’s North point (N) to the required position. The desired compass direction
can also be given as a numerical value (the angle of north in relation to the floor plan’s
coordinate system), if the symbol is first opened. How to change the building shape and
position is described in Section 5.7.1.
At the lower boundary of the Site form (Figure 5.3) input fields are located for building height
above ground and the height coordinate for the floor slab (negative under the ground level). In
addition there are buttons to change the size of the described site (View size) and to enter so
called wind pressure coefficients for the different building faces.

Figure 5.3 Site form
5.2.

Saving the system

To protect against mistakes, it is important to save the system often. Do this by selecting Save
default name in the File menu. In the dialog displayed, change default name to the desired
name, name, in front of .idm. In this way the file name becomes name.idm. Click Save to
finish.
There is no Undo function at the standard level. The same effect is reached by repeatedly
saving the system under different names, thus making it easy to return to a previous version.
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Selecting input

In this Section the most essential input parameters will be introduced. There are many
additional inputs that have been omitted here.
Open the zone’s form by double clicking on Zone 1 in the Zones list box in the building form
(Figure 5.4). Alternatively, one can double click on the zone in the Floor plan view. Begin by
giving the zone a height and a vertical position in the building by changing the Room height
and the Floor height from the ground parameter values in the Geometry box.

Figure 4.5 The Zone’s form
Click on the Floor plan button to return to the Floor plan and vary the position and size of the
zone. In the displayed window (Figure 5.5) the zone can be selected and dragged to the
desired place in the building. The co-ordinates for the cursor position can be found to the right
in the status bar of the IDA window. The origin for these co-ordinates is normally selected, as
here, in one corner of the Floor plan. The zone can also be rotated by pressing and holding the
Alt-key, while dragging a point on the square (See also Figure 5.25). Hold the zone a few
seconds in a position close to an exterior wall and it will automatically snap into position.
It is also possible to create non-rectangular zones by right clicking on the zone and selecting
Edit in the menu. The details of this process is further described in Section 5.7.1.
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Figure 5.5 Drawing of Floor plan with a zone
The size of the zone can be changed by first selecting it and then drawing one of the small
rectangles either in the corners or in the middle of its sides. It is also possible to give a
numerical value for corner positions in the Property page which is displayed when the zone is
selected (Figure 5.6).

Figure 5.6 Property page for zone geometry
The construction of the floor, ceiling and walls must be selected to be able to carry out a
meaningful simulation. The current zone relies on default constructions for the building as
long as no other information has been given. These construction defaults are accessed by the
Defaults tab in the building form (Figure 5.7).
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Figure 5.7 Defaults tab
In the combo boxes, first select Search in database… followed by the desired construction for
each element in the Load resource from database dialog (Figure 5.8). This will load the
selected construction from the database and it becomes directly available in all situations
where the Construction combo box occurs. This means it does not have to be loaded from the
database again but is available as an alternative when the arrow to the right of the
Construction combo box is pressed. Repeat the same procedure for each construction element.
Alternate between using already available constructions and loading new ones.

Figure 5.8 Load resource from database dialog
The selected construction can be opened (most easily by using the right button) and changed
from the combo box where they were selected. If a changed construction is saved under a new
name it can then be stored in the database for later use. (See Section 3.7.)
If one now returns to the zone form and an Enclosing surface is opened by double clicking
(either in the figure or in the list of Enclosing surfaces) the surface form is opened. Under the
advanced tab a special construction, different from the building default, for this particular
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surface can be given. Each surface may act as either external or internal, also partially. In
consequence, two different constructions may be defined for the surface. The construction
that is actually used is determined by the physical location of the surface, i.e. whether it is
adjacent to one of the building’s external faces. Note that this is true also for floors and
ceilings. The building height above ground which is given in the Site form (Figure 5.3)
becomes important for determining the role of a ceiling as internal or as roof.
If the zone floor coincides in height with the floor slab, it is regarded as being external. If the
floor slab is above ground (height coordinate is given in the Site form), the floor will be
regarded as facing a ventilated “crawl space.” If instead the floor slab is at or below the
ground level, the floor construction is connected to a ground model, which is accessed in the
Ground properties form in the General tab of the building form.
The floor, ceiling and walls forms have a tab Surface for defining objects on the surface.
Click on this in the exterior wall’s form if, for example, a window is desired. A drawing of
the wall (view from inside) becomes visible (Figure 5.9). Window size and position can be
changed in the same way as previously described for the zone. The colored box in the
surface’s lower left corner defines the origin of coordinates for the objects on the surface.
To insert a new object on the surface, e.g. an additional window, select New object... in the
Insert menu, and then window in the dialog displayed. Click on OK. Now place the cursor
somewhere within the wall drawing, hold down the left key and draw the window to the
desired size. Release the key.

Figure 5.9 Surface editor with window object
To select the type of glazing, the window object is opened (by double-clicking) and the
window form is displayed (Figure 4.11). Select glazing in the upper combo box in complete
analogy with the selection of wall construction as described above. In the example in Figure
5.10 the object 3-pane clear has been selected. Standard glazing for all windows can also be
defined under the Defaults tab in the building form.

34

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

Figure 5.10 The window form
As an example of possible loads, it is assumed there is one occupant and one light in the zone.
New in version 3.0 is that a freshly inserted zone already has some loads defined.
By first opening Occupant (Figure 5.11) followed by Lights (Figure 5.12) from the zone form,
select schedules for occupant presence and when the lights are turned on as well as the
electrical power emitted from the light. For example, select schedule 8-17 Monday-Friday
from the database in both cases, and a power of 60 W for the light.

Figure 5.11 The Occupant load form
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Figure 5.12 The Lights form
In order to insert an additional occupant load, with the zone’s form active, select New object
in the Insert menu followed by Occupant in the dialog opened (Figure 5.13). End with OK.
Repeat and select Equipment. When a load category has been selected, the Database button
will be enabled, to enable selection from the database.

Figure 5.13 Insert object for zone Dialog
There may be any number of occupant and equipment loads in a zone but only a single light.
Occupant objects are not only heat loads but act also as temperature sensors (sensors only if
the Number of people parameter is set to 0.)
Remove any additional loads except for the original occupant and light by selecting each
object and pressing Delete on the keyboard.
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Select also a suitable ventilation airflow at Exhaust air for CAV in the zone’s form (Figure
5.4).
If not previously done, select the location from the database in the Location combo box in the
building form (Figure 5.2). The Location object also holds climate data for design summer
and winter days. The design summer climate is used if Synthetic (summer) has been selected
in the Climate combo box.
In order to use hourly climate data, usually for a full year, select instead Search in database…
from the Climate combo box. Depending on the installation, there may be some climate files
available here. To access additional climate files from the Internet, select IDA on the Web
from the Help menu and then Climate files.
We will not go into any details about the air handling unit here but only open the form by
double clicking on Air Handling Unit in the building form (Figure 5.14).

Figure 5.14 Form for the standard air handling unit.
At the top left corner one finds the box Setpoint for supply air temperature. Within the box a
field for the, in this case, constant supply air temperature can be set. The final supply air
temperature will be somewhat higher than this value due to friction in fans and ducts and this
rise is given at the bottom right corner of the box Main parameters.
5.4.

Select type of simulation

In the standard level, there is no explicit choice between different types of simulations such as
cooling load calculation or energy runs. This choice is instead done indirectly by selection of
time period of the simulation (the period of measurement), parameters for installed equipment
and suitable result objects.
Let’s start with the time period. Click on Simulation data in the building form to open the
Simulation data dialog (Figure 5.15).
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Figure 5.15 Simulation data
In the Calculation tab, select between a periodic or a dynamic simulation. A periodic
simulation means a certain day is simulated a number of times until the system has stabilized
and no longer changes. The actual day’s date is given in the From date field. Click on the
Calendar button (Figure 5.16), to select a date.

Figure 5.16 Calendar
A dynamic simulation means that the simulation starts at a particular date and ends at another
date. Both these dates are indicated in the same way as the date for periodic simulation. How
the simulation is to be started must also be indicated for a dynamic simulation. For this
reason, another tab, named Startup, is added to the Simulation data dialog (Figure 5.17).
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Figure 5.17 Simulation data with Startup tab added
The Startup phase can also be periodic or dynamic. Make the selection in the same way as
above, but under the Startup tab. A periodic startup phase means that the selected day is
simulated a number of times until the system has stabilized. A dynamic startup phase means
that a selected number of days are simulated before the proper simulation starts.
How long the startup phase should be depends on the time constant of the building. The
heavier the building, the longer startup phase is required. Approximately two weeks should
however always be enough for realistic buildings. In both cases, no intermediate results are
saved from the startup phase.
Since we’ve chosen to work with climate data for a single design summer day here, a
dynamic simulation wouldn’t be meaningful (repeating the same climate day after day).
Select data instead for a periodic simulation of some summer day.
5.5.

Running a simulation

Start a simulation with the Run command in the Tools menu or by pressing
5.6.

in the toolbar.

Results

Several different types of results are obtained from an IDA Indoor Climate and Energy
simulation. Before defining these, you should however be aware of the possibilities of
selecting a so called Time slice for a closer study of available results for a specific time
interval.
There are actually three different “time intervals” to keep track of in the standard level:
1. The interval defined by selected climate data. Normally this is a 24 hour period, in the
case of design day data, or a year in the case of data from a weather file. However, the
latter may in principle cover an arbitrary time interval between a single day and a full
year.
2. The time interval defined in Simulation data, the simulation period. This is the actual
measurement period. Predefined energy reports for example will account for energy
used during the whole simulation period.
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3. The interval selected for diagram result presentation, called Time slice. If the
simulation has covered for example the whole summer, we may still want to examine
results for a single day, week or month.
5.6.1.

Selection of Time slice

Results from the entire simulation period can be displayed, or alternatively from a specific
sub-period. A specific period is selected in the dialog (Figure 5.18) which is obtained by
selecting Time slice ……in the Options menu.

Figure 4.18 Time slice
5.6.2.

Select Diagram

The result of a simulation is presented as diagrams and reports. There are several different to
select from. Make the selection from the Requested output dialog, in the building form. Here
are some examples:
1. AHU temperatures, which produces a diagram with the same name (Figure 5.19). It shows
exhaust air, supply air, and outside air temperatures.
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Figure 5.19 AHU temperatures
2. Power supplied by plant (Figure 5.20). It shows power supplied to batteries and local
equipment.

Figure 4.20 Power supplied by plant
3. Main temperatures (Figure 5.21). It can be seen how the mean temperature of the zone air
and the operative temperatures vary in time. The diagram contains an operative
temperature for every occupant load introduced into the zone.
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Figure 4.21 Main temperatures
To quickly create a Word document with all selected results, press the button Make report in
the Results tab of the building form.
5.7.

Additional parameter selections

This section defines a few additional possibilities for the user to vary the program’s input.
5.7.1.

The building

Double click on the IDA resources box in the building form to display the IDA Resources
form (Figure 5.22). It contains those objects from the database, which are or have been used
in the current building. These can be opened for examination and also changed and saved in
the database under a new name (see Section 3.7). Objects in use cannot be deleted while
other, no longer referenced objects, can be. Objects can also be changed from each place
where they are used.
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Figure 5.22 IDA resources
There is a Project Data box in the building form which opens a form with the same name
(Figure 5.23). A project can be documented here by entering information regarding customer
and responsible engineer etc. This information will be printed on output reports.

Figure 5.23 Project Data
To change a building’s shape, go to the Site form (Figure 5.24) and select it by clicking
somewhere in the building. Now the building can be edited in the same way as described
previously for the zone in the Floor plan. Double click instead and a so-called polyline which
defines the building becomes visible. The same edit state can also be reached y selecting the
building and then pressing
in the toolbar. A polyline consists of line segments and break
points, the latter marked by small rectangles. The polyline can be edited in five ways:
1. Its breakpoints can be drawn to the desired positions for the building’s corners.
2. Its line segments can be drawn to the desired positions for the building’s walls.
3. A new breakpoint can be introduced by clicking on or close to the line.
4. An existing breakpoint can be deleted by clicking on it.
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5. Breakpoints for non right-angled corners can be introduced by holding the Control key
down and simultaneously clicking on a segment of the line.
Click once with the right button and select OK to end editing, or alternatively press Enter (to
accept) or Esc (to cancel). Figure 5.24 has an example. A new breakpoint has been introduced
directly to the right of the middle on the building’s south wall. The wall to the right of this
breakpoint has then been dragged down and an angle-formed building has been created. The
figure shows the appearance before the editing has been ended.

Figure 5.24 Editing the building’s shape
Note also that the program automatically allocates names to all the facades created by the
introduction of new breakpoints. This allocation has not yet taken place in Figure 5.24 but can
be seen in Figure 5.25.
In the Site form, the building can also be rotated. Do this by holding down the Alt key and
drag a point within the building’s boundary. The building is then drawn along and follows the
same movement pattern as a playing card being pulled by a finger on a table. Friction between
the card and the table controls the card’s movement. Figure 5.25 illustrates an example of a
rotated building.
Position and height of shading objects can be defined in the same form. This is done with the
aid of a polyline along the object’s defining surface. Select Insert Shading building from the
Insert menu. Now create a polyline by clicking at its starting point, breaking points and end
point within the form. Click once with the right button and select OK to end. The desired
height is introduced into the box in connection to the shading object. Figure 5.25 illustrates a
polyline with two breakpoints and a height of 4.5 meters.
Note that coordinates for the selected objects are displayed in a separate window, the Property
page. One can also edit the coordinates in this window. Often it works well to first give a
rough shape graphically and then refine it by entering exact coordinates.
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Figure 5.25 Rotated building with shaded object introduced
5.7.2.

The zone

All mechanisms for editing the shape of the building are also available for zones. This is
however done in the Floor plan tab of the building’s form, where the zone in question first is
selected.
There are shortcuts to the forms for the floor, ceiling and walls in the zone’s form (Figure
5.26). Instead of going via the Enclosing surfaces list box, double click directly on the floor in
the box showing a bit of floor tiling in the figure. The Status bar, which advises which object
will be opened depending on where you are in the figure, is of great help here. The window’s
form (Figure 4.11) can also be opened directly in this way.

Figure 5.26 Zone form with certain selections made
5.7.3.

Zone heating and cooling

In order to calculate the zone heating or cooling load, a heating or cooling room unit with a
large (enough) capacity is inserted. Then the desired room temperature (controller setpoint) is
given, a simulation is done and the actually delivered maximum heat (or cooling) is recorded.
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The procedure is briefly described for the cooling case here. In the next chapter there will be a
more thorough discussion of room heating and cooling.
Open the ceiling from the zone’s form. Select New object… from the Insert menu and then
cooling device. The cursor now turns into a small rectangle. Drag a rectangle in the ceiling of
the approximate size of a chilled beam (Figure 5.27).

Figure 5.27 Surface editor for the ceiling with a cooling device and a light visible.
Double click on the cooling device and then on the button in the box Alternative input data.
Give a large but realistic Maximum power (Figure 5.28).

Figure 5.28 Alternative input data dialog for cooling device.
The next step is to enter a suitable setpoint for the controller. This is done in a single place for
all cooling devices of the zone by setting a parameter in the object Controller setpoints which
is accessed from the zone’s form. We will return to other aspects of this object in the
subsequent chapter, for now it is sufficient to set a suitable max value for the Comfort
temperature (Figure 5.29).
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Figure 5.29 The Controller setpoints dialog
Make a new simulation by selecting Run from the Tools menu.
After the simulation, the resulting room temperatures can be checked in the Main
temperatures diagram. The cooling power can be examined in the Cooling power to zones
graph in the Power supplied by plant diagram.
If the report Temps and heat balance in zone (Chose output, Tools menu) is selected, an
overview of zone conditions for the last day of the simulation is presented. At the bottom of
this report, the total max cooling (and/or heating) power by all room units is displayed.
5.7.4.

The window

In the window’s form, there is a box called Drawing view from the side to describe the
external window shading. Double clicking in this will open a Shading editor. A window
shading element is inserted by selecting New object…. in the Insert menu, with this form
active. Four different elements are available here (Figure 5.30).

Figure 5.30 Insert object for shading dialog
When the selection has been made, the drawing view is redisplayed and the cursor can be
placed beside the wall to the right of the window. Hold down the left key and draw the
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shading element to the desired size (Figure 5.31). The size and position of the element can
later be changed in the same way as for a zone in the floor plan drawing (minus rotation). To
create a Simple screen, draw instead a polyline in the same way as described above by figure
4.25. The small field with a number is reserved for the shading’s width (in the case of side
fins, give here the distance between them). Repeat the procedure for each shading element.
Together with the panes’ position in the opening, which can also be changed in the Shading
editor, the different shading elements provide a so-called external shading object.

Figure 5.31 Shading editor with marquee and balcony introduced
5.7.5.

Input data report

For complex cases, a there is a significant amount of data to be given. Some support for
keeping track of all this is provided by selecting Report in the Tools menu when the building
form is active. The generated report is a complete account of all data required for repeating
the simulation.
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6. Model description
This chapter treats the mathematical models of IDA Indoor Climate and Energy together with
some of their input forms. More information about the models can be found in the report
Models for Building Indoor Climate and Energy Simulation which can be downloaded from
the User’s page: Help menu, IDA on the Web, ICE User Support.
A building model consists of a single or several thermal zones, a single or several air handling
units and a primary system (a boiler and a chiller). When a new model is initiated at the
standard level, default air handling units and primary systems are inserted automatically. The
default systems have unlimited capacity for providing the zones with air and water at given
temperatures. By default, the supply air temperature is kept constant at 17 C°; the chilled
water temperature is 15 C° and the heated water temperature is a function of the outdoor air
temperature. For many studies nothing need to be altered in the HVAC systems.
This description deals firstly with the primary system, then follows the supply chain to the
AHU (Air Handling Unit), and finally to the zones.
6.1.

The Primary system

In the default configuration, the primary system consists of seven components (designated 1-7
respectively in figure 6.1): chiller (1) and a schedule (2) for its operation as well as a boiler
(3), a controller (4) for hot water supply temperature and a schedule (5) for night setback
operation. Also connected to the boiler is a schedule for its operation (6) and a schedule for
controlling the consumption of domestic hot water (7). To facilitate their access, the form also
presents some of the most important component parameters. As the symbols for the chiller
and boiler indicate, these components also contain models for accumulator tanks and
circulation pumps in their respective circuits. The six energy meters in the lower right corner
monitor energy consumption of various categories in the primary system.

Figure 6.1. The primary system in the default configuration
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The boiler consumes so called primary energy, e.g., oil and produces warm water with given
temperature and pressure. Boiler efficiency is constant and is provided by one of the
parameters in the form (Figure 6.1, Efficiency, boiler). The pressure is important in two ways:
to indicate pump energy for the electrical energy account, and to facilitate turning off the
circulation circuit by reducing pump pressure to almost zero. In the default configuration, the
circulation pump for the heating circuit is always in operation, but as it is considered to be
ideally pressure controlled, no energy is used when the flow is zero.
The setpoint for the hot water supply temperature comes from a special controller component
connected to the boiler. The controller provides a graph showing the setpoint as a function of
the outdoor air temperature (see Section 12.51, for a description of how this is done).
The chiller and its circulation circuit operate in a similar way, but differ in some aspects from
the boiler. The chiller uses electrical power to produce chilled water at two different constant
temperatures (but with the same pressure). The colder water (Figure 6.1, Coolant temp. to
AHU), normally 5 °C, supplies the AHU. The somewhat warmer temperature (Figure 6.1,
Coolant temp. to zones), normally 15 °C, goes to the zones (if there are any consumers there).
Temperature setpoints are normally provided as constants directly in the form.
Operation of the chilled water circuits can be time-controlled by means of a schedule, which
is connected (also invisibly) to the circulation pump. In the default configuration, the 'Always
On' schedule is selected, but other schedules can easily be selected or constructed (see Section
12.49 regarding schedule construction).
The boiler and chiller are both equipped with accumulator tanks. These masses, including
each distribution circuit mass, can be given within each component. In the vast majority of
cases, the selected mass has very little effect on the simulation result, but if the chiller is
turned off and the mass is unnaturally large for the simulated system, it may take considerable
time for the tank temperature to increase. On the other hand, numerical problems may arise if
the mass is too near zero.
6.2.

The air handling system

In the default configuration, the air handling system consists of the following components
(Figure 6.2): supply air temperature setpoint controller (1), exhaust fan (2), heat exchanger
(3), heating coil (4), cooling coil (5), supply fan (6), schedule (7) for operation of both fans
and a schedule for the operation of the heat exchanger (8). The two energy meters to the left
measure fan power and heat recovery in the heat exchanger. The unit provides temperaturecontrolled air at a given pressure. Some of the critical component parameters are also
presented on the form in order to facilitate access.
The supply air temperature setpoint is connected to the heat exchanger and both coils. All
three components have separate ideal control circuits, which independently strive to maintain
the setpoint. After the coils, the supply fan raises the supply air temperature by the number of
degrees specified by the user. (See Figure 6.2, Temperature increase, supply fan and system).
Provided there is sufficient capacity, the actual supply air temperature to the zones is therefore
made up of the setpoint plus the given temperature increase in the fan and duct system. The
model does not calculate actual heat loss and gain in the fans and ducts.
In the setpoint controller, three methods are provided for setpoint selection. In the default
AHU, the setpoint is set to constant, 16 degrees. The second alternative is to let the setpoint
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vary with time according to a schedule. Thirdly, an option is available where the setpoint is
calculated as a (user-defined) function of outdoor air temperature.
From version 3 several other alternative AHU:s are also available. However, here we will
focus primarily on the default unit.

Figure 6.2. Default air handling unit
The heating coil has two important parameters (double click to open): ETAAIR, the air side
temperature efficiency and DTLIQ, the desired water side temperature reduction. Capacity
control is achieved by adapting the actual efficiency up to the given maximum efficiency
level (given by ETAAIR). The necessary water flow is calculated and the water temperature is
reduced, if possible, by the desired number of degrees. There is no bypass on the liquid side;
control is achieved by simply restricting the water flow.
In the default configuration, the temperature efficiency is set at 1.0. There are two situations
when it may be desirable to change this to a more realistic value: when designing the actual
coil by means of simulation experiments, and when making energy calculations in cases
where the boiler efficiency is dependent on temperature conditions (this dependence is not
modeled in the standard boiler). In addition, the simplest and quickest way of removing the
entire coil is to set the efficiency to zero.
The cooling coil works in the same way as the heating coil, but is mathematically more
complicated because air dehumidification is calculated. For wet operation the given efficiency
is defined as (1 - ”bypass factor”), according to ASHRAE’s nomenclature. Physically, this
means that the state of the cooled air in the psychrometric chart is on a straight line between
the state for the incoming air and the apparatus dew point temperature on the saturation curve.
In the model, the average temperature of the liquid side defines the apparatus dew point. On
this line, the given efficiency indicates the status: 0 is no cooling whatsoever, and 1 indicates
maximum cooling, which also means that the air at most is chilled to (the arithmetical) mean
value of the coolant’s incoming and outgoing temperatures.
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Similarly, the heat exchanger is controlled by the actual efficiency selected by the model, up
to the maximum limit set by the user, so that the setpoint for the supply air temperature is
reached (if enough heat is available). The temperature of the (often chilled) exhaust air, which
may not fall below a certain level (TEXHOUTMIN parameter), sets another limit. This is to
avoid freezing.
The heat exchanger takes into consideration condensation on both the supply and exhaust
sides. During wet processes, the given efficiency is interpreted as (1 = ”bypass factor”), in the
same way as for the cooling coil, but the apparatus dew point for the heat exchanger is
defined as the incoming temperature for the opposite medium.
The fans have ideal pressure control with given setpoints and efficiencies, i.e.; they supply a
fixed pressure head. Basically, both these parameters only have significance for calculating
fan electricity consumption. The user gives directly the increase in air temperature and
pressure head, efficiencies or type of fan does therefore not affect it.
The fans operational schedule is connected to both the supply and exhaust fans. When the
control signal is zero, the fans supply a very low pressure head (for numerical reasons, greater
than zero). The fan schedule is also connected to all the air terminals in the zones. When the
fans switch off, all terminals are closed. This is to avoid a spontaneous flow through the
system caused by chimney effect. It is also possible to purposely model the chimney effect
through the system, but that is not dealt with here.
The fan schedule, like other schedules, gives normally values of 0 (off) and 1 (on) as output
signals. However, it is meaningful for the fan schedule to sometimes give other values,
thereby forcing ventilation flow. For example, if a value of 1.2 is given, all terminals will
supply a 20% higher flow than that which is selected locally in the zone. This applies to both
CAV and VAV systems. In the same way, a value of 0.5 results in half the flow.
The local terminal connection to the central schedule has no counterpart in actual systems, but
has been introduced partly to avoid unintentional spontaneous flow in the system, and partly
to permit forcing the flow in case of CAV.
The heat exchanger is from version 3.0 controlled by a schedule. To turn it off, the schedule
should give the value 0. A value 1 turns on the heat exchanger. No other values are
meaningful.
6.3.

The zone models

For the HVAC systems, the presentations for the standard and advanced user interface levels
are the same (for the distinction between standard and advanced, see Section 3.2). However,
in the case of the zone models, the presentations are completely different. This section
explains the principal features of the zone models, and also provides a brief overview of the
advanced level in this context. In actual fact, most users will never have to deal with the
advanced level, but it is useful to know it exists, and the physics are more easily explained
from the point of view of the advanced level. The main issues for the zone at the standard
level has been presented in Chapter 5.
IDA Indoor Climate and Energy provides two different zone models. One of these, the
climate model, is very detailed - it calculates for example a vertical temperature gradient. The
second model, the energy model, has a more conventional level of precision, and is based on a
52

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

mean radiant temperature. Both zone models are based on the same description of the
building, given in the standard level. All models of components in and around the zone, such
as windows, radiators, controllers, leaks, terminals etc., are common to both the energy and
climate models. The climate model is currently available only for zones with a rectangular
geometry. More details about the mathematical models can be found in Models for Building
Indoor Climate and Energy Simulation1.
Figure 6.3 shows a schematic view (advanced level) of a zone with the climate model. To
access this window, select Build model in the Tools menu, after entering all the information
required in the standard level. In this case, including a radiator, a cooling panel and external
shading. After the advanced level model has been generated, the user is able to select between
General (standard level) and Scheme (advanced level) tabs for zones as well as for building.
The various component groups are numbered in the figure as follows:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Supply and exhaust air terminals (VAV), with controller
Ceiling/Floor2
Air leak to ambient
Solar irradiation and external film coefficient, external wall
One external wall and three internal walls
Window and shading calculation component
Radiator with controller and wall section behind radiator (with solar irradiation)
Cooling panel with controller and ceiling section behind
The actual zone model in which radiation, convection and loads etc. are modeled

Figure 6.3. Scheme view (advanced level) of Climate zone model.
6.4.

Airflows in the zone

This section covers the models and input which determine the airflows through the zone. IDA
Indoor Climate and Energy differs in this respect from most other thermal simulation
1

which can be downloaded from the User’s page: Help menu, IDA on the Web, ICE User Support
This object is both ceiling and floor, since the model was generated to represent zones above and below with
identical conditions as the current zone.

2
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programs for buildings, because it enables the user to take account of natural ventilation, i.e.
flows driven by wind pressure and the chimney effect. However, the general intention is that
in standard situations this can be ignored, and the flows can be defined independent of
pressure.
In the default configuration, each zone has three paths for airflows: through the supply and
exhaust terminals and via leakage through the envelope. When two zones are placed adjacent
to each other and there is an opening in the common wall between them or when windows are
open, additional flow paths are created.
The terminals are always of VAV (Variable Air Volume) type. This means that as long as
there is sufficient pressure head, a given flow is maintained. In CAV (Constant Air Volume),
the simplest case, the control signal is set to zero (the terminal controller in Figure 6.3, point
1, is then excluded from the generated system). In a VAV system, a proportional controller
regulates the flow with respect to temperature, carbon dioxide or humidity levels in the zone.
Since flows through two of the three paths are given (either directly, by the user, or by the
controller), the size of the third flow, through the leak, is important only for the pressure in
the zone, and not for net flows. The pressure in the zone, in turn, is important only if there is a
connection with other zones, through other leaks or open doors. These are the only cases
where it is necessary to determine whether the size of a leak is appropriate.
There are two different forms for airflow in the zone. Figure 6.4 shows the zone form. On it,
those fields which are important to the flow are circled. Opening the Controller setpoints field
(first right click on the combo box or click on arrow, then select Open ), opens the other form
(see Figure 6.5).

Figure 6.4. The zone form.
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Figure 6.5. Control setpoints.
In the zone form, the user can select System type (CAV, VAV with temperature control, VAV
with CO2 control or VAV with humidity control). For CAV, the required airflow is given in
the zone form through Exhaust air for CAV3. The parameter Supply air / exhaust air,
determines the ratio between the supply and exhaust airflows. If 0 is selected here, there will
be negligible airflow through the supply air system. This is the easiest way to create a pure
exhaust air system. Leakage area at 4 Pa gives the size of the envelope leak, according to the
ASHRAE definition4. This leak is normally inserted in the external wall, 1 m above floor
level. (The height is only relevant for natural ventilation situations.)
In the combo box Controller setpoints, the user can select an object with a collection of
relevant zone-level control setpoints. The Control setpoints form (Figure 6.5) provides data
for zone climate quality requirements. Here, only those parameters, which are of importance
for airflows, are discussed. For a VAV system, the given minimum value of Mechanical
exhaust airflow provides the lowest allowable airflow, with the maximum value providing the
highest one. In the case of CAV, as was pointed out, the desired flow is given directly in the
zone’s form. If the chosen CAV flow falls out of the quality range provided in Control
setpoints, a warning is issued when the simulation is started.
The other circled values impact only upon the corresponding VAV control scheme. If the user
selects CO2 control, (see Figure 6.4), the airflow is varied in proportion to the CO2 content of
the air in the zone. A CO2 value, which equals or exceeds the given max-value (in Figure 6.5),
results in the maximum flow through the exhaust terminal, with a minimum CO2 value
producing the given minimum airflow. The humidity control function is entirely analogous
with respect to relative humidity.
Temperature controlled VAV systems function somewhat differently. Here, the maximum
comfort temperature value is used. Forcing of the VAV flow begins somewhat below
3

The button ”l/s m2” next to the input field enables input in various units.
ASHRAE Fundamentals provides a number of values regarding leaks according to this definition, as well as
conversion methods between various representations of leak sizes.

4
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(normally 1 °C) the indicated maximum value. Full exhaust flow (see Figure 6.5) is reached at
somewhat above (normally 1 °C) the maximum temperature value. The throttling range is
normally 2 °C, but can be selected at the building level, if so desired. (Outline View, SYSTEM
PARAMETERS.TEMP_THROTTLE).
The minimum and maximum comfort temperature values are also important for control of
radiators and cooling devices in the zone. This will be discussed in the following section.
When the fans are running (fan operation is governed by the Air Handling Unit, see Section
6.2), the infiltration flow becomes the difference between the exhaust and supply airflows.
(The latter is selected indirectly via Supply air / exhaust air.) However, when fans are shut off
a small flow through the ventilation system is maintained. This is partly to avoid numerical
instabilities, but also to model infiltration in this mode. This infiltration flow is given at the
building level, outline view, by the parameter . The unit is liters per second and m2 external
wall (incl. window).
6.5.

General information regarding zone cooling and heating room units

Local heating or cooling is supplied in the zone by defining room units on the walls, in the
ceiling, or on the floor. There is at the moment general devices for waterborne cooling (for
both radiative and convective devices), a chilled or heated beam, a waterborne radiator (or
convector), waterborne floor heating and an electric radiator. The models’ function will be
dealt with first, followed by a presentation of the input.
With the exception of the heated floor, all room units have ideal flow controllers that control
the mass flow between given max and min values in order to satisfy the requested room
temperature. Floor heating is by default temperature controlled by a PI controller, more about
this in Section 6.7.
The temperature setpoint for cooling devices is normally taken directly from the Controller
setpoints, max value for Comfort temperature5 (see Figure 6.5). The corresponding value for
radiators is the Comfort temperature min value.
6.6.

Waterborne heating devices

Heat emission from waterborne heating devices, except floor heating, is calculated using
P = K*l*dT^N,
where l is device length and dT is the temperature difference between the water and the zone
air. K and N are constants characterizing a device of a certain height.
Figure 6.6 has a heating device inserted on a wall surface. Its main form has been opened and
a dialog for alternative input has been opened from the form. In normal cases the values of K,
N and Height come from the database (gray colored text in the form). The user need only
designate surface area and the design water flow.
5

An exception is made when the air system is temperature controlled VAV. Waterborne cooling units in this
case have their setpoints displaced by usually 2 °C. (Can be given centrally via the parameter SYSTEM
PARAMETERS.COOLPANEL_OFFSET). This means that the airflow is first forced to max value, after which the
waterborne cooling unit sets to work.
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The radiator’s warm surface that is exposed to the zone is defined by the box that is drawn
when the unit is inserted on a wall surface. The size of this box has meaning for the heat
transfer. The total emitted sensible heat is always given by the expression for P. The division
between radiation and convection calculated based on the device’s surface temperature, which
is connected to the water temperature, and the given exposed surface. The zone “sees” a warm
surface and calculates the radiation and convection from this surface. The main part of the
remaining heat (needed to complete P) is emitted convectively directly to the air
(corresponding to convection behind a radiator). A small part of the heat goes to increase the
temperature on the portion of wall behind the heating device. The heat transfer coefficient
between the device’s surface and the wall behind is considered in the basic case to be
completely dominated by radiation and is calculated by the model.
Figure 6.6. A radiator on an external wall, its standard form, and a dialog for
alternative input.
To facilitate quickly adding new heating devices without direct knowledge of K and N, a
possibility for alternative input is given (see Figure 5.6, lower box). In this case, the physical
dimensions of the device are taken directly from the box defined by the user. The values for
design mass flow and K are calculated from the power given by the user at the specified
temperature conditions. The user also provides a value for N in this case. Note that K is
calculated from the information given in the alternative input. This is thereafter the value for
K. If the size of the graphical box is later changed, the device is likely to have an unintended
maximum power. Note also that the actual maximum heating capacity of the device will vary
with actual room and supply water temperatures. The temperature conditions given in
Alternative data are only used to calculate K and have no impact on the simulated supply and
return water temperatures6.
6

The actual water supply temperature is given by the boiler; the return temperature will vary with the actual
massflow through the unit, the current room temperature and the size (K value) of the heating unit. However, if
actual temperature conditions are made to coincide with those given in the dialog, exactly the given power will
be emitted.
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Floor heating

If a floor heating object is inserted on the floor of a zone, the floor construction for this area is
divided into two parts, above and below the heated layer. Between the two a heat exchanger
model is inserted corresponding to the piping layer. Heat from the layer is not accounted for
among resulting heat from room units but will appear coming from the structure. Quite often a
floor heating circuit will heat the room below almost as much as the room it belongs to.
The floor heat model assumes that the heated layer can be treated as an infinitely conductive
plane in the floor slab, i.e. all 2D effects are disregarded. Heat transfer is calculated with a
logarithmic temperature difference between the fluid and this plane of constant temperature.
The user supplied total heat transfer coefficient between the fluid and the plane, includes
1. Convection between medium and tube wall
2. Heat conduction through the tubes
3. “Fin efficiency” corresponding to the distance between immersed tubes or actual fins
The floor heating circuit is regarded to have it’s own three-way valve and pump circuit
keeping the massflow constant. This massflow is computed from the user supplied
parameters, Design power output and Temperature drop across coil (Figure 6.7). Emitted
power is controlled by varying the supply water temperature between the given Maximum
temperature into coil and the actual layer temperature. PI or P control can be selected (PI is
default). An alternative Always on is also available, which will keep the temperature of the
supply water equal to the boiler supply temperature up to the given Maximum temperature.

Figure 6.7 Floor heating form
6.7.

Cooling units

The Cooling device is used for radiative and convective units which performance parameters
are constant. A fan-coil can for example be modeled, provided the fan is considered to be
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running permanently. Cooling units operate completely analogous to waterborne radiators,
with the exception of a few differences in input, which are discussed here.
Figure 6.8. A cooling panel on the ceiling surface, its standard form, and a dialog for
alternative input.
Here, the height of a radiator corresponds instead to a Module width, to which K and N refer.
The total length is calculated as the given box’s area divided with Module width7. There is a
difference in that the heat transfer coefficient between the back of the device, and the surface
behind (often the ceiling) is given directly in the main form. If an (arbitrary) negative figure is
entered, the heat transfer coefficient is calculated in the same way as for the heating device,
i.e., as if all heat transfer was done by radiation. This is a good approximation for a device
that has no insulation at all.
The dialog for alternative input has somewhat different parameters for cooling units.
Absorbed power and temperature differences between air and water are given for two points
on the power curve. For max power, the temperature drop of the water is also given.
6.7.1.

Active beams

Active beams serve both as supply air terminals and as cooling devices with significant
convection. Their performance depend on the amount of supply air that is passed through but
they normally retain a heat transfer contact with room air also in the case of zero supply air
flow. The radiative coupling with the room is neglected in the present model. Beams are
mostly used for cooling but may also heat the room air.

7

The same is done for the radiator.
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Two input data options are available: Simplified and Manufacturer’s. The latter means that
the performance parameters K and N (from the model in Section 6.6) are given as functions of
air flow. This alternative is mostly used when data is automatically imported from the on-line
manufacturer’s database of IDA Room. The Simplified option is based on two user supplied
performance points, at design conditions and at zero flow (Figure 6.9). N is for this case set to
1.5.

Figure 6.9 Active beam form
In the constant flow (CAV) case, the given Design air flow is regarded to pass through the
beam when fans are running. When fans are forced, the beam flow is correspondingly
increased. For VAV, the Design air flow will pass through the beam at full VAV flow. At
lower flows, the flow through the beam will be proportionately decreased.
The total design air flow through all beams must not exceed the total for the zone. If beam air
flow is less than the requested total for the zone, the remaining part is regarded as being
supplied through conventional terminals.
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7. CAD Import
From IDA Indoor Climate and Energy version 3.0 it is possible to import architectural
drawings in the recently standardized IFC format (version 1.5.1). This format can be
generated from most 3D CAD tools such as AutoDesk’s Architectural Desktop, ArchiCAD,
Microsoft Visio etc.
The most important information that is transferred is geometrical data, i.e. the shape and
position of zones, windows, doors, building faces etc. Zones in ICE are automatically created
from so called space objects in the IFC model. It is not sufficient that the CAD model only
contains wall objects, spaces that fill the voids between walls must have been created, a semiautomatic process in most CAD tools.
ICE can also utilize other types of information in the CAD model, should they be present,
such as wall constructions. One can find more detailed information about the ICE IFC
implementation on the user’s page: Help menu, IDA on the Web, ICE User support. Select
Topic notes on the page.
7.1.

Mapping data from IFC

Start with a building without zones and select the Floorplan tab. Press CAD Import to select
an IFC file for loading. There are some sample IFC files in the installation, normally located
in C:\Program Files\IDA\samples\ICE\IFC. It is also possible to import files with standard
Windows graphics to use as background for manual zone creation. However, here we will
focus only on the import of IFC files.
The first task is to map named data objects in the IFC model (if any are present) to
corresponding IDA resources. Press IFC Mapping in the Floorplan tab to open the Mapping
dialog (Figure 7.1). If wall constructions have not been described in detail in the CAD model,
select directly Wall Constructions in the Category combo box. This will present a list of all
wall types that have been found in the IFC model. Since ICE needs more detailed information
about a wall, IFC wall types need to be manually associated with ICE wall constructions. To
bind a certain IFC wall type to an ICE construction, select both the IFC wall type and the
corresponding ICE resource and press Map to selected. A right pointing arrow in the IFC Data
list indicates that the item has been bound. Usually one first has to load relevant ICE
resources from the database by pressing Load from Db. To inspect the selected IDA resource,
press View.
Repeat the procedure for window types as well. Here, one usually has to first create relevant
windows in the ICE database, including internal shadings etc.
If wall constructions have been described in the IFC model with layer thicknesses and
material names, one can automatically create corresponding ICE constructions. In this case,
one starts instead with binding IFC material names with ICE material resources. Once the
materials have been mapped, ICE wall construction resources are created by pressing Import
from IFC when the relevant IFC wall type has been selected.
Any object in the IFC model which is not explicitly mapped to an IDA resource will be set to
its default value, which is given on the Defaults tab in the building form.
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Figure 7.1 IFC Mapping dialog
7.2.

Create zones

An IFC model may contain more than a single floor. A horizontal section (slice) of the
building at a certain level is shown in the Floorplan tab (Figure 7.2). To select a different
level, press the button Level: xx m, where xx is the floor height from ground of the current
level. In the Level dialog, the building height from ground (Building top) and height
coordinate of the floor slab with respect to ground (Building bottom) are also shown, as
interpreted from the IFC file. These numbers are not always correct for the user’s purpose.
To define which spaces in the IFC model that should constitute a (thermal) zone in the
simulation model, click on (select) the neighboring spaces that should be included. (Click
again to unselect a space.) Think about zone economy, i.e. do not create more zones than you
think is physically motivated for the current study. To create an ICE zone from the selected
IFC spaces, press New zone. Try to give as many reasonable defaults as possible for new
zones, after creation these values must be edited separately for each created zone.
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Figure 7.2 IFC model with an ICE zone, a selected IFC space and an unselected IFC
space.
The created ICE zone get the geometry of the corresponding IFC space(es). If for example a
space is taller than the floor to floor distance of the building, the corresponding ICE zone will
also reach over more than a single floor. One can change the horizontal section level during
the zone creation process but it is currently not possible to combine several spaces vertically
into a single zone. ICE is limited to zones with flat floor and ceiling. To create more complex
geometries one has to define several zones, possibly connected by large openings. Note that
the Floorplan view displays two models simultaneously, the zones of the created ICE model
and the spaces of the IFC model. Both categories of “rooms” can be individually selected and
ICE zones can also be opened.
If the IFC model is revised during the ICE modeling project, there is some support for
retaining previous work. New IFC models can be loaded while modeling, either replacing the
existing model or adding to it, e.g. loading several floors that are in separate IFC files. When
a new file is loaded, the user is given the option to replace or add to the current IFC model
and to replace or keep mapping information and existing ICE zones.
One should note that IFC is still a standard under very active development and the quality of
implementations will vary as will the content of “typical” IFC files. Today, few tools rely on
having access to correct 3D information so quite often the 3D content of project drawings will
not be quality controlled. However, the IFC standard has beyond doubt reached a stage of
usefulness and it is likely that the number of quality implementations of IFC tools will
increase rapidly in the years to come.
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8. Getting started with the advanced level
The standard level interface covers the most common simulation tasks, but sometimes it is
useful to examine other variables than those available here or to replace a component model.
To accomplish this one turns to the advanced level interface, where the system is described in
a mathematical sense with components containing equations, variables and parameters.
In some cases the system structures at the standard and advanced levels match each other
quite well. The air handling unit, for instance, has different components: fans, coils etc. The
same description can then be used for both the standard and advanced levels. The same is true
for the primary system. For the actual building description, however, entirely different
descriptions are used for the standard and advanced levels.
Most components at the advanced level are described with equations. Components are
interconnected by creating equalities between variables that appear on interfaces. An example
is the interconnection between the cooling and heating coils in the air handling unit. Both the
outflow interface of the heating coil and the inflow interface (terminal) of the cooling coil
contain variables for: pressure, temperature, massflow, moisture and carbon dioxide
concentrations.
To work on the advanced level, select Build model in the Tools menu. This creates the
schema view of the current building. If the model has been built previously, Scheme is
already available as a view of the system. Figure 8.1 shows the appearance of the air handling
unit in the schema view (which is also the standard view for the air handling system).

Figure 8.1 The air handling unit.
The behavior of a component is described by equations, variables and parameters. The
difference between parameters and variables is that the former will never change their value
during a simulation, whereas a variable might. A window area is an example of a ”natural”
parameter and the room air temperature is always a variable.
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The description of a component is done using a special language called NMF (Neutral Model
Format) and it contains the following main sections:
Abstract

A brief textual description of the model

Equations

The actual mathematical description (formalized according to a strict syntax
but quite readable also for humans)

Links/Interfaces A description of the ports or terminals of the component. A fan would
typically have at least two links for incoming and outgoing air flow and
could also have links for power supply and control signals.
Variables

Variables to be calculated by the model.

Parameters

Quantities that characterize the component, e.g. a vector of numbers
describing the fan curve

Parameter
processing

Computer code which converts user supplied parameters into those that
actually appear in the equations

We will now go through a few examples of useful operations at the advanced level of ICE.
8.1.

Example 1: Presenting more data in an existing diagram

Suppose we are interested in the air temperature after the heat exchanger in the air handling
unit and would like to see the graph together with the other temperatures of the AHU. Open
the AHU window (Figure 8.1) and double click on the connection between the heat exhanger
and the heating coil. A small window is opened showing the connection between the two
interfaces; SUPOUT (SUPply OUT) of the heat exchanger (hx) is connected to the
AIRFLOWIN interface of the heating coil (hc). To see the actual variables of the connection,
double click on the box hx.SUPOUT. TSUPOUT is the variable we are looking for, double
click on it to get the form at the lower right of Figure 8.2.

Figure 8.2
All relevant information about the variable is displayed in this window. At the bottom of the
window, there is a combo box for logging the variable to a diagram. Select “AHU
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temperatures” in the combo box. Make a simulation, and inspect the added graph in the
diagram.
8.2.

Example 2: Night setback

Night setback means that the temperature of a room is allowed to drop below comfort levels
at night when nobody is awake to notice. Normally, this is achieved by decreasing the radiator
supply temperature by some given amount and this is easily done at the standard level in ICE
3.0 with a schedule controlling the boiler. However, in this example we will instead reach a
similar effect by changing the setpoint of a radiator according to a given schedule.
Start with creating a zone model at the standard level which is heated by a radiator during a
design winter day. Chose loads etc. so that the radiator actually contributes to the heat balance
in a significant way, i.e. without the radiator, the room would be much too cold. Open the
zone form and generate the advanced level by Build model from the Tools menu. Figure 8.3 is
an example of what the system should look like then.

Figure 8.3 Zone in Scheme view (radiator proportional controller circled)
The proportional controller that has been generated has a fixed setpoint (a parameter) which is
not allowed to vary in time. This means that it must first be replaced by a controller with
variable setpoint. Start with removing the previous controller by selecting and deleting it. The
new controller can be found in the system Library in the Tools menu. Drag the object
“Proportional Controller” to the location of the previous controller.
Once the new controller is in place, we need to give it suitable parameters and boundary
variables. Double click to open a window for the new controller as in Figure 8.4.
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Figure 8.4 Outline view of PSMOOTH2 controller
Open the list of Variables by clicking on the “+”-symbol. Open the form (Figure 8.5) for the
variable PROPBAND by double clicking on it. This variable controls the P-band of the
controller and giving a negative value indicates heating type control, i.e. turn up controller out
signal when the measured quantity is low. Double click in the field “Unconnected” next to
Source or connection and type –2 at use value. Finish the dialog with Connect (Figure 8.6).
Next, set the variable OVERRIDE to 1 in the same manner. This variable is used to bypass
controller action, but this is not done here.

Figure 8.5 Form for PROPBAND variable

Figure 8.6 Dialog for connecting (binding) a variable to a value
The next step is to connect the new controller to the radiator. Double click on the frame of the
new controller to start a connection line. In the active zone, the cursor will change into .
The new controller has now a small square on its boundary marking the start of the
connection line. Drag the connection by clicking on line breakpoints along the path and finish
by clicking on the boundary of the radiator. In the Connection dialog, which is now shown,
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chose to connect the MEASURELINK interface in the controller to the AIRTEMP interface
on the radiator as in Figure 8.7. This will give the controller information about the air
temperature near the radiator. This information could also have been fetched directly from the
zone model.
Make also a second connection between the controller and the radiator, now connecting
OUTSIGNALLINK of the controller to CONTROL of the radiator. This is the actual
massflow control signal.

Figure 8.7 Dialog for connecting component interfaces
Finally we are to make an algorithmic connection between the new controller and a time
schedule for the setpoint as a function of time. The component we need is called Schedule.
Drag it from the lower left corner of Library into any place near the new controller. The same
component occurs frequently also at the standard level, so we will be brief here, see also the
help text for Schedule.
To give the two setpoints in the Schedule, create a new resource by right clicking on the
combo box and selecting New resource. Call it e.g. “Night Setback.” Open and press the
Advanced… button. Make a schedule that generates the value 21 between 08:00 and 19:00
and 18 otherwise.
As a last step we will connect the controller setpoint with the new schedule. For algorithmic
(one-way) connections, one marks the source of the signal from the receiving object. Open the
controller and right click on SETPOINTLINK in the list of Interfaces. Select Binding… from
the right button menu, select object in… 1:Zone and the OUT_LINK of the Night Setback
schedule object (Figure 8.8). Finish with Connect. This completes the connection, which is
invisible in the schema, but can be seen from the receiving object.
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Figure 8.8 Dialog for algorithmic interface connection
Start the simulation by choosing Run model (not Run) from the Tools menu.
A practical function at the advanced level is Replace… This enables one to replace a
component with another while retaining as much as possible of existing connections and
parameter values. Right click on the new controller and select Replace… in the menu. Chose
With new object. A list (corresponding to Library but with all available objects) is displayed.
Select THERMOST from the list (a two-point thermostat). Simulate with Run model from the
Tools menu. Simulation with the thermostat model can take significant time, since many
switching events may occur.
In this exercise, we have done some operations at the advanced level for the zone model.
These changes will be overwritten by a new generated model by the operations Build model
or Run in the Tools menu. This is of course a great limitation, since the model has to be regenerated each time a parameter is changed at the standard level. To change zone or building
parameters, one has to find and change the corresponding parameters at the advanced level or
accept the tedious work of repeating the operations done at the advanced level. However, for
the Plant and AHU, the situation is better, since this part of the system isn’t re-generated each
time a new model is built.

70

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

9. Frequently asked questions and their answers
9.1.

Program management

9.1.1. How do I open and make changes in objects that are selected from lists?
All objects can be opened to facilitate looking at them and changing their content. Different
methods are used to open an object, depending on if it appears in a list, in a so-called combo
box (most common), directly in the form, or in a dialog.
Double clicking on them, as in a typical Windows environment, can open objects appearing in
lists or directly in forms. Objects in so called combo boxes (where the list out of which a
selection is to be made first is “clicked open”) are generally opened by first clicking on the
selected item with the right mouse button, and then selecting Open in the menu displayed.
Combo boxes in dialogs are, however, an exception. In these cases, click on the small right
arrow to the right of the box, to display the corresponding right button menu. From version
3.0 this right arrow button is also available in forms.
9.1.2. How can I make my diagrams look better?
You can always right click on a diagram you are dissatisfied with and select Properties. You
can now change the appearance of the diagram.
If you want to change a diagram type once and for all, i.e., keep the change from run to run,
first select Editable forms from the Options menu. When the form (diagram) which has been
changed is then closed, you will be asked if you want to save a file ending with .idc. If this is
done, the changes are permanently saved.
9.1.3. How can I get a copy of a zone?
Select the zone in the building form. Select Copy from the Edit menu. Select Paste from the
same menu.
The new zone’s location in the building coincides with the original, so one of the zones must
be moved if a meaningful simulation is to be carried out. Open the zone to be moved and
select Floor Plan. Use the mouse to draw the zone to a new location.
9.1.4. How do I select the type of calculation: temperature, cooling load or energy?
There is no direct choice for this in IDA Indoor Climate and Energy. Basically the same type
of calculation is always done; that is, the system is run using given parameters, weather
conditions and loads. This is comparable to a temperature calculation in other programs.
An energy calculation is always done, and it is only a matter of selecting the correct result
objects (Chose output, Tools menu) before running, to attain the desired result. Of course, the
run must also cover the period of interest. To speed up the calculation, select “energy model”
in the Dialog for simulation data or in each zone. Relaxing the tolerance in the Advanced tab
of the Simulation data dialog can also help.
It is important not to create any unnecessary detail in efficient models, add for example a
single large window in a wall even if in reality there are many small. Also take care to not
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model airflows through openings such as open doors unless there is cause to believe that this
is important to the final result.
Please also see questions regarding cooling load calculations.
9.1.5. Can I compare results from different simulations?
Yes. This is possible in, for example, Excel. All the result files (.prn) from a simulation can be
transferred to Excel. The Excel macro IDAPlot is automatically installed in Excel 2000 the
first time an IDA diagram is opened. Select Excel from the View menu when the diagram
window is active. For older versions of Excel the macro has to be manually installed. Read
c:\Program Files\IDA\Office\readme.txt for more information.
To read IDA time series files (.prn) directly into Excel, start the macro under the Excel menu
Tools ->IDAPlot, and then select to open the result file you want to compare. Repeat the
procedure for the next result file without closing the first book. When all the result files have
been read, select a diagram and click with the right hand button on the mouse at a neutral
place in the diagram and select source data in the menu. Select series and add a series. Enter
X- and Y- values for the new series. It is easiest to go to page 1 in the respective books and
select the data series. Repeat this procedure for all the books.
Normally time series from separate simulations will have different sequences of time steps
and may therefore be hard to post process in Excel. However, from version 3.0 it is possible
to generate fixed timestep output, while the actual simulation still operates with variable
timesteps. Select appropriate Time step for output in the Advanced tab of the Simulation data
dialog.
9.1.6. How do I redefine an IDA resource, for example, a wall construction, from its
place of use without first locating it in the IDA resources window?
If you open and change the resource where it is selected, the data in the resource itself is
changed, i.e. at all the places where it is visible.
9.1.7. How do I load lighting, equipment, occupant loads, and windows from the
database?
In the Dialog for Insert object there is a button marked Database. This is activated when type
of object to insert is selected, provided that an object of that type exists in the database.
9.1.8. Can I save entire zones in the database?
No, but you can copy zones between systems.
9.1.9. How do I get out of unsuccessful drawing operations?
Press the Esc key or right click and select Cancel. Unwanted breakpoints are removed by
clicking on them once again.
9.2.

Geometry

9.2.1. How are zones connected to each other and to external faces
All walls and floors “understand” how they should be connected to other zones or to external
surfaces. The zone 3D position is used to find and the appropriate connections. One can later
on, at the advanced level, check that the models actually have been connected correctly.
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9.2.2. Is it possible to manually connect a wall or part there of to an external surface
which is far away
Yes, in version 3.0 one can do this by choosing Connect to face in the Advanced tab for the
wall (floor or ceiling) in question. This way it is possible to describe buildings with complex,
non-prismatic, geometry.
If only a part of the wall is to be connected, one first selects New object from the Insert menu
when the wall surface is visible in the active window and then Wall part. In the new part,
boundary conditions can be chosen in the same way as described in the previous paragraph.
9.2.3. How is the building orientated in relation to the floor plan and the North arrow?
The corners of the building are defined in a local coordinate system that moves with the
building. The building system is defined within a global system which is fixed on the site.
Rotation of the building’s coordinate system in relation to the global one is entered in degrees.
Positive rotation is clockwise.
The North arrow’s direction is also entered in relation to the global system. Positive rotation
direction for the North arrow is also clockwise.
Please also see Geometry for the building in the reference manual.
9.2.4. How is a zone orientated in relation to the building?
A corner point on the floor defines the position of a zone. The point’s position and rotation is
defined with respect to the building’s coordinate system.
9.2.5. Can I define a zone without having to consider the building?
No, a building with orientation is always defined.
9.2.6. How is the information about the building’s height and depth used?
It is primarily used to find out when a zone is to be connected to the roof or ground. Other
ways it is used is to calculate self-shading for non-rectangular buildings and to compute the
local wind speed at the height of the roof. The given pressure coefficients are assumed to be
defined in relation to this wind speed.
9.2.7. How can I give coordinates numerically instead of graphically?
By first selecting Property page in the Options menu and then selecting the object. A separate
window showing coordinates is opened.
9.2.8. Which view does the editor display for external shading, and how can I enter side
fins?
The editor displays a view from the side of the window. Only symmetrical shading objects
can be defined with respect to the window’s middle line. For example, a marquee will be
centered in the middle of the window. The width of the object is given numerically.
In consequence with this, only double side fins can be defined, one on each side of the
window’s middle line, and with a mutual distance which is given by the given number.
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Heating and cooling load calculations

9.3.1. How do I carry out a cooling or heating load calculation?
They can most easily be done from the IDA Room wizard. At the standard level one does the
following:
Both types of calculations are done by defining a local piece of equipment (cooling unit or
radiator) on a surface and giving it a large, but realistic, maximum power. The setpoint for
both the cooling and heating controllers respectively is given by selecting suitable minimum
and maximum Comfort temperatures in Controller setpoints in the zone’s form.
After simulation, look at the result object for “Temperatures and heat balance in the zone”
(which, before simulation is ordered in the Tools menu, Chose output). This supplies
information about which max power was required during the selected simulation period.
A proportional controller (which always has an offset) is used by default for controlling
radiators, which means that the temperature setpoint is not kept exact. Cooling units use by
default PI control and therefore keep their setpoint more exact.
Please also see Section 6.5.
9.3.2. How can I design cooling in cases where the temperature is allowed to exceed the
setpoint?
This cannot be done automatically in the current version of IDA Indoor Climate and Energy.
The thing to do is experiment with different max power in the local equipment and see how
warm it gets.
9.3.3. How do I define a boiler, which corresponds to a district heating plant?
There is at the moment no special support for this in IDA Indoor Climate and Energy. The
user must define a boiler with an efficiency of 1.0 or somewhat lower to compensate the small
losses. Used primary energy then equals the used district heating. The flow on the primary
side can unfortunately not be calculated yet.
9.3.4. It seems to take too much energy to chill the supply air to a specified temperature
– is this really the case?
This is correct in relation to the model for cooling coils that is used (bypass factor method
from ASHRAE). With this the air starts to dehumidify as soon as the chilled water’s mean
temperature drops below the dew point (see also Section 6.2). The amount of energy required
for dehumidification is often mistakenly neglected. The air is also re-heated by the fan and by
friction in the duct system after the coil.
9.3.5. Why does the diurnal mean temperature for cooling load calculations not change
in the wizard when simulation is changed to, for example, January?
The diurnal mean temperature is calculated based on the temperatures given for the design
summer case in the location object. The simulation date only has meaning for solar elevation
and the day’s length.
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Airflow in IDA Indoor Climate and Energy

9.4.1. How do I give the supply airflow at the standard level?
Select Exhaust air for CAV in the zone’s form and a suitable Factor supply air / exhaust air .
The difference in flow is compensated by infiltration (or exfiltration) through the leak.
See also Section 6.4.
9.4.2. How is a pure exhaust air system defined?
By selecting 0.0 for Factor Supply air / Exhaust air in the zone’s form. The building always
has a supply air system, but this makes the flow through it negligible. All supply air enters
through the leak in this case.
9.4.3. Why are the supply air and exhaust airflows not exactly the same in the AHU,
when I select 1.0 for “Factor supply air / exhaust air” in the zone?
To avoid unwanted flow through the leak, the selected flow in the zone is recalculated from
volume flow to mass flow (at 20 °C). If this was not done, depending on temperature – and
thereby density variations in the zone air, air would always be moving through the leak.
(Except when the zone’s air temperature is exactly the same as the supply air temperature).
The accounted flow through the fans is however the correct volume flow at the actual
temperatures, which in general is different in the supply and exhaust air, respectively.
9.4.4. How do I force the flow in a CAV system?
If the value given by the schedule, which controls the supply and exhaust fans in the AHU, is
set to a value over 1, the flow is forced with the equivalent factor.
9.4.5. Why is the flow not fully zero when the air- or water system is off?
For numerical reasons small flows are left. There would otherwise be a risk of instability in
the numerical solution.
9.5.

Energy calculations

9.5.1. How do I cover the entire volume of the building with zones for an energy
calculation?
Be economical with the number of zones to be defined in an energy calculation.There are two
mechanisms for reducing the number of zones, but still make calculations on the whole
building. The first is to quite simply define large zones, perhaps whole buildings or floor
levels. You can also use the “Number of zones of this type” parameter in the zone’s form. By
doing this several zones with the same conditions can be calculated with regards to energy
consumption without needing to define every zone. The latter alternative should however be
avoided for zones with air paths to other zones.
9.5.2. We get suspiciously low energy consumption, what could be wrong?
A thing often forgotten when setting up an energy model is cold bridges, every building has
cold bridges and in ICE the default value for them is 0 W/K (lacking a better number).
Make sure also that the loads used are realistic for average usage of the building and not the
same as those used for cooling or heating load calculations.
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Note also that the default value of occupant clothing, 0.5 clo, is low for winter situations and
if it is kept for a yearly run, occupants will emit too much heat over the year.
9.6.

Other questions about IDA Indoor Climate and Energy

9.6.1. How do I build my own AHU?
In version 3.0 there are a number of ready made air handling units to chose from. Select the
one which best matches your problem and then edit it.
All models from the ASHRAE Secondary Systems Toolkit are available and can be inserted
into the AHU. A manual these components can be obtained from ASHRAE
(www.ashrae.org). Some of the components have simple, self-explanatory parameters.
9.6.2. Where is zone temperature defined for displacement ventilation?
The temperature shown on the diagram is the temperature at half of the zone height.
9.6.3. Which air temperature is used for calculating the operative temperature for
displacement ventilation?
The air temperature which applies at the given height for the actual occupant load. The given
height defines the occupant’s center of gravity.
When occupant loads are introduced into the zone, they are initially placed on the floor in the
middle of the zone, with their center of gravity 0.6 m above the floor. If you open the surface
editor for the floor, you can move the different occupant loads to different positions, and also
select their height over the floor.
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IDA Indoor Climate and Energy builds a single large simultaneous system of equations for all
processes in the building. This system of equations contains several ordinary differential
equations and has therefore different “built in” time constants. The room air will for example
react quickly on a convective heat load, while the ground layer below the building can have a
time constant several orders of magnitude larger. This system of equations is solved with
numerical methods that adapt the timestep to the frequency content of the solution. Short time
constants in the model in combination with high frequency content in driving functions (many
starts and stops) can lead to long execution times.
Internally generated starts and stops (events) will also lead to short timesteps. Try for example
to use a thermostat for radiator control as was done in an example in Chapter 8.
The shear number of equations in the system is naturally significant for the execution time,
which increases roughly linearly with the problem size8. However, it is vital to not model any
unnecessary detail, and not for example model a large number of identical objects such as
windows or cooling beams, when they could be replaced by a single larger one. Each added
zone (climate model) will contribute about six hundred variables to the system of equations.
The single most important factor for speeding up calculations is to have a reasonable amount
of detail in time schedules (driving functions). Describing many sharp transitions will usually
only result in increased computation time and not have a significant impact on results.
For a model with reasonably simple time schedules, it can often prove effective to loosen the
numerical tolerance to make to solver take longer and thereby fewer timesteps. Two important
solver parameters are Tolerance and Maximum timestep. These are accessed from the
Advanced tab of the Simulation data dialog. Often the tolerance can be relaxed to, say, 0.1-0.3
from the standard value 0.02.
Looser tolerance will normally lead to acceptable loss of accuracy for accumulated quantities
such as monthly energy consumption. For computing design (extreme values) of quantities
such as heating or cooling load, one should be more careful with using loose tolerances and a
large max timestep. Too lose a tolerance will on the other hand lead to decreased robustness,
forcing the solver to often have to back up and retry with a smaller timestep, ultimately
leading again to even longer execution time (if indeed the simulation is successful).
To learn about the statistics of a simulation in terms of number of timesteps, variables, restarts
etc. view the file screen.txt in the IDA temporary directory idamod309. At the end of this file
some statistics are given.
10.2.

Numerical instabilities

With a tool like IDA Indoor Climate and Energy it is easy to build large non-linear systems of
equations and solve them for thousands of time points. However, it is impossible to, even
8

For more primitive numerical methods, the execution time will typically grow as the cube of the problem size.
This directory will be created in the standard temporary directory of the machine, which may occur in different
locations depending on Windows version used. Sometimes the quickest way is to search for ”idamod30”.

9
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theoretically, guarantee the success of the solution procedure. Any non-linear system of
equations may have more than a single solution, or none at all. Numerical computer programs
are in this respect different from most other types of software, where it may be, at least
theoretically, possible to create a bug-free code. IDA Indoor Climate and Energy also has a
more difficult task than most other building simulation software, where less freedom is given
to create mathematically complex models.
A major part of the IDA development work is devoted to improving the solver performance
on difficult cases. However, this work is altogether dependent on close interaction with users.
It is vital that users, which have built reasonable and meaningful models that are difficult to
solve, take the trouble of sending the model to the support office. This is most easily done by
using the Mail support function on the Help menu.
Some physical processes more often lead to problematic models. Generally speaking, models
with significant natural ventilation flows through openings or leaks are the most difficult to
solve, especially when the effect of wind pressure is included. If, in addition, vertical
temperature gradients are to be simultaneously computed, one obtains a severely stiff and
non-linear system of equations.
A model that in spite of numerous revisions continues to give some trouble is the radiator and
cooling panel model. If the user requests a large (or very small) maximum power in relation
to the physical size of the device, the model may lead to failed simulations. The solution is to
alter the physical dimensions somewhat.
A general way of dealing with difficult cases is to decrease the tolerance parameter that was
discussed in the previous section. This forces the solver to be more careful and take smaller
steps, which in most cases improves robustness. A tolerance of 0.001 or even smaller can
sometimes be used.
A frequent situation is that any change in input data makes a previously failed run go through.
This is not as strange as it sounds, since each change will lead to a different sequence of
timesteps and this way the exact combination of values that led to the failed timestep is
avoided.
Another often effective trick is to replace sharp steps in schedules with steep ramps,
especially for the fan control schedule. This will enable the solver to gradually over a short
time period approach the new solution and thereby reach it more securely. If, in addition, the
start and endpoints of the ramp are marked as input events, the solver will be even more
cautious. Input events are marked by repeating the same time point twice in the profile,
something best done in the Data tab view.
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IDA Room reference manual

This chapter describes the different input fields of IDA Room in some detail. A general
introduction to IDA Room is found in Chapter 4.
11.1.
11.1.1.

IDA Room input data
Location Page

See corresponding object at the standard level, Section 12.6.
11.1.2.

Glazing page

See corresponding object at the standard level, Section 12.55.
11.1.3.

Internal shading page

See corresponding object at the standard level, Section 12.29.
11.1.4.

Envelope page

This page gives you the possibility to select alternative constructions for floors and walls
under the tab Simple data.
Description of fields:
Expand the description of each construction. The expanded description is explained in
detail in the next section.
combo box for the choice of constructions from the database [Database selection for
Construction]
U-value Display of the constructions’ total resulting U-value including the inner and outer
heating resistance [W/m2K]
11.1.5.

Page for wall and floor construction

This page describes the materials and layer thicknesses for wall and floor constructions.
Description of fields:
The following information is described for each material layer:
Thickness The material layer’s overall thickness [m]
Material Selection of material for the layer [Database selection for Material]
Heat conductivity Measurement of the material’s thermal conductivity [W/mK]
Density Measurement of the material’s density [kg/m3]
Specific heat Measurement of the material’s heat-storage capacity [J/kgK]
Each material layer in the construction can be selected by clicking on any field in the row.
The toolbar to the right refers to operations on the selected layer. The following operations
can be performed:
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Save material Name a user defined material
Add Add a new material layer at the bottom of the list. The new layer is a copy of the
selected layer, if a layer is selected.
Delete layer Delete the selected material layer
Move layer up Move the selected material layer up in the list
Move layer down Move the selected material layer down in the list.
11.1.6.

Simple data tab

This tab is active when the program is started. Once one of the tabs for a detailed description
of the room is activated you cannot return to Simple data.
Description of fields:
Location and case: Sizing case Selection of the design case [Summer case with cooling,
Summer case without cooling, Winter case]
Location and case: Simulation date Significant for the height of the sun, ambient
temperatures are stated under "location" [Selection of date for Summer case or Winter case]
Location and case: Location Selection of the location also results in the choice of climate
data for the location [Database selection for location]
Location and case: Max temp. Maximum dry bulb temperature during a day, changed by
opening location [°C]
Location and case: Min temp. Minimum dry bulb temperature during a day, changed by
opening location [°C]
Zone and materials: Envelope Selection of construction and materials for walls and floors
[Database selection for structure]
Zone and materials: Window area incl. frame The window’s total area, 10 % of which is
assumed to be taken up by the frame [m2]
Zone and materials: Glazing Selection of the glazing’s optical and thermal properties
[Database selection for Glazing]
Zone and materials: Internal shading Selection of curtains, Venetian blinds etc. Pulled when
the transmitted sunlight exceeds 100 W/m2 [Database selection for Internal shading]
Zone and materials: Orientation Selection of the compass point that the window faces
[Selection from fixed list]
Zone and materials: Room height Distance between the flooring and the ceiling [m]
Zone and materials: Width Distance between the side walls, in relation to the window, inside
measurement [m]
Zone and materials: Length Distance from the window wall to the opposite wall, inside
measurement [m]
Loads: Num of occup The number of persons that load the room (dry and wet) [number]
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Loads: Time for persons Hours per day the persons are present, centred around 13:00 [hours]
Loads: Light Rated input power when lights are on [W]
Loads: Time for Light Hours per day for the Light, centred around 13:00 [hours]
Loads: Other Loads Dry convective heating power from appliances in the room [W]
Loads: Time for Other Loads Hours per day for the Other Loads, centred around 13:00
[hours]
Flows: Supply air flow Total supply air flow= exhaust air flow (when fans run) [l/s] or
[m3/h]
Flows: Fan operation time Hours per day for mechanical ventilation, centred around 13:00
[Hours]
Flows: Supply air temperature Temperature of in-blown air (unavailable for Summer case
without cooling) [°C]
Flows: Thermostat setpoint Set value for the room thermostat for cooling or heating units
(unavailable for Summer case without cooling) [°C]

The tab for Simple data enables cooling or heating load calculations for a rectangular room
with one window with a minimum of input data. The room has one external wall, but
otherwise it is surrounded by rooms with the same temperature conditions. The room is
presumed to have a fully balanced mechanical supply and exhaust air system. A periodic
calculation is performed, i.e. the room is exposed to an endless heat wave (or cold spell).
When no significant change occurs from one day to the next the calculation is terminated and
the results from the last day are presented.
Three sets of conditions are possible: Summer case with cooling, Summer case without
cooling and Winter case. In Summer case with cooling the room is partly cooled via the
supply air and partly by a local room unit that automatically gives a large max. power (200
W/m2 floor area). The primary results are the removed cooling power and the resulting
operative temperature in the room. The room unit should, in most cases, have a sufficient
capacity to maintain the air temperature close to the thermostat’s setpoint. The operative
temperature (and the directed operative temperatures) refers to a person standing in the centre
of the room.
In Summer case without cooling a pure temperature calculation is made without access to
mechanical cooling. The supply air then has the outdoor temperature plus two degrees
corresponding to the temperature increase in the fans and ducting.
In Winter case the room is equipped with a radiator with a large capacity (50 W/m2). The
radiator should, in most cases, be sufficient to maintain the room air temperature with the
given setpoint of the thermostat. No room unit for cooling is generated in this instance.
11.1.7.

General tab

This tab is always available. Here general information for the project is stated and some input
data fields are repeated from the Simple data, which you may need to change even in a
detailed description of the room.
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Description of fields:
Location and case: Sizing case Selection of the design case [Summer case with cooling,
Summer case without cooling, Winter case]
Location and case: Simulation date Significant for the height of the sun, ambient
temperatures are stated under "location" [Selection of date for Summer case or Winter case]
Location and case: Location Selection of the location also results in the choice of climate
data for the location [Database selection for location]
Location and case: Max temp. Maximum dry bulb temperature during a day, changed by
opening location [°C]
Location and case: Min temp. Minimum dry bulb temperature during a day, changed by
opening location [°C]

Water temperatures: Hot, Supply Supply temperature to room heating units [°C]
Water temperatures: Hot, Return Return temperature to the boiler at design conditions [°C]
Water temperatures: Cold, Supply Supply temperature to room cooling units[°C]
Water temperatures: Cold, Return Return temperature to the chiller at design conditions [°C]

Project data: Customer Text that describes the client, printed on reports [Text]
Project data: Resp. engineer Text that describes the chief engineer, printed on reports [Text]
Project data: Date Date of the calculation assignment, printed on reports [Date]
Project data: Description Text that describes the case and project, printed on reports [Text]
11.1.8.

Geometry and horizon tab

This tab is the first in the detailed description of the room. When one of the three tabs for a
detailed description is activated it is no longer possible to return to Simple data. All input data
already defined in the Simple data tab is still available and can be changed.
Description of fields:
Geometry: Room height Distance between the flooring and the ceiling [m]
Geometry: Width Distance between the side walls, inside measurement [m]
Geometry: Length Distance from the external wall to the opposite wall, inside measurement
[m]
Geometry: Orientation Direction of the compass’ north arrow in relation to the room
drawing [°]
Geometry: Applet for the North arrow Direction of the compass’ north arrow in relation to
the room drawing [input and output data]
Geometry: Applet for the Room’s shape Shows the shape of the room and window
positions, clickable surfaces [output data]
Objects on the wall: List of all room walls Clickable list of all objects in the room [output
data]
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Horizon: Applet for horizon Defines the height of the sun for which the sun is shadowed by
the surroundings [input and output data]
Under the Geometry and horizon tab you can change the shape of the room, orientation and
shading. You also get an overview of the room with all its walls and objects that have a
bearing on the indoor climate. All objects on the walls are openable and lead to new input
data dialogs.
The blue line on the lower edge of the drawing makes it possible to describe a sun cut-off
horizon for the room. An angle [0 - 90 °] is given for each point of the compass, which
defines the shadowing object’s height above the imagined horizon in the distance. The centre
of the floor is the viewing point.
Drag the cursor sideways with the mouse button pressed to change the line. The vertical
segment, which links the new with the old line, is formed automatically. No angled lines are
permitted. If you make a mistake, you can either redraw over the error or you can click on the
Undo button on the toolbar.
Let’s look at an example with a room that is 30 m above the ground and which is shadowed in
the morning by an 80 m high building at a distance of 100 metres. Further, we assume that the
shadowing building lies directly south-east and is 40 metres wide. The height of the
shadowing line segment should then be arc tan((80 - 30)/100) = 27°. The width should be arc
tan(40/100) = 22° centred around south-east (135°). As the resolution is limited we draw a
line with a height 25° from the point of the compass 120° to 150°.
11.1.9.

Walls and floor tab

Clicking on a surface or an object on a wall in the Geometry and horizon tab activates the
Walls and floor tab. One of the room’s six main surfaces is always active. Usually an object
on the active wall is also highlighted. A drawing of the active wall is shown in the applet,
Objects on the surface. The ceiling is seen from above in this view. Other surfaces are seen
from within the room.
The different objects can be highlighted in the drawing by clicking on them. Data for the
highlighted (selected) object is shown to the right of the picture. You can move the object by
clicking and dragging in the drawing.
Description of fields:
Properties: Select surface Radio buttons to select the active surface [Floor, Ceiling, Walls1-4]
Properties: Building Element Type of wall or floor [Internal, External, Against constant
temperature]
Properties: Construction Selection for the construction of the wall or floor [Database
selection for wall or floor construction]
Properties: Surface temp. on other side A fixed surface temperature on the opposite side,
note not the air temperature. [°C]
Objects on the surface: Applet for Objects on the surface Shows the objects on the active
main surface; objects are selected here [input and output data]
Selected object: <Type of object> Part of the page that displays data for the selected object
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Description of the forms for objects on the wall:
The following objects may appear on a surface:
Ceiling

Manufacturer independent cooling device
Manufacturer independent chilled beam
Radiator
Window
Skylight
Light
Load from the web…

Floor

Group of people adding to the zone load

Wall

Manufacturer independent cooling device
Radiator
Window
Load from the web…

11.1.10.

Objects on room surfaces

11.1.10.1.

Room unit from specific manufacturer loaded from the web

Description of fields:
Geometry: X Position in x-direction for the lower left corner, can be given in the Applet [m]
Geometry: Y Position in y-direction for the lower left corner, can be given in the Applet [m]
Geometry: Length Length of the device, select from list [m]
Geometry: Width Width of the device, select from list [m]

Construction: Model Model designation from the manufacturer’s range
Construction: Air flow Mechanical air flow through a chilled beam per metre beam length
[l/s]
Design power: Cooling power (water) Cooling power from water at given temperatures [W]
Design power: Cooling power (air) Cooling power by supply air at given temperatures [W]
Design power: Heating power (water) Heating power from water at given temperatures [W]

The total maximum cooling power of the beam is the sum of the cooling power (water) and
cooling power (air). The displayed value for the cooling power (air) is only dependent on the
selected air flow through the appliance and its temperature in relation to a room temperature
of 24 °C. The air supply temperature is then considered to have its highest permitted setpoint
value, which is stated under the Loads and ventilation tab.
The actual cooling power from the air is dependent on the simulated values for the room and
air supply temperatures and the air flow rate through the appliance during the calculation. The
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air flow will be changed in relation to that stated if the fans are forced or runs slower than
design speed (also stated under the Loads and ventilation tab)
The cooling power (water) stated in the form is related to a room air temperature of 24 °C and
to water temperatures stated under the General tab.
The actual waterborne cooling power can deviate from the displayed value due to the
following reasons: the room air temperature deviates from 24 °C, the controller never requests
full water flow, the air flow deviates from that selected because of variations in the fan speed
or the cooling water does not maintain its set temperature value because the chiller is
switched off.
The estimated heating power is calculated instead for a room temperature of 20 °C and the hot
water temperatures given in the General tab. Otherwise the same reasoning as for waterborne
cooling power applies.
Chilled beams are only considered to operate through convection. Passive beams and chilled
ceilings also have a radiation component that is dependent on the surface area and its
temperature. Radiating devices also affect the operative temperature in the room.
11.1.10.2.

Manufacturer independent cooling device

Description of fields:
Geometry: X Position in x-direction for the lower left corner, can be given in the Applet [m]
Geometry: Y Position in y-direction for the lower left corner, can be given in the Applet [m]
Geometry: Length The device’s extension along the x-direction [m]
Geometry: Width The device’s extension along the y-direction [m]
Design power: Power Cooling power from water at given temperatures [W]
The cooling power (water) stated in the form is related to a room air temperature of 24 °C and
to water temperatures stated under the General tab.
The actual waterborne cooling power can deviate from the displayed value due to the
following reasons: the room air temperature deviates from 24 °C, the controller never requests
full water flow, the air flow deviates from that selected because of variations in the fan speed
or the cooling water does not maintain its set temperature value because the chiller is
switched off.
The appliance removes heat both via radiation and convection. The size of the radiation
component is dependent on the exposed surface and its temperature. Generally, a large
physical size of the device gives a larger radiation component. Devices with radiation also
affect the operative temperature in the room.
11.1.10.3.

Manufacturer independent chilled beam

The active chilled beam absorbs heat from the room air partly through passive convection and
partly via induction with the supply air (no radiation). Accordingly, the maximum cooling
power depend on supply air flow through the beam.
Description of fields
Geometry: X Position in x-direction for the lower left corner, can be given in the Applet [m]
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Geometry: Y Position in y-direction for the lower left corner, can be given in the Applet [m]
Geometry: Length The device’s extension along the x-direction [m]
Geometry: Width The device’s extension along the y-direction [m]
Design power: at full air flow Cooling power from water at given temperatures and full air
flow [W]
Design power: at zero air flow Cooling power from water at given temperatures and no air
flow [W]
Design power: Air flow Mechanical air flow through the beam [l/s]
The cooling power given in the form is related to a room air temperature of 24 °C and to the
water temperatures stated under the General tab.
The actual waterborne cooling power can deviate from the displayed value due to the
following reasons: the room air temperature deviates from 24 °C, the controller never requests
full water flow, the air flow deviates from that selected because of variations in the fan speed
or the cooling water does not maintain its set temperature value because the chiller is
switched off.

11.1.10.4.

Radiator

Description of fields:
Geometry: X Position in x-direction for the lower left corner, can be given in the Applet [m]
Geometry: Y Position in y-direction for the lower left corner, can be given in the Applet [m]
Geometry: Length The device’s extension along the x-direction [m]
Geometry: Width The device’s extension along the y-direction [m]
Design power: Power Heating power from water at given temperatures [W]
The design power given in the form is related to a room air temperature of 20 °C and to the
water temperatures stated under the General tab.
The actual heating power can deviate from the given value due to the following reasons: the
air temperature deviates from 20 °C or the controller never requests full water flow.
The radiator gives off heat both via radiation and convection. The size of the radiation
component is dependent on the surface area and its temperature. Generally, a large physical
size gives a larger radiation component.

11.1.10.5.

Window

Description of fields:
Construction: Frame fraction Area of the unglazed part of the window divided by the total
window area [%]
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Construction: Glazing Selection of the glazing’s optical and thermal properties [Database
selection for Glazing]
Construction: Internal shading Selection of curtains, Venetian blinds etc. Pulled when the
transmitted sunlight exceeds 100 W/m2 [Database selection for Internal shading]

Geometry: X Position in x-direction for the lower left corner, can be given in the Applet [m]
Geometry: Y Position in y-direction for the lower left corner, can be given in the Applet [m]
Geometry: Height The window’s extension along the x-direction (frame outside measurement
[m]
Geometry: Width The window’s extension along the y-direction (frame outside measurement
[m]
Geometry: Recess depth The distance between the window outer pane and the façade surface
[m]
Geometry: Awning width The total width of the awning [m]
Geometry: Awning height The total height of the awning projected on the façade [m]
Geometry: Awning extension The largest distance the sunblind is from the façade surface
[m]
Geometry: Awning, mounting distance above window Distance between the awning bracket
and the window recess [m]

The thermal and optical properties of the window are basically defined by the selection of the
glazing and internal shading. See respective objects for a detailed description.
The internal shading is pulled automatically when the sunlight inside the glass exceeds 100
W/m2.
The frame is assumed to have a U-value of 2.0 W/ m2°C.
The awning is fixed and presumed to be fully opaque. Windows installed in the roof may not
have awnings.

11.1.10.6.

Skylight

A skylight corresponds to a window structure on the roof. This can be used to study the light
penetration and the climate consequences for diverse shapes of skylights, e.g. saddle roof with
glass. The skylight object has the shape of a pyramid with a rectangular base and a horizontal
cut-off (rectangular) top. This forms five areas that can be glazed to a different extent.
An advanced radiation calculation is performed, so that e.g. direct sunlight that shines in
through one pane and out through another is treated correctly. The light that passes through
the base of the skylight object down into the room is spread diffusely to the room surfaces.
Description of fields:
Geometry: X Position in x-direction for the lower left corner, can be given in the Applet [m]
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Geometry: Y Position in y-direction for the lower left corner, can be given in the Applet [m]
Geometry: DX The base’s extension along the x-direction [m]
Geometry: DY The base’s extension along the y-direction [m]
Geometry: DZ The object’s total height above the ceiling area [m]
Geometry: L1 distance in the ceiling plane between the limit lines of the top and base towards
the room’s Wall 1 [m]
Geometry: L2 distance on the ceiling plane between the limit lines of the top and base
towards the room’s Wall 2 [m]
Geometry: L3 distance on the ceiling plane between the limit lines of the top and base
towards the room’s Wall 3 [m]
Geometry: L4 distance on the ceiling plane between the limit lines of the top and base
towards the room’s Wall 4 [m]
Glass area: Wall 1 Size of glazing in the skylight’s Wall 1 [m2]
Glass area: Wall 2 Size of glazing in the skylight’s Wall 2 [m2]
Glass area: Wall 3 Size of glazing the skylight’s Wall 3 [m2]
Glass area: Wall 4 Size of glazing the skylight’s Wall 5 [m2]
Glass area: Roof Size of glazing in the skylight’s roof [m2]

Construction: Wall Selection of the construction for unglazed areas (including the roof)
[Database selection for wall or floor construction]
Construction: Glazing Selection of the glazing’s optical and thermal properties [Database
selection for Glazing]

The base of the skylight object is thermally regarded as a tempered wall from the zone’s
perspective. The wall’s temperature is given by a weighted average of the temperatures of
glazed and unglazed areas. The model should represent the long wave radiation balance and
the convection from a hot skylight relatively well. Convection in the form of cold draught
from vertical parts of the skylight will not be modelled as accurately.
11.1.10.7.

Light

This form is used to describe the position and size of the Light on the ceiling. This can have a
bearing on the operative temperature in the room. The lighting total load and time schedule
are defined under the tab Loads and ventilation.
Description of fields:
Geometry: Position in x-direction Position in x-direction for the lower left corner can be
given in the Applet [m]
Geometry: Position in y-direction Position in y-direction for the lower left corner can be
given in the Applet [m]
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Geometry: Size in x-direction Extension in x-direction [m]
Geometry: Size in y-direction Extension in y-direction [m]
Only one Light object is permitted. If you wish to "spread" the Light across the ceiling you
need to make the object large.
The luminous efficiency of the luminaire is automatically set to 12 lumen per watt. Of the
supplied input, 30 % is emitted as convection and the remainder in the form of long and short
wave radiation.

11.1.10.8.

Group of people adding to the zone load

This object acts partly as an occupant, i.e. a source of heat and moisture, and partly as a
sensor for the operative temperature. The object’s position in the room has in principle only a
bearing on the sensor function.
The number of occupants that load the zone and the time schedule for their presence is
defined under the Loads and ventilation tab.
Description of fields:
Geometry: Position in x-direction Position in x-direction can be given in the Applet [m]
Geometry: Position in y-direction Position in y-direction can be given in the Applet [m]
Geometry: Center of gravity’s height over floor The sensor’s height above the floor [m]
Activity level and clothing: Activity level Activity level according to Fanger [met]
Activity level and clothing: Clothing Clothing level according to Fanger [clo]
Only a single occupant object is permitted. If the loading of several persons with different
numbers and time schedules need to be modelled, you must state the maximum number under
the Loads and ventilation tab and create a new time schedule which is the point wise weighted
average of the different individual schedules.
The person’s activity level and clothing have some influence on the moisture and heat
emissions, especially during the winter case time when a summer dressed person gives off
approx. 20 % too much heat.
Selecting activity level (met)
The examples below give the emitted total power and activity levels during different
activities, which are assumed to be continuous. (Source: ASHRAE Fundamentals).
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Activity

met

Power [W]

Sleep

0.7

72

Reclining rest

0.8

81

Seated quiet resting

1.0

108

Standing, relaxed, rest

1.2

126

Walking (3.2 km/h)

2.0

207

Walking (4.3 km/h)

2.6

270

Walking (6.4 km/h)

3.8

396

Reading, seated

1.0

108

Typing

1.1

117

Office walking

1.7

180

Office lifting/packing

2.1

216

Cooking

1.6-2.0

171-207

Housecleaning

2.0-3.4

207-360

Light machine work

1.8-2.4

189-252

Heavy machine work

4.0

423

Pick and shovel work

4.0-4.8

423-504

Dancing, social

2.4-4.4

252-504

Aerobics/work out

3.0-4.0

315-423

Tennis

3.6-4.0

378-486

Basketball

5.0-7.6

522-792

Competitive wrestling

7.0-8.7

738-909

How to select clothing (clo)
The amount of clothing has some influence on the power emitted by people. It has a large
influence on the comfort experienced. The examples below give the clo-values for different
types of clothing (source: ASHRAE Fundamentals).
Clothing

Clo

Shorts, short-sleeve shirt

0.36

Trousers, short-sleeve shirt

0.57

Trousers, long-sleeve shirt

0.61

Same as above, plus suit jacket

0.96

Same as above, plus vest and T-shirt

1.14
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Trousers, long-sleeve shirt, long-sleeve
sweater, T-shirt

1.01

Same as above, plus suit jacket and long
underwear bottoms

1.30

Sweat pants, sweat shirt

0.74

Knee-length skirt, short-sleeve shirt, panty
hose, sandals

0.54

Knee-length skirt, long-sleeve shirt, full slip,
panty hose

0.67

Knee-length skirt, long-sleeve shirt, half slip,
panty hose, long-sleeve sweater

1.10

Same as above, replace sweater with suit jacket

1.04

Ankle-lenght skirt, long-sleeve shirt, suit
jacket, panty hose

1.10

Long-sleeve coveralls, T-shirt

0.72

Overalls, long-sleeve shirt, T-shirt

0.89

Insulated coveralls, long-sleeve thermal
underwear, long underwear bottoms

1.37

11.1.11.

Loads and ventilation tab

Description of fields:
Loads: Num of occup Number of occupants that load the zone [Number]
Loads: Applet for occupants Schedule for the occupancy10, 'on' corresponds to a full load [01]
Loads: Light Rated input power when lights are on [W]
Loads: Applet for Light Operation schedule for lights, 'on' corresponds to a full load [0-1]
Loads: Other Loads Dry convective heating power from appliances in the room [Number]
Loads Applet for Other Loads Operation schedule for Other Loads, 'on' corresponds to a full
load [0-1]

Operation: Thermostat setpoint, cooling The air temperature that cooling room units attempt
to maintain [°C]
Operation: Thermostat setpoint, heating The air temperature that heating room units attempt
to maintain [°C] [°C]
Operation: Applet for chiller operation Schedule for the chillers’ operation [0-1]. If the
chiller is switched off there will be no cooling available to cool the supply air or for operation
of cooling room units.
10

Drag the cursor sideways with the mouse button pressed to change the line. The vertical segment, which links
the new line with the old line, is formed automatically. No angled lines are permitted. If you make a mistake,
you can either redraw over the error or you can click on the Undo-button on the toolbar.
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Operation: Efficiency, heat recovery Temperature efficiency for the heat exchanger in the air
handling system [0-1]
Operation: Supply air flow Mechanical supply air to the zone [l/s or m3/h] This is the total
supply air flow into the zone, including the air through chilled beams11. It is incorrect if the
total amount of air through chilled beams exceeds this value. If the total amount through
chilled beams is lower than this value it means air is released into the room without passing
through a chilled beam.
Operation: Exhaust air flow Mechanical exhaust air from the zone [l/s or m3/h]
Operation: Applet for fan operation Schedule for ventilation flow [0-1.4] 0=shutoff, 1=the
requested flow. Forced flow is obtained by giving a value > 1. If, for example, the value 1.2 is
given, all inlet terminals will give 20% higher flow than that selected. In the same way 0.5
gives half the flow.

Air supply temperature, Tsup: Supply air max temperature The highest temperature blown
into the room (if the cooling machine is running) [°C]
Air supply temperature, Tsup: Supply air min temperature The lowest temperature blown
into the room [°C]
Air supply temperature, Tsup: Temperature rise, fans and ducts The temperature increase
that the supply air receives due to the fan and friction heat in the ductwork [°C]
Air supply temperature, Tsup: Applet for the supply air temperature The supply air
temperature’s setpoint in relation to the outdoor temperature; you can drag the curves [input
and output data]

11.2.

IDA Room results

This section includes a complete result report from a program run. The text from the result
report is in grey. Remarks to the different output data fields are in black 10 point italic Arial,
making them easy to find.

IDA Room 1.0
Run by Per Sahlin
Date 20 Nov 2001
11.2.1.

Project data

This data comes from respective fields in the General tab.
Description

Manual demo run

Location

Stockholm

Sizing case

Summer case

11

Chilled beams are defined as active chilled or heating beams or other room controlled heat exchangers in the
air supply ducting.
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16 Jul 2001

Customer
11.2.2.

Simulation results

11.2.2.1.

Extremes

The room
Operative temperature
during occupancy [°C]
The operative temperature is a
measurement of the
experienced temperature, the
average of air and radiation
temperatures

Value

Occurs at

min

22.2

9:00

max

23.0

14:18

452.5
Waterborne
Max heat uptake [W]
Airborne*

Max emitted heat [W]

max. value of the total
waterborne cooling
through all cooling units

14:18

177.9
max. value of ventilation
air cooling to the room

Waterborne

Ditto for heating

Airborne*

Ditto for heating

13:48

*

incl. infiltration

The air handling unit
Value

Occurs at

274.4
Max heat uptake [W]

Max emitted heat [W]

max. value of cooling
power to the central
cooling coil, note that
this includes
dehumidification of the
supply air
Ditto to the central
heating coil
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Air handling unit temperatures

°C

Last day of simulation: 2001-07-16
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Return air dry bulb temperature, Deg-C
Supply air dry bulb temperature, Deg-C
Outside air dry bulb temperature, Deg-C

11.2.2.3.

Power supplied by plant

W

Last day of simulation: 2001-07-16

450.0
400.0
350.0
300.0
250.0
200.0
150.0
100.0
50.0
0.0
0
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Cooling power to zones, W
AHU cooling coil power, W
Heating power to zones, W
AHU heating coil power, W

Cooling power is here shown as a positive quantity
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Main temperatures

°C

Last day of simulation: 2001-07-16
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Operative temperature 1, Deg-C
Mean air temperature, Deg-C

This diagram shows the room air temperature and the operative temperature at the point of the
occupant. Note that the cooling unit controller maintains a relatively constant air temperature, but the
operative temperature varies.

11.2.2.5.

Directed operative temperatures
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Heat balance

Last day of simulation: 2001-07-16
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Heat from air supply terminals and cold bridges, W
Heat from furniture, W
Heat from occupants, W
Heat from appliances, W
Heat from room units, W
Heat transmitted from windows, W
Heat transmitted from walls, W
Heat from lighting, W
Heat from daylight, W

Found here are all the energy flows of the zone’s heat balance, divided into the following categories:
item

comment

Heat from supply terminals and infiltration (no
cold bridges in IDA Room).

All air flows are accounted here, i.e. mechanical ventilation as well as
infiltration.

Heat from furniture

Normally very small (combined with walls and floors in version 3)

Heat from occupants

Includes both sensible and latent heat emitted by the occupants. The
moisture is ventilated away.

Heat from appliances (other loads) such as
computers, printers etc.

Emitted as convection in IDA Room.

Heat from controlled room units such as chilled The split between convection and radiation is automatically
beams and radiators.
calculated.
Heat from window surfaces, including both
conducted heat and absorbed solar radiation.

Incoming solar radiation affects room conditions in two ways:
1.

as directly transmitted (shortwave) radiation, which is
repeatedly reflected at room surfaces but is ultimately
absorbed by these

2.

as heat which is first absorbed in the window pane and then
reaches the room through convection and radiation.

The latter is accounted for here together with window transmission.
The first is separately displayed (see below).

Heat from walls and floors, i.e. heat which has
been stored in the structure

In the account, the control volume is just underneath each surface.
Accordingly, the curve represents conductive heat through the
structure including both storage and net transmission.

Heat from electrical lighting
Heat from daylight passing through the window Se previous comment.
pane.
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ICE Reference Manual
General
Introducrion

IDA Indoor Climate and Energy (ICE) is a simulation application for accurate study of
thermal indoor climate of individual zones (thermal zones) within a building as well as energy
consumption for the entire building. The user interface has been designed to make it easy to
build up and simulate simple cases, but also to offer the advanced user the full flexibility of
IDA, to facilitate the simulation of complex or unusual cases.
The system to be simulated consists of a building with one or more zones (rooms) and a
primary system (the subsystem containing chiller and boiler) and one or more air handling
systems. The default systems have unlimited capacity for providing the zones with air and
water at given temperatures. For many studies nothing needs to be altered in these HVAC
systems.
Surrounding buildings or other objects might shade the building. The air inside the building
contains both humidity and carbon dioxide. Weather data is supplied by weather data files
containing information on actual or synthetic weather. The effects of wind on the building
may be taken into consideration. Predefined building components can be loaded from a
database. This can also be used to store personally defined building components.
The program is built up around forms and dialogs. The Status bar can be found at the bottom
of the IDA window. In many cases it explains in brief the significance of the different areas
(list boxes, parameter boxes, etc.) that can be found under the cursor in the different forms
and dialogs. It is recommended that the user get into the habit of reading the text in the Status
bar if anything is unclear.
12.1.2.

The Geometry in IDA Indoor Climate and Energy

A building in IDA Indoor Climate and Energy can contain one or several zones (rooms). In
the present program version, a zone is a prism with any number of vertical walls, one floor
and one ceiling. Apart from windows and openings (doors), different types of heating and
cooling units can exist within these restricted surfaces.

The geometry of the building is defined by its corners (see above figure). The corners’ x and y
co-ordinates are indicated in a local coordinate system for the building (called the building
system below) that moves and rotates with the building. Before editing, the origin of
coordinates for the building system coincides with the lower left corner of the building. The
building system is then also at the origin of coordinates for the global coordinate system
(which is marked by the origin marker).
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The zone geometry is described relative to a point in the building system, where the zcoordinate gives the height of the floor above ground level.
The zone is defined by its height plus the corners of the floor. The corners’ x and y coordinates are indicated in a local coordinate system for the zone (called the zone system
below) that moves and rotates with the zone. The zone system is defined by the origin’s
coordinates (in the building system) and the rotation angle around the z-axis.
The shape of the zones are limited to prisms with vertical rectangular walls.

A local coordinate system (called the surface system) is defined on every enclosing surface.
For vertical walls, the origin of coordinates is located in the lower left corner of the surface
(from inside the zone).For floor and ceiling, the surface system coincides with the zone
system (with z-coordinate omitted).
The surface system is used to indicate the position for features (such as openings) on the
surface:

Wall
Feature

dy
y

dx
x

The geometry for objects like windows and heating devices is defined by a rectangle. The
insertion point of the rectangle (lower left corner) is given in the surface system.
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Objects in IDA Indoor Climate and Energy (in alphabetical order)

IDA Indoor Climate and Energy contains a number of objects of interest to the user.
See also Objects in hierarchical order.
Active beam
Air handling unit
Balcony, screen and marquee
Building
Chimney
Choice of output
Climate definition
Climate file
Controller setpoints
Convective interior mass
Cooling coil
Cooling device
Electric radiator
Equipment load
External window shading
Floor heating
Ground conditions
Heat exchanger
Heating coil
Heating device
Internal shading
Leak
Lights
Location
Material
Object geometry
Occupant load
Opening
Piecewise proportional controller
Pressure coefficients
Primary system
Profile
Project data
Results
Schedule
Simulation data
Site object
Skylight
Surfaces
System parameters
Thermal mass
Wall definition
Wall, Floor and Ceiling
Wall part
Water radiator
Wind profile
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Window
Zone
Zone air
Zone defaults
Zone geometry
12.1.4.

Objects in IDA Indoor Climate and Energy (in hierarchical order)

The hierarchical structure for the objects in IDA Indoor Climate and Energy are shown in the
formation below. Objects are edited either in forms or dialogs.
See also Objects in alphabetical order.
Building - Location
Wind profile
Climate data
Zone defaults
Site object
Simulation data
System parameters
Choice of output
Project data
Climate file
Ground conditions
Results objects
Air handling system
Primary system
Zone Geometry
Air
Controller setpoints
Results objects
Surfaces - Construction
Inner surface
Outer surface
Wall part
Window - Glass construction
Internal shading
Schedule for internal shading
External shading - Balcony, screen and marquee
Opening schedule
Opening - Opening schedule
Leak
Chimney
Skylight
Active beam
Heating device
Electric radiator
Cooling device
Floor heating
Lights Schedule
Occupant load - Schedule
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Equipment load - Schedule
Convective internal mass
Thermal mass
Energy meter - Energy cost
Additional consumption (schedule)
12.2.
12.2.1.

Building simulation
The building’s form

An object of the Building type is presented in a form on the screen. This contains all the
objects connected to the building. The building’s form is automatically displayed each time
the user selects to open an already existing, or a new, document (please see Working with
IDA systems). The form above shows a sample appearance of the building form. It contains
standard versions of the air handling system, the primary system and energy meters in the
HVAC-system and Energy meter list boxes.
Field descriptions, etc:
Location Location of the building. The chosen location does not have to correspond exactly
to the location of the climate file.
Climate Choice of climate object. The object contains a reference to a climate file and
information about this file or indicates that synthetic climate is to be used (design day data for
summer or winter in the Location object).
Wind profile Choice of wind profile object. Wind profile is only important for studies where
pressure coefficients are given.
Simulation data Object to select simulation model fidelity, and for describing simulation
times and tolerances, etc.
Project data Object for documentation of the simulation object and the current choice of
parameters. Project data are written on reports etc.
Requested output Specifies what diagrams and reports that will be created during the
simulation.
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Site and shading buildings Site object. A plan of building shape and shading objects.
Pressure coefficients are specified here.
Ground properties Model for temperature conditions below ground.
IDA Resources IDA resources, i.e. used input data objects.
Replace AHU ... Replace the selected AHU with a new one.
New AHU ... Add an extra AHU (If the existing one is not needed: Do 'Replace' instead)
HVAC System List of central water and air handling systems..
Energy meters List of objects with energy cost information and extra consumption. Always
three in the current version, one for zone electric energy, one for electricity in the central
systems, and one for primary energy, i.e., the type of energy consumed by the boiler.
New zone ... Add a new zone to the building. Clicking on the button New zone opens a dialog
where the default settings for new zones can be modified, possibly by selecting an already
saved standard zone.
Zones List of zone objects.
Clicking on one of the buttons Simulation data, Project data, Requested output, Building
shape and surroundings, or IDA-resources opens respectively dialogs for Choice of simulation
data, Project data, or Choice of output, or forms for Site object or IDA- resources.
Before simulating, the location of the building has to be specified and the zones (rooms) to
simulate must added to the building form. Location is selected from the database in the
Location combo box. By pressing New zone... in the building form and the Add zone, a new
zone is added into the building.
After a simulation, the result diagrams and reports chosen can be found under the Results tab
(see Dialog for choice of output).
12.2.2.

Dialog for location

This dialog describes an object of the Location type. It contains the geographical position and
design weather data for the place where the calculation object is assumed to lie.
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The given weather data for winter and summer design conditions are used when the Synthetic
(winter or summer) option has been selected in the Climate field in the building form.
Field descriptions, etc:
Position: Country country or geographical area for calculation
Position: City place for calculation
Position: Latitude calculation object’s latitude (Deg)
Position: Longitude calculations object’s longitude (Deg)
Position: Elevation calculation object’s height over sea level (m)
Position: Time zone calculation object’s time zone, e.g. -1 for Central Europe (h)
Design days: Dry-bulb min Lowest dry bulb temperature during the day (°C)
Design days: Dry-bulb max Highest dry bulb temperature during the day is considered to
occur at 15:00. (°C)
Design days: Wet-bulb maxHighest wet bulb temperature during the day is considered to
occur at 15:00. (°C)
Design days: Wind direction The wind is only relevant to the airflow through the building if
pressure coefficients are given and more than one leak or opening has been defined (Deg)
Design days: Wind speed Wind direction and speed is kept constant during the day (m/s)
Design days: Clearness number Reduction factor for direct and diffuse sunlight. 0 = dark, 1
= clear, dry and cloudless atmosphere, 1.15 = extremely clear conditions. (-)
Object: name and description
The Dialog for a location is opened when the Right button is pressed with the cursor over an
object of the Location type (e.g. Malmö) in the Location field in the building form or in the
form for IDA-resources.
For synthetic climate, the outdoor air temperature varies sinusoidally between the given min
and max values. The warmest time of day is assumed to be at 15:00, for dry as well as for wet
bulb temperature.
A clearness number indicates the presence of clouds or unclear atmospheric conditions. For a
clear, dry and cloudless sky 1 is given. A normal daily average for a clear day summer day
can be 0.8. Under extremely clear conditions, particularly in northern countries, 1.15 may
occur. Further information about clearness number and additional references can be found in
ASHRAE Fundamentals, chap. 27.
12.2.3.

Form for climate definition
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This form describes a Climate object, which provides information about an actual climate data
file on disk. Indicated here is the path to the file (.prn) which contains the data, geographical
position of the station, height of the wind measurement, etc.
The description gives qualitative information about the data, its selection, extreme weather
periods etc.
Field descriptions, etc:
Filename the name and place for the data file, which must have a special IDA-format, is
given here.
Wind measurement height wind speed data in the file corresponds to measurements at this
height over the ground (m)
Position: Station name of measuring station
Position: Country country or geographical area of measuring station
Position: Latitude measuring station’s latitude (Deg)
Position: Longitude measuring station’s longitude (Deg)
Position: Elevation measuring station’s height over the sea level (m)
Position: Time zone measuring station’s time zone, e.g., -1 for Central Europe (h)
Object: Name and description
The form for Climate definition is accessed when the Right button is pressed with the cursor
over an object of the Climate data type (e.g. Helsinki) in the Climate field in the building
form or in the form for IDA-resources.
12.2.4.

Dialog for wind profile

This dialog describes an object of the Wind profile type. A description of the wind’s profile
can be found uppermost in the box.
Field descriptions, etc:
Description
A0_COEFF coefficient in power law expression for wind speed
A_EXP exponent in power law expression for wind speed
The wind is only relevant to the airflow through the building if pressure coefficients are given
for the building facades and more than one leak or opening has been defined.
The wind speed is considered to vary vertically in accordance with ASHRAE’s model (see
ASHRAE Fundamentals, chapter 14). It is zero on the ground and reaches a speed
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corresponding to that given in the weather data at the Href height. This height is normally 10
meters and this value applies if synthetic weather is selected in the Climate field. When a
weather file with measured data is selected in the Climate field, the height is loaded from the
database and displayed in the wind measurement height field in the form for Climate
definition.
Wind speed at different heights is given by the following power law expression:
U = Umeasured*A0_COEFF(H/Href) ^ A_EXP,
where U is the wind speed in (m/s) at height H in m. Umeasured is wind speed for the actual
time in the weather file.
The wind profile’s form is accessed when the Right button is pressed with the cursor over an
object of the Wind profile type (e.g. Default urban) in the Wind profile field in the building
form or in the form for IDA-resources.
12.2.5.

Choice of Simulation data

Click in the Simulation data box in the building form to open a dialog with the same name.
Select here the default zone model and give integration parameters.

Begin by selecting the degree of accuracy for the mathematical models of the zones
themselves and the surrounding walls and floor. If the Climate model button is selected, a
very detailed physical model of the building and its components with, for example, the
possibility for a vertical temperature gradient will be simulated. If instead the Energy model
button is selected, a simpler physical model is used. It has a more conventional degree of
accuracy based on a mean radiant temperature. Consequently, the calculation time will be
somewhat shorter, all else being equal.
The energy model does not calculate daylight or directed operative temperature. The climate
model is currently restricted to zones with rectangular geometry.
Both zone models use the same description of the building. All the component models in and
around the zone such as windows, radiators, controllers, leaks, terminals, etc. are common for
the simplified and detailed zone models.
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Choice of model can also be made for every zone locally in the zone’s form in the Model
fidelity combo box. Choice for the whole building in the dialog above does not apply to those
zones in which local choices have been made.
In the Calculation tab, select between a periodic or a dynamic simulation. A periodic
simulation means a certain day is simulated a number of times until the system has stabilized
and no longer changes. The actual day’s date is given in the From date field. Click on the
Calendar button to select a date or type directly in the field.
A dynamic simulation means that the simulation starts at a particular date and ends at another
date. Both these dates are indicated in the same way as the date for periodic simulation. How
the simulation is to be initialized must also be indicated for a dynamic simulation. For this
reason, another tab, named Startup, is added to the Simulation data dialog.

The startup phase can also be periodic or dynamic. Make the selection in the same way as
above. A periodic startup phase means that the selected day is simulated a number of times
until the system has stabilized. A dynamic startup phase means that a selected number of days
are simulated before the proper simulation starts.
How long the startup phase should be depends on how heavy the building is. The heavier the
building, the longer startup phase is required. Approximately two weeks should however
always be enough for realistic buildings. In both cases, no intermediate results are saved from
the startup phase.
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Integration parameters can be selected under the Advanced Tab in the dialog. See also
Chapter 10 in the manual for description of these parameters.
Field descriptions, etc:
Tolerance This number determines how accurately equations are to be solved (-)
Maximal timestep The largest timestep to be taken (h)
Maximum number of periods Maximum number of periods in a periodic simulation.
Tolerance for periodicity Tolerance for periodicity in a periodic simulation (-)
Time step for output If greater than zero, recorded times in output files will have this
timestep (h)
The tolerance given is the degree of accuracy reached in the calculated variables. It is absolute
for small quantities (normally < 1) and relative for larger quantities (normally >1). The
precise definition of Tolerance is given in the documentation for IDA Solver, which can be
obtained from EQUA. Relaxing the tolerance should normally result in a faster simulation.
However, if the tolerance is relaxed too much, the solver will have greater trouble to find a
solution at all and this in turn costs execution time and causes poorer stability.
For a dynamic simulation, the solver will select the time step up to the Maximal timestep
specified. Allowing very long timesteps may create stability problems for the solver that in
turn cost time to resolve.
In the case of a periodic simulation, the number of periods can be limited and a tolerance
chosen for the relative changes required from day to day, for the simulation to be considered
periodic.
If a Time step for output has been given, result files will be interpolated to have a fixed
timestep, enabling for example Excel comparison of results between different runs.
Simulation timestep is still variable.
See also Topic note on timesteps at the ICE User Support web page (Help menu).
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Dialog for project data

The dialog for an object of the Project data type is displayed by clicking in the box with the
same name in the building form. A project can be documented here by entering information
regarding customer and responsible engineer, etc.
Field description:
Customer text
Responsible engineer text
Description This gives a short description of the simulated system.
The text is printed on generated reports.
12.2.7.

Edit the shape, orientation and surrounding of the building

In the form for the building’s site, the building’s initial shape (rectangular) and height (6.0 m)
can be seen, and also that it is not shaded by surrounding buildings. To change the size and
position of the building, first click once within the building’s boundary lines (not in the height
box). The size can then be changed by dragging the small squares along the sides of the
building, and the position changed by dragging the whole building.
The easiest way to change the building orientation is by turning the compass needle in the
upper left-hand corner of the window. Select the compass needle and drag the small square
close to the compass’s North point (N) to the required position. The desired compass direction
can also be given numerically if the symbol is opened first.
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To replace the rectangular shape of a building by an arbitrary polygon, right click somewhere
within the building (not in the height box) and select Edit. The perimeter of the building is
changed to a so-called polyline. A polyline consists of line segments and break points, the
latter marked by small rectangles. The polyline can be edited in five ways:
- Its breakpoints can be dragged to the desired positions for the building’s corners.
- Its line segments can be dragged to the desired positions for the building’s walls.
- A new breakpoint can be introduced by clicking on or close to the line.
- An existing breakpoint can be deleted by clicking on it.
- Breakpoints for non right-angled corners can be introduced by holding the Control key
down and simultaneously clicking on a segment of the line.
Click once with the Right button and select OK to end editing, or alternatively press Enter (to
accept) or Esc (to cancel). As an example, the figure below has had a new breakpoint
introduced directly to the right of the middle on the building’s south wall. The wall to the
right of this breakpoint has then been dragged down and an angle-shaped building has been
created.

Note also that the program automatically allocates names to all the facades created by the
introduction of new breakpoints. This allocation has not yet taken place in the figure above,
but can be seen in the last figure in this part.
The building can also be assigned geometry in the form of coordinates. This is done in
Properties for building. Right click on the building an select Open.
Position and height of shading objects can be defined. This is done with the aid of a polyline
along the object’s defining surface. To create a shading object, select New Object (Shading
building)… from the Insert menu. Now create a polyline by clicking at its starting point,
breaking points, and end point within the form. Click once with the right button and select OK
to end. The desired height is introduced into the blue box in connection to the shading object.
The figure below illustrates a polyline with four points and a height of 4.5 meters. The
shading objects can be moved and changed. An object can be selected with the left button,
making the surrounding rectangle visible and movable. Use the right button menu to select
Edit and edit the polyline, as previously described.
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The facades’ pressure coefficients for different wind directions can be indicated via selecting
Pressure from the menu displayed when the Right button is pressed with the cursor over the
building.
There is one other way to move the building, by which it can also be rotated. Do this by
holding down the Alt-key and drag at a point within the building’s boundary. The building is
then drawn along and follows the same movement pattern as a playing card being pulled by a
finger on a table. Friction between the card and the table controls the card’s movement. It is
advisable to avoid editing a rotated building, due to limitations in screen resolution.

12.2.8.

Dialog for Pressure Coefficients

Pressure Coefficients are used to calculate wind pressure on the different external surfaces of
a building in relation to the speed of wind at ceiling height. See ASHRAE Fundamentals. The
wind only influences airflow through the building if non-zero pressure coefficients are given
and more than one leak or opening has been defined in a zone.
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The pressure coefficients are dependent on the building’s shape and as well as on surrounding
aerodynamic conditions. CFD calculations or wind tunnel measurements are required for
good precision. In simple cases, handbook data can give acceptable information.
The wind’s contribution to pressure is assumed to be constant over the whole surface and is
given by the following expression:
P_OUT := (PRESSURE-COEFF * RHO * ON-SITE-WIND**2)/2,
where the applicable PRESSURE-COEFF depends on facade and wind direction (linear
interpolation between given directions), RHO is the air density and ON-SITE-WIND is the
speed of wind at the roof height of the building.
This dialog is accessed from the Site form.
12.2.9.

Ground conditions

The dialog for an object of the type Ground conditions, is displayed by clicking on the button
with the same name in the building form. Here the ground layers and temperature conditions
under and around the building can be described.
Field description:
Ground layer outside basement's walls Construction for average path between basement
wall and ground surface.
Ground layer under basement's slab Construction for ground layers down to constant
temperature.
Temperature below the ground layer Temperature below the surface layer affected by
seasonal variations.
Two layered constructions can be specified, with material layers described as for walls. These
two constructions describe ground around basement walls and under the basement floor
respectively.
When the building model is created, these layers are added to the wall desciptions for walls
under ground and ground floor slab. The material layers added can be inspected in the
advanced level, by opening the corresponding objects.
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The ground layer under the basement floor is coupled to the ground temperature specified in
the dialog, which is treated as constant. The layers around the basement walls are coupled to a
facade object for crawl space, which is kept at ground surface temperature. Note that no 2D or
3D effects are modelled for either of these couplings.
12.2.10.

Form for energy meter

Field descriptions, etc:
Energy rate plan Select object with time dependent energy price information.
Schedule for extra consumption [kW] Select schedule for extra energy consumption to be
accounted for in calculation of total energy cost. Output signal in kW.
Total energy consumption and costs are presented in special reports. Click on Requested
output in the building form.
The form for energy meter is opened by double clicking on an object of the Energy meter type
(e.g. Electric meter) in the Energy meters box in the building form.
12.2.11.

Dialog for energy price

In this dialog a description of the objects of the Energy price type can be given.
Field descriptions, etc:
Currency Currency name.
Fixed cost, Kr/year Fixed yearly cost.
Energy rate, Kr/kWh
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Schedule for rate Choose a schedule that selects rate at different times. Output signal should
be 1,2,3 or 4 at all times.
Object: Name and description
The dialog for an energy price is opened from the Energy meter form by opening the object in
the Energy rate plan field.
12.2.12.

Edit the zone position and size in the floor plan

Clicking on the Floor plan button in the zone’s form opens a form for the floor plan (can also
be reached from the building level, by the Floor plan tab. The position and size of the zone
can be changed here. The active zone is indicated by a red border. Any other existing zones in
the building, both on the same floor and on other floors, (paler gray lines), are also visible. All
zones in the same floor, plus the building shape, can be edited. The building shape is best
handled in the Site view, although it is possible to edit it also in the Floor plan.
To change the position of the zone select it, put the cursor somewhere within the zone’s
boundary lines and drag it with the mouse to the desired position in the building. The
coordinates for the cursor position can be found in the lower right corner of the IDA-window.
Hold the zone for a few seconds in a position close to an exterior or interior wall (even on
another level), and it will automatically snap into position. This can include a smaller rotation
if necessary.
The size of the zone can be changed by first selecting it and then dragging one of the small
rectangles either in the corners or in the middle of the sides. It is also possible to give
numerical values for the zone’s corners in the form for the zone’s geometry. This form is
visible when the zone is selected if Property Page has been selected in the Options menu.
The shape of the zone can be edited after right clicking in the zone and selecting Edit. The
editing is handled in the same way as for the building (see Edit the shape, orientation and
surrounding of the building).
The zone can also be rotated by holding down the Alt-key, while dragging a point within the
zone’s boundary lines. The zone is dragged along and follows the same movement pattern as
a playing card being pulled by a finger on a table. Friction between the card and the table
controls the card’s movement.
Note that if a zone is moved so that, e.g., an external wall becomes an internal wall, the wall
construction corresponding to the new position will be selected automatically. This also holds
for parts of walls.
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Walls are automatically coupled to zones and exterior walls that they adjoin. The couplings
should not be created by the user.
See Geometry in IDA Indoor Climate and Energy for a description of how the geometry and
coordinate systems in IDA Indoor Climate and Energy are defined.
Along the bottom of the form, there are five buttons:
Import CAD
Import of an IFC model or Windows graphics as background.
New zone
When a new zone is entered, the basic geometry of the zone has to be entered in the floor
plan.
IFC Mapping
The transfer of data objects from the IFC model to IDA is described here.
View size
Presents the relation of the drawing pad to the coordinate system.
Level: xxx m
Press here to view the floor plan at some other height in the building.
12.2.13.

The building’s geometry
The geometry of the building can be edited here. The coordinates are
given in the site plan coordinate system. Orientation indicates how the
building has been rotated in relation to its original position.
Field descriptions, etc:
Origin: x, y, z (m)
Size: x, y, z (m)
z max Coordinate relative to ground of the highest point of the building
(m)
z min Coordinate relative to ground of the lowest point of the building
(negative if a basement is present) m
: orientation (rotation) relative to original position (Deg)
Corners [m, rel. to the origin]: x, y
See Geometry in IDA Indoor Climate and Energy for a description of
how the geometry and coordinate systems in IDA Indoor Climate and
Energy are defined.

12.2.14.

Floor level dialog

Show floor plan at level
Select from the list of floor levels or type a new one
Section height fr. floor
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Show all zones that overlap with layer from "level" to "level"+"section height"
Building top
The height of the building (floor of attic) above ground
Building bottom
Height of ground floor slab above ground (negative if below ground)
12.2.15.

CAD import

ICE can import CAD IFC files of IFC release 1.51, generated by, e.g., ArchiCAD, AutoCAD,
Architectural Desktop, Microsoft Visio, Phytagoras’ Facility etc. ICE imports information
about wall, window and door positions. ICE relies on the existence of ifcSpaces for creation
of simulated zones. At last, ICE imports styles for walls, windows and materials that can be
used to provide an appropriate property set to a group of imported objects in ICE.
See Chapter 7 of the manual and special ICE topic document IFC Import.pdf for details.
IDA can also import drawings which have been converted to the common Windows’
graphical formats (.bmp, .wmf, and .emf). Such drawings may be displayed in the background
of the floor plan view.
12.2.16.

IFC mapping

Category
Select an IFC category for mapping (begin with materials)
IFC data
Available IFC data of the selected category
ICE resources
Available IDA resources of the selected category
Map to selected
Map the selected IFC objects to the selected IDA resource
First select one or more IFC objects and one IDA resource
Unmap selected
Disconnect selected IFC objects from their IDA resources
Import from IFC
Make a new IDA resource from IFC object. Only import of walls is implemented. Import
not possible if the materials used in the wall are not already mapped to ICE
View
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Show the selected IDA resource
Load from Db
Load resource from ICE database
Create new
Create a new IDA resource
See also Chapter 7 of the manual for further instructions.
12.2.17.

Default settings

Input given here will be used unless other data has been given in the zone.
Template for new zones
Template used when new zones are added
Elements of construction
External walls
Construction for external walls lacking descriptions in the zone.
Internal walls
Construction for internal walls lacking descriptions in the zone.
Internal floors
Construction for internal floors lacking descriptions in the zone.
Roof
Construction for roofs lacking descriptions in the zone.
External floor
Construction for floor slabs lacking descriptions in the zone. A ground insulation layer
is normally described as part of the ground structure.
Glazing
Glazing for windows lacking descriptions in the zone.

116

IDA Indoor Climate and Energy 3.0
12.2.18.

EQUA Simulation AB 2002

Zone defaults

In this dialog, templates for new zones can be created and modified. A new template is
created by modifying parameters and then save under a new name (Save as ...). A library of
typical zones can be created in this way.
Field descriptions, etc:
Zone name
The name of the new zone template
Use template
List of alternative settings for new zones
General, Size, Loads, Construction
Save changes
Check to keep all changes for next added zone; uncheck if the changes are for this zone
only
Show this dialog when inserting a zone
If not checked, zones are added without this dialog
Add zone
Add a new zone with the given parameters
Ok
Accept changes
General
Model fidelity 'Standard' = choice is done at building level. 'Climate' = better result, gradients
included. 'Energy' = faster, no gradients. The selections 'Climate' or 'Energy' have priority
over the selection at the building level. (See Choice of simulation data for descriptions of the
different models.)
Controller setpoints Choice of control values for temperature, air quality, and light.
Thermal bridges
Total loss factor Direct heat transfer between room air and outside air, Watts per degree
(C) temperature difference (W/°C)
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Furniture
Covered part of the floor Fraction of floor area which is covered by furniture. (0-1)
Weight / area with furniture Total weight of furniture divided by the covered area.
(kg/m2)
Air
Select AHU Choice of air handling unit from the types available at the building level.
System type Type of ventilation system. Constant or variable flow, with different
controls. All systems are supply/exhaust.
Exhaust air for CAV Mechanical exhaust airflow for CAV systems (l/s m2 floor area).
VAV flows are given in Controller setpoints. Clicking on the button l/s m2, opens a
dialog where the flow can be specified in alternative ways (l/s or m2/h for entire zone,
m3/h/m2, or air changes per hour).
Gradient calculation Choice of: Displacement ventilation, well-mixed air, or a vertical
temperature gradient given by the user.
Gradient Given temperature gradient. Relevant only in the case 'Fixed gradient'. (°C/m)
Supply air / exhaust air Supply air flow in relation to exhaust flow. Set to 0 for pure
exhaust ventilation. Exhaust - Supply = Infiltration. (-)
Leak area at 4 Pa, 1 m above floor ELA Equivalent leakage area in the climate shell.
Relevant only when other leaks exist, e.g. open doors. (m2)
Air velocity in the occupied zone Air velocity for the calculation of comfort index
(m/s).
Size
Size in x-direction Can be modified later
Size in y-direction Can be modified later
Floor area Calculated automatically
Room height Distance between floor an ceiling (m).
Loads For automatic addition of occupant and equipment loads. These will be added to a new
zone in proportion to the initial zone floor area. If the zone size is later on changed, the loads
will not be changed accordingly.
Select type and schedule
Occupants
Equipment
Lights
Construction
External walls
Construction for external walls not described in the zone.
Internal walls
Construction for internal walls not described in the zone.
Internal floors
Construction for internal floors not described in the zone.
Roof
Construction for roofs not described in the zone.
External floor
Construction for ground floor slabs not described in the zone. A ground insulation
layer is normally described as part of the ground structure.
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See Geometry in IDA Indoor Climate and Energy for a description of how the geometry and
coordinate systems in IDA Indoor Climate and Energy are defined. The form for building
geometry is reached by selecting Properties in the Options menu. See Edit the shape,
orientation and surrounding of the building.
12.2.19.

ASHRAE

American Society for Heating, Refrigerating and Air-conditioning Engineers
(http://www.ashrae.org)
12.2.20.

Weights

Every zone can be given a weight that is used for calculating the combined flows from all
zones of a building. The weight is indicated in the zone’s form, in the Number of zones of this
type field.
12.3.
12.3.1.

HVAC Systems
The Primary system

See also the section on Primary system in Chapter 6 of the manual.
Descriptions of fields in the box Main parameters:
Max. power, boiler A max capacity for the boiler’s heat production, excluding domestic hot
water can be given here. When the limit is reached, the boiler will no longer be able to
maintain the setpoint for the hot water supply temperature. (kW)
Efficiency, boiler The boiler produces hot water (including domestic) with this efficiency in
relation to the supplied, so-called, primary energy. (-)
Max flow, dom. hot water Highest domestic hot water flow. A schedule is given in the form,
which indicates consumption’s time profile in relation to this value. (l/s)
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Temp., domestic hot water Domestic hot water temperature to consumer, incoming water is
considered to hold 5 °C in the default configuration. (°C)
Max. power, chiller here a max capacity for the chiller’s production. When the limit is
reached the chiller will no longer be able to maintain the setpoints for the coolant
temperatures. (kW)
COP, chiller The efficiency at which the chiller produces cooling power in relation to the
supplied electrical power. This is kept constant independent of temperatures and any part
loads. (-)
Coolant temp. to AHU Setpoint for water temperature to the central cooling coil. (°C)
Coolant temp. to zones Setpoint for water temperature to local zone units. (°C)
The form above is most easily opened from the building form by double clicking on the
Primary system object in the HVAC systems box.
12.3.2.

Air Handling System

Read about the Air handling system in Chapter 6 in the manual.
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Form for Heating Coil

The figure illustrates the form used for an object of the Heating Coil type. A heating coil is
one of the parts in the air handling system. The form is most easily opened by double clicking
on the symbol for heating coil (hc) in the air handling system’s Schema.
Field description, etc:
ETAAIR Air side effectiveness at capacity (-)
DTLIQ Liquid side temperature drop (°C)
The heating coil has two important parameters, ETAAIR, the air side temperature efficiency
and DTLIQ, the desired waterside temperature reduction. Capacity control is achieved by
adapting the actual efficiency up to the given maximum efficiency level. The necessary water
flow is calculated and the water temperature is reduced, if possible, by the desired number of
degrees. There is no bypass on the liquid side; control is achieved by simply restricting the
water flow.
In the default configuration, the temperature efficiency is set at 1.0. There are two situations
when it may be desirable to change this to a more realistic value: for coil sizing by means of
simulation experiments, and when making energy calculations in cases where the boiler
efficiency is dependent on temperature conditions (this dependence is not modeled in the
standard boiler). In addition, the simplest and quickest way of removing the entire coil is to
set the efficiency to zero.
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Form for cooling coil

The figure illustrates the form used for an object of the Cooling coil type. A cooling coil is
one of the parts of the air handling system, which is included in every building created. The
form is most easily opened by double clicking on the symbol for the cooling coil (cc) in the
air handling system’s Schema.
Field description, etc:
ETA Air side effectiveness at capacity (-)
DTLIQ Liquid side temperature rise (°C)
The cooling coil works in the same way as the heating coil but is mathematically more
complicated because air dehumidification is calculated. The given efficiency is defined as (1 "bypass factor") according to ASHRAE’s nomenclature. Physically, this means that the state
of the cooled air in the psychometric chart is on a straight line between the state for the
incoming air and the apparatus dew point temperature on the saturation curve.
In the model, the average temperature of the liquid side defines the apparatus dew point. On
this line, the given efficiency indicates the status: 0 is no cooling whatsoever, and 1 indicates
maximum cooling, which also means that the air temperature may be chilled to (the
arithmetical) mean value of the coolant’s incoming and outgoing temperatures
12.3.5.

Form for choice of schedule

The form is used for algorithmic objects that describe a time schedule.
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Form for Heat Exchanger

The figure illustrates the form used for an object of the Heat Exchanger type. A heat
exchanger is one of the parts in the air handling system. The form is most easily opened by
double clicking on the symbol for heat exchanger in the air handling system’s Schema.
Field description, etc:
ETA Effectiveness at full capacity (-)
TEXHOUTMIN Minimum allowable temperature of exhaust air stream (°C)
The heat exchanger is controlled by the actual efficiency selected by the model (up to the
maximum limit set by the user), so that the setpoint for the supply air temperature is reached,
if enough heat is available. The temperature of the (often chilled) exhaust air, which may not
fall below a certain level (TEXHOUTMIN parameter in the form), sets another limit. This is
to avoid freezing.
The heat exchanger takes into consideration condensation on both the supply and exhaust
sides. During wet processes, the given efficiency is interpreted as (1 - "bypass factor") in the
same way as for the cooling coil, but the apparatus dew point for the heat exchanger is
defined as the incoming temperature for the opposite medium.
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Edit temperature depending input

Certain input in IDA Indoor Climate and Energy depends on outdoor air temperature. Under
the Data Tab in the piecewise proportional controller dialog, a number of points can be given
to define such dependency. As an example, the Dialog box is opened in the form for primary
system and air handling system by double clicking on the symbol with the following
appearance:

Field descriptions, etc:
Description Object description.
Points
Add
Delete
Selected point: Ambient temperature
Selected point: Supply heating water temp

Under the Diagram Tab, the temperature dependency is presented in the form of a curve. This
can be edited, which is done as a polyline. When the curve is edited, the points under the Data
Tab are then corrected.
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Field descriptions, etc:
Edit
Properties
A polyline consists of line segments and break points, the latter marked by small rectangles.
In this case, it can be edited in three ways after double clicking on it or clicking on the Edit
button:
1.
Its break points can be dragged to the desired position.
2.
A new break point can be inserted by clicking on or close to the line.
3.
An existing break point can be deleted by clicking on it.
To end editing, click once with the Right button and select OK. The curve can then be
examined before leaving the dialog. Alternatively, the curve can be edited by defining points
under the Data Tab.
12.4.
12.4.1.

Zone
Zone form

This form presents an object of the Zone type. It is most easily opened by double clicking on
the name of a zone in the Zones list box in the building form or by double clicking on a zone
in the Floor plan.
Field descriptions, etc:
Model fidelity 'Default' = choice is done in the Simulation data dialog at the building level.
'Climate' = better result, gradients included. 'Energy' = faster, no gradients. Selecting 'Climate'
or 'Energy' here has priority over the selection at the building level. (See Choice of simulation
data for descriptions of the different models).
Number of zones of this type Number of rooms with these conditions. Central consumption
of air, water and electricity is increased by this factor.
Loss factor for thermal bridges Direct heat transfer between room air and outside air, Watts
per degree (C) temperature difference. (W/°C)
Controller setpoints Choice of control values for temperature, air quality and light.
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Air
Select air handling unit Choice of air handling system from the ones available at the
building level.
System type Type of ventilation system. Constant or variable flow, with different
controls. All systems are FT.
Exhaust air for CAV Mechanical exhaust air flow for CAV systems (l/s m2 floor area).
VAV flow is given under Controller setpoints. Clicking on the button l/s m2, opens a
dialog where the flow can be specified in alternative ways (l/s or m2/h for entire zone,
m3/h/m2, or air changes per hour).
Gradient calculation Choice of: Displacement ventilation, well-mixed air, or a vertical
temperature gradient given by the user.
Gradient Given temperature gradient. Relevant only in the case 'Fixed gradient'. (°K/m)
Supply air / exhaust air Supply air flow in relation to exhaust flow. Set to 0 for pure
exhaust ventilation. Exhaust - Supply = Infiltration. (-)
Leak area at 4 Pa, 1 m above floor ELA Equivalent leakage area in the envelope. Of
importance only when other leaks, e. g., through open doors, also exist. (m2)
Air velocity in the occupied zone Air velocity for the calculation of comfort index
(m/s).
Geometry
Room height Distance between the floor surface and the ceiling. (m)
Floor height above ground Distance between the floor surface and the ground (m).
Determines whether the zone is vertically connected to surrounding zones. Relevant for
shading calculations.
Floor plan Object for indicating the size and position of the zone in the building. Other
defined zones are shaded gray.
Enclosing surfaces By default the zone is rectangular with six surrounding surfaces,
called main surfaces. When an alternative geometry is defined, the main surface names
will be extended with a letter suffix (e.g. wall 1 can be split into wall 1a and wall 1b).
Windows, doors, and radiators, etc are introduced as objects on the corresponding zone
surfaces.
Loads Use menu 'Insert | New object' to add equipment, light, and occupant loads here.
Internal masses Use menu 'Insert | New object' to add internal masses: Walls entirely inside
zone or purely convective masses.
The choice of model fidelity (in the combo box with the same name) will have precedence
over the selection made at the building level in the dialog for Simulation data.
Tolerances for zone climate control can be set by selecting a resource or data base object in
the Controller setpoints combo box.
Indicate the zone height in the upper left of the Geometry box. The zone’s vertical position in
the building is indicated in the Floor height from ground field. Clicking on the Floor plan
button opens a form for the floor plan where the size and horizontal position of the zone in the
floor plan can be changed. Forms for walls, floor and ceiling are accessed under the heading
Enclosing surfaces.
Three types of objects can be added to a zone by inserting them in the zone’s form. These are:
Occupant load, Lights and Equipment load. To insert any of these in a zone select New
object… from the Insert menu and the desired object type in the Insert object dialog. The
figure below has one object of each type inserted. Other equipment, such as radiators and
cooling panels, are inserted directly on an enclosing surface.
There is a shortcut to Drawings describing objects on the surface for the floor, ceiling and
walls. Instead of going, for example, via the floor’s form, double click directly on the floor in
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the zone plan in the upper right of the zone’s form. The Status bar is of great help here as it
indicates which object that will be opened depending on where in the plan the cursor is
located. The forms for floor, ceiling, walls, windows, and doors can be opened in this way.
Zone air flow
In the default configuration, each zone has three air flow paths: through the supply and
exhaust terminals and via leakage through the envelope. When two zones are placed adjacent
to each other and there is an opening in the common wall between them, or when windows
are open, additional flow paths are created.
The terminals are always of VAV (Variable Air Volume) type. This means that as long as
there is sufficient pressure head, a given flow is maintained. In CAV (Constant Air Volume),
the simplest case, the control signal is set to zero. In a VAV system, a proportional controller
regulates the flow with respect to temperature, carbon dioxide or humidity levels in the zone.
Since flows through two of the three paths are given (either directly, by the user, or through
the controller), the size of the third path, the leak, is important only for the pressure in the
zone, and not for the flow through the leak. The pressure in the zone, in turn, is important
only if there is a connection with other zones, through other leaks or open doors. These are
the only cases where it is necessary to determine whether the size of a leak is appropriate.
There are two different forms for airflow in the zone. The figure below shows a portion of the
zone form. On it, those fields which are important to the flow are circled. Opening the
controller setpoints field (first right click on the combo box, then select open ), opens the
other form.

När fläktarna är igång (fläktdrift styrs via Luftbehandlingssystemet) ges infiltrationen som
skillnaden mellan valt frånluftsflöde och tilluftsflöde (det senare väljs indirekt via Faktor
tilluft / frånluft). När fläktarna står still kvarstår små flöden genom ventilationssystemet, dels
för att det kan leda till numeriska problem om de sätts till exakt noll och dels för att
representera en tänkt infiltration. Infiltrationsflödet när fläktarna står ges centralt via
parametern SYSPARS.VENT_OFF_AIRFLOW. Denna kan nås från dispositionsvyn.
Enheten är liter per sekund och m2 ytterväggyta (inkl. fönster).
Forcering av alla mekaniska luftflöden i förhållande till givna börvärden kan fås genom att
ändra schemat för fläktdriften i Luftbehandlingssystemet.
För beskrivning av lokal kyla och värme se Rumsapparater för kyla och värme.
In the zone form, the user can select System type (CAV, VAV with temperature control, VAV
with CO2 control or VAV with humidity control). For CAV, the required airflow is given in
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the zone form through Exhaust air for CAV. The parameter Supply air / exhaust air,
determines the ratio between the supply and exhaust airflows. If 0 is selected here, there will
be negligible airflow through the supply air system. This is the easiest way to create a pure
exhaust air system. Leakage area at 4 Pa gives the size of the envelope leak, according to the
ASHRAE definition (ASHRAE Fundamentals, ch. 14). In the combo box Controller
setpoints, the user can select an object with a collection of relevant zone-level controller
setpoints.
When the fans are running (fan operation is controlled from the AHU), infiltration is
calculated as the difference between specified exhaust and supply flows (the latter is set via
factor Supply air / exhaust air). When the fans are stopped, small residual flows are
maintained in the ventilation system, partly because zero flows cause numeric problems,
partly to generate a reasonable infiltration. This infiltration flow is specified by the system
parameter SYSPARS.VENT_OFF_AIRFLOW, which can be reached via the Outline tab. The
unit is litres per second and m2 exterior wall area (including windows).
A forced ventilation, where all mechanical flows are changed relative to their set points, can
be achieved via the schedule for fan operation in the air handling system.
For a description of heating and cooling devices, see Room units for cooling and heating.
12.4.2.

Dialog for controller setpoints

The dialog for objects of the Controller setpoints type defines all the quality requirements for
the zone’s climate.
Field descriptions, etc:
Comfort temperature
Min Setpoint for heating controller. (°C)
Max Setpoint for cooling controller. (°C)
Design temperature
Min Minimum zone temperature permitted. (°C) (At present not in use.)
Max Maximum zone temperature permitted. (°C) (At present not in use.)
Mech. exhaust air flow
Min Minimum flow at VAV. Recommended minimum airflow. (l/s/m2)
Max Maximum flow at VAV. Recommended maximum airflow. (l/s/m2)
Relative humidity

128

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

Min Level of humidity below which minimum VAV flow is kept. Only for VAV with
humidity control. (%)
Max Level of humidity above which maximum VAV flow is kept. Only for VAV with
humidity control. (%)
Level of carbondioxide
Min Level of carbondioxide below which maximum VAV flow is kept. Only for VAV
with CO2 controlling. (ppm (vol))
Max Level of carbondioxide above which maximum VAV flow is kept. Only for VAV
with CO2 controlling.. (ppm (vol))
Light at workplace
Min Light intensity at the working surface below which a maximum of electric light is
turned on. (Lux)
Max Light intensity at the working surface above which the electric light is fully off.
(Lux)
Object: name and description
The dialog for controller setpoints is opened by the Right button menu with the cursor over an
object of the Controller setpoints type, (e.g. Office, normal standard) in the Controller
setpoints field in the zone form or in the form for IDA-resources.
The limits specified in the dialog are used by controllers of the zone climate.
The values for design temperatures are currently not used. In future versions they will be used
for automatic dimensioning of room units.
For a VAV system, the given minimum value of Mechanical exhaust airflow provides the
lowest allowable airflow, with the maximum value providing the highest one. In the case of
CAV, the desired flow is given directly in the zone form. If the chosen CAV flow falls
outside the quality range provided in Controller setpoints, a warning is issued when the
simulation is started.
The limits for CO2 and relative humidity are relevant for the corresponding VAV control
Schema only. If the user selects CO2 control, (in the zone form), the airflow is varied in
relation to the CO2 content of the air in the zone. A CO2 value, which equals or exceeds the
given max-value results in the maximum flow through the exhaust terminal, with a minimum
CO2 value producing the given minimum airflow. The humidity control function is entirely
analogous with respect to relative humidity.
Temperature controlled VAV systems function somewhat differently. Here, the maximum
comfort temperature value is used. Forcing of the VAV flow begins somewhat below
(normally 1 °C) the indicated maximum value. Full exhaust flow is reached at somewhat
above (normally 1 °C) the maximum temperature value. The throttling range is normally 2 °C,
but can be selected at the building level. (Outline View, SYSPARS.TEMP_THROTTLE). (If
too narrow a range is selected, however, finding a solution may prove to be difficult.)
The minimum and maximum comfort temperature values are also important for control of
radiators and cooling devices in the zone. See section Room units for cooling and heating.
12.4.3.

Operative temperatures

The operative temperature is the average of the air temperature and a radiation temperature at
a certain point. This is the temperature which is felt by a person in a room. It is calculated for
each occupant load taking account of its position in the room. When an occupant load is first
inserted it is given a default position in the middle of the room, with a center of gravity
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(sitting) at 0.6 m above the floor. This position can be changed by opening the surface editor
for the floor.
To learn about the operative temperature at a point without introducing an additional thermal
load, the number 0 is given in the field for Number of people in the form for the Occupant
load.
Directed operative temperatures, in six directions, are available in the zone model at the
advanced level.
12.4.4.

Form for occupant load

Every object of the Occupant load type (zero or more people) inserted in a zone (see Insert
object) is edited in this form.
Field description, etc:
Number of people Number of people in the group.
Schedule Schedule for the presence of the group. The output signal must be within [0, 1].
Activity level Activity level according to Fanger (met)
Clothing Degree of clothing according to Fanger. (clo)
Object: Name and description
See below for a more detailed description of met and clo:
The form for an occupant load is opened e.g. by double clicking on an object of the Occupant
load type (e.g., Occupant load 1) in the Loads box in the zone form.
The occupant load’s position on the floor in the zone can be changed in the Surface editor (for
the floor). An occupant load is indicated by a chair icon. Several occupant loads can occur in
the same zone.
Measuring points for operative temperature coincide with occupant loads. To follow the
operative temperature at a certain point without loading the zone, select 0 for the number of
people or the always off schedule.
Selecting activity level (met)
The activity levels and, to some degree, the amount of clothing, defines how much heat
(sensible and latent) and carbon dioxide a person emits. 1 met corresponds to 58.2 W per m2
body surface, which is the amount one sitting, inactive person is assumed to emit. In IDA
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Indoor Climate and Energy, body surface has been selected to be 1.8 m2, corresponding to an
average adult. The examples below give the emitted total power and activity levels during
different activities, which are assumed to be continuous. (Source: ASHRAE Fundamentals).
Activity

met

Sleep
Reclining rest
Seated quiet resting
Standing, relaxed, rest
Walking (3.2 km/h)
Walking (4.3 km/h)
Walking (6.4 km/h)
Reading, seated
Typing
Office walking
Office lifting/packing
Cooking
Housecleaning
Light machine work
Heavy machine work
Pick and shovel work
Dancing, social
Aerobics/work out
Tennis
Basketball
Competitive wrestling

0.7
0.8
1.0
1.2
2.0
2.6
3.8
1.0
1.1
1.7
2.1
1.6-2.0
2.0-3.4
1.8-2.4
4.0
4.0-4.8
2.4-4.4
3.0-4.0
3.6-4.0
5.0-7.6
7.0-8.7

Power
[W]
72
81
108
126
207
270
396
108
117
180
216
171-207
207-360
189-252
423
423-504
252-504
315-423
378-486
522-792
738-909

How to select clothing (clo)
The amount of clothing has some influence on the power emitted by people. It has a large
influence on the comfort experienced, which is measured with PPD (percentage of people
dissatisfied) and PMV (predicted mean vote). 1 clo equals a heating resistance of 0.155
m2K/W. The examples below give the clo-values for different types of clothing (source:
ASHRAE Fundamentals).
Clothing
Shorts, short-sleeve shirt
Trousers, short-sleeve shirt
Trousers, long-sleeve shirt
Same as above, plus suit jacket
Same as above, plus vest and T-shirt
Trousers, long-sleeve shirt, long-sleeve
sweater, T-shirt
Same as above, plus suit jacket and long
underwear bottoms
Sweat pants, sweat shirt
Knee-length skirt, short-sleeve shirt, panty
hose, sandals
Knee-length skirt, long-sleeve shirt, full slip,

Clo
0.36
0.57
0.61
0.96
1.14
1.01
1.30
0.74
0.54
0.67
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panty hose
Knee-length skirt, long-sleeve shirt, half slip,
panty hose, long-sleeve sweater
Same as above, replace sweater with suit jacket
Ankle-lenght skirt, long-sleeve shirt, suit
jacket, panty hose
Long-sleeve coveralls, T-shirt
Overalls, long-sleeve shirt, T-shirt
Insulated coveralls, long-sleeve thermal
underwear, long underwear bottoms
12.4.5.

1.10
1.04
1.10
0.72
0.89
1.37

Form for Lights

Field description, etc:
Number of units Number of lighting units. Total power emitted is the rated input times this
number.
Control strategy Operation method for lighting. Only 'Schedule' at present.
Schedule Operation schedule for lights. The output signal must be in the interval [0, 1]
Rated input per unit Consumption of electrical power when lights are on. (W)
Luminous eff. Number of lumen emitted per watt supplied electrical power. (lm/W)
Convective fraction Fraction of rated input emitted as convective heat. (0-1)
Object: Name and description
The form for a light is opened e.g. by double clicking on an object of the Lights type in the
Loads box in the zone form.
The light’s extension and position on the zone’s ceiling can be changed in the Surface editor
(for the ceiling), where a light is marked with a specific symbol. At the moment, only one
light source is allowed in a zone. Typically, the size and location of the light has but a small
influence on the room climate, except when a large output is emitted from a small surface. To
avoid this, the light can be extended over a major part of the ceiling.
If the Control strategy is set to Setpoints+Schedule, the light output is varied depending on
available daylight, during the periods when the selected schedule is on (> 0). If the daylight
falls below a min level, set in the Controller setpoints dialog, the light output is set at nominal
power. If the daylight exceeds the max level, the lights are off. Between these limits, the
control is proportional.
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Form for equipment load

Field description, etc:
Number of units Number of equipment units with these data.
Control strategy Control method.
Schedule Operation schedule. The output signal must be in the interval [0, 1].
Emitted heat per unit Total emitted sensible heat. (W)
Long wave radiation fraction Share of sensible heat that is emitted as long wave radiation.
Radiation is distributed according to wall surface areas. (0-1)
Moisture emission per unit Water vapor emitted by the device. (kg/s) Vaporization heat is
not accounted for.
The vapor is regarded to have the same temperature as the zone air.
CO2 per unit Carbondioxide emitted by the device. Note the unit! (mg/s)
Object: Name and description
The form for an equipment load is opened e.g. by double clicking on an object of the
Equipment load type in the Loads box in the zone form.
Several objects of the Equipment load type can be in one zone. Their placing in the zone is
not considered to influence the results.
12.4.7.

Convective internal mass

Objectsof this type, inserted in a zone (see Insert object), are always edited in this form.
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Field description, etc:
Area
Area per side (object is described as two-sided wall) [m2].
Construction
Approximate the object by wall-type construction.
Heat transfer coefficient
Convective heat transfer coefficient (no long-wave exchange is calculated) [W/(m2 K)].
This type of object is used to model internal masses that primarily interact with the zone air,
and that are "seen" by the walls only to a minor extent. Examples could be store room shelves,
furniture, plants, etc. These masses can have a relatively large influence on fast temperature
variations but can normally be neglected in energy calculations.
The area should give an estimate of the total area exposed to the zone air. Note that all objects
are treated as double sided, e.g. for a desk the top side area should be given. The construction
specified should correspond to a section through the object and several material layers can be
specified in the same way as for a wall.
12.4.8.

Thermal mass

Objects of the type Thermal mass, inserted in a zone (see Insert object), are always edited in
this form.

Field description, etc:
Area
Area per side of two-sided wall [m2].
Construction
Construction (order between sides is immaterial)
Heat transfer coefficient
Convective heat transfer coefficient (long-wave heat transfer is calculated by ICE)
[W/(m2 K)].
This type of object is used to model masses like internal walls and floor slabs that are
contained inside the zone, are "seen" by the zone walls, and thus partake in the radiation
balance.
The given area should provide a figure for the area exposed towards the zone surfaces. Note
that all objects are treated as double sided; the area of one side is given. The construction
specified should correspond to a section through the object.
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Zone geometry

The numerical values for the zone’s size and position in the floor plan can be given here.
.Field descriptions, etc:
Origin
x: The zone's x coordinate in the building system. (m)
y: The zone's y coordinate in the building system. (m)
z: The zone's z coordinate in the building system, i.e. the floor surface's
height above ground. (m)
Size:
x: Zone length inside walls (m)
y: Zone width inside walls (m)
z: Height between floor surface and ceiling (see figure below). (m)
Orientation: Angle The zone's rotation wrt the positive x-axis in the
building system. (Deg)
Floor Area Surface area inside walls. (m2)
Corners (m), wrt. origin: Coordinates for the corners, in the zone system
(m)
See Geometry in IDA Indoor Climate and Energy for a description of how
the geometry and coordinate systems in IDA Indoor Climate and Energy are defined.
The form for the zone’s geometry is reached by selecting Property Page in the Options menu,
while in the Floor plan editor which can be opened by the Floor plan button in the zone form,
or by the Floor plan tab in the building form.
12.5.
12.5.1.

Walls, Floor and Ceiling
Editing objects on a surface

Double clicking in the box Drawing describing objects on the surface, in the form for objects
of type Floor, Wall and Ceiling, opens a so-called surface editor which shows a drawing of
the respective surface.
To insert an object on the surface select New Object… in the Insert menu followed by the
desired type of object in the dialog opened. Now click on OK and place the cursor somewhere
within the drawing, hold down the left button and drag the object to the desired size. Now
release the button.
The size and position of the object can be changed. Change the size by first selecting the
object and dragging one of the small rectangles in the object’s corners or in the middle of its
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sides. Change the position by placing the cursor within the object’s boundary lines, holding
down the left button, and dragging the object to the desired position.
Numerical values for the object’s length and width can also be given in the form for object
geometry, which is reached by selecting Property Page in the Options menu, while the object
is selected.
12.5.2.

Geometry for object (2D)
Most objects with two-dimensional geometric measurements have a
form describing the geometry. This is opened by selecting Property
Page in the Options menu, while the object is selected.
Field descriptions, etc:
X min and Y min coordinates for the lower left corner in the surface
system (m)
X-size and Y-size width and height of the object (m)
X max and Y max coordinates for the upper right corner in the surface
system (m)
Area The total area of the object (calculated automatically) (m2)
12.5.3.

Room units for cooling and heating

Local heating or cooling is supplied in the zone by defining room units on the walls, in the
ceiling, or on the floor. There is general equipment for waterborne cooling (for both radiative
and convective equipment), a water radiator (or convector), floor heating, and an electric
radiator.
See further chapter 6 in the IDA ICE Manual.
12.5.4.

Active Beam

Use manufacturer's data Automatically selected when product data has been imported
from manufacturer’s database
Simplified model Select in order to give parameters manually
Power at design air flow, Cooling Waterborne cooling power at design air flow and given
temperatures (°C)
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Power at design air flow, Heating Waterborne heating power at design air flow and given
temperatures (°C)
Power at zero air flow, Cooling Waterborne cooling power at zero air flow and given
temperatures (°C)
Power at zero air flow, Heating Waterborne heating power at zero air flow and given
temperatures (°C)
Design air flow Air flow through device at design conditions (l/s)
Design conditions

dT(coolant - zone air) at max power, Cooling Average temperature difference
between coolant and room air at design power (°C)
dT(coolant - zone air) at max power, Heating Average temperature difference
between hot water and room air at design conditions (°C)
dT(coolant) at max power, Cooling Temperature rise of coolant at design power (°C)
dT(coolant) at max power, Heating Temperature drop of hot water at design power
(°C)
Controller Type of control
Active beams are air supply terminals combined with coils for cooling and sometimes also for
heating. In addition to providing natural convection, which is active also without any
mechanical supply air, the heat transfer is significantly improved by forced convection via the
supply air stream.
The radiation component from active beams is normally quite small and it is neglected by the
model, hence the actual position in the ceiling of the beam has no impact on calculation
results.
Read more about active beams in Chapter 6 of the manual.
12.5.5.

Floor Heating
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An object of the Floor heating type, inserted on a floor surface, can be opened for editing by
double clicking on the object in the surface editor. (The surface editor is reached by double
clicking on the floor in the zone form.)
Field descriptions, etc:
Floor heat (temperature control)
Design power output Power output at design conditions. (W/m2)
Maximum temperature into coil Highest permitted temp sent into floor. (°C)
Temperature drop across coil Temperature drop at design conditions. (°C)
Controller Type of control.
Location in floor slab
Depth under floor surface Depth of the water circuit plane below floor surface; check w
floor construction
Heat transfer coefficient
H-water-pipe-fin For aluminium fins in a wood joist construction, 6 is a reasonable
value; 30 for tubes in concrete. The total heat resistance is normally dominated by the
resistance in the floor slab, and thus this parameter is not very critical.
Read about the model for floor heating in Chapter 6 in the manual.
See also Room units for cooling and heating.
12.5.6.

Edit Cooling devices
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A form for editing an object of the Cooling devices type is displayed by double clicking on a
cooling device in the Drawing for describing an object on the surface, the so-called surface
editor (Surface editor is displayed by double clicking in the drawing box in the form for the
ceiling on which the cooling device is located). The figure also has a dialog for alternative
input opened from the form.
Cooling devices operates completely analogous with heating device, with the exception of a
few differences in input, which are described here.
Field descriptions, etc:
Massflow at full power Water flow through the equipment at design conditions. (kg/s)
K-value Removed heat per unit of equipment length and degree (raised to N). (W/m*°C^N)
N-value Exponent in the expression for removed heat. (-)
Module width Width of an equipment module for which given K and N are valid. (m)
Heat transfer coefficient to the room surface behind U-value for the insulation between the
equipment and the wall/ceiling. (W/m2*°C)
Maximum power, P1 Removed heat at full capacity. (W)
dT(coolant-air) at max. power, dT1 Mean temperature difference between the air and the
coolant at full capacity, P1. (°C)
dT(coolant) at max. power, dTliq Temperature increase of water at full capacity. (°C)
Lower power, P2 Removed heat at any partial load, e. g., half capacity. (W)
dT(coolant-air) at lower power, dT2 Mean temperature difference between the air and the
coolant at the partial load, P2. (°C)
The form for a cooling device can also be opened from the Right button menu with the cursor
over an object of the Cooling device type (e.g. Cooling device 1) in the form for surface
editor or, for a resource(different form, includes alternative input, in the form for IDAresources.
Here, the height of a radiator corresponds instead to a Module width, to which K and N refer.
Just as for the radiator, the total length is calculated as the given box’s area divided with
Module width. There is a difference in that the heat transfer coefficient between the back of
the equipment, and the surface behind (often the ceiling) is given directly in the main form. If
an (arbitrary) negative figure is entered, the heat transfer coefficient is calculated in the same
way as for the heating devices, i.e., as if all heat transfer was done by radiation. This is a good
approximation for a device that has no insulation at all.
The dialog for alternative input has somewhat different parameters for cooling units.
Absorbed power and temperature differences between air and water are given for two points
on the power curve. For max power, the temperature drop of the water is also given.
To accurately model zone thermal conditions, the surface areas of heating and cooling devices
must must be realistic in relation to emitted power.
See also Room units for Cooling and Heating.
12.5.7.

Edit waterborne heating devices

Heat emission from waterborne heating devices is calculated using
P = K ∗ I ∗ dT N
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where l is equipment length and dT is the temperature difference between the water and the
zone air. K and N are constants characterizing a piece of equipment of a certain height. In the
case of a radiator, N is often set at 1.28, which is why K gets the unit
. The
logarithmic mean temperature difference is used to calculate dT.
The values of K, N, and the height of equipment of different makes are stored in the database.
A database object should be defined for every principal configuration and occurring height,
but the length of the equipment is first defined when it is inserted in the model.

A form to edit an object of the Heating device type is displayed by double clicking on a
heating device in the Drawing for describing objects on the surface, the so-called surface
editor. (Surface editor is displayed by double clicking in the drawing box in the form for wall,
floor and ceiling on which the heating device is located) In the figure, a dialog for alternative
input has also been opened from the form.
Field descriptions, etc:
Massflow at full power Water flow through equipment at design conditions. (kg/s)
K-value Emitted power per unit of equipment length and degree-C (raised to N).
N-value Exponent in the expression for emitted power. Frequently set to 1.28 for ordinary
radiators. (-)
Height Equipment height at which given K and N are valid. (m)
Maximum power, Pmax Emitted power at full capacity. (W)
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Air temperature at maximum power, Tair Room temperature at the measuring point at full
capacity. (°C)
Supply temp. at maximum power, TliqIn Incoming water temperature at full capacity. (°C)
Return temperature at max. power, TliqOut Outgoing water temperature at full capacity.
(°C)
N-value, exponent of power curve, N See the base form for explanation of N-value. (-)
The form for heating device can also be opened from the Right button menu with the cursor
over an object of the Heating device type (e.g. Water radiator 1) in the form for surface editor
or, for a resource (different form, includes alternative input), in the form for IDA-resources.
Read about the radiator in Chapter 6 in the manual.
A detailed modeling of the room climate, especially operative temperatures, requires a
reasonable agreement between heater or cooler surface size and specified power output.
See also Room units for cooling and heating.
12.5.8.

Electric radiator

Rated power Maximum output (and input) power [W].
Distance between radiator and wall Gap behind radiator (m).
Controller Method of control of heater output. The temperature setpoint is fetched from
Controller setpoints.
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Form for window

A form for editing the properties of a window is opened (e.g., by double clicking on the
window) in Drawing describing objects on the surface. (The surface editor is displayed by
double clicking in the drawing box in the form for wall, floor and ceiling where the window
is).
Field descriptions, etc:
Glazing Choice of glass configuration, includes SHGC-, T- and U-value for the glass.
Opening schedule Schedule for degree of window opening. 0 = fully closed, 1 = fully open.
Frame fraction of the total window area The unglazed area of the window divided by the
whole window area, defined by the outer frame measures. (0-1)
Frame U-value Heat transfer coefficient for the unglazed part of the window, including
interior and exterior film coefficients. (W/°C)
Internal window shading
Device Choice of curtains or blinds.
Control Selection of control strategy for internal shading device.
Schedule Schedule for internal window shading.
Selecting 'Light intensity + Schedule' draws the shading when the schedule is 'on' and the
incident light exceeds 100 W/m2 on the inside of the glass. This level can be changed at the
building level in outline view, System parameters, internal_shading_control_level.
Selecting 'Schedule', makes only the schedule's values apply, 1=completely drawn,
0=completely open
External window shading
Device Choice of external window shading. Object for near-window shading, eg.,
awnings, side fins, recess depth etc.
Drawing view from the side to describe the external window shading External
window shading. Quick way to open shading editor
Object: Name and description

142

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

The form contains a box named Drawing view from the side, to describe the external shading.
Double clicking on this opens a form, which is used for editing any shading objects outside
the window. This form has two tabs; under the Control tab, the type of control can be
specified (no control, wind and/or sun control).
The form for a window can also be opened by clicking the right button over an object of the
window type in the surface editor.
12.5.10.

Dialog for Glass construction

The Glass construction dialog is used to describe optical and thermal properties of the
window glazing. A glass construction has a name (3-pane, clear, 4-12-4-12-4 in the figure), a
description and a number of parameters.
Field descriptions, etc:
Name
Shading coefficients: Absolute value Select to specify window data without reference
glazing
Shading coefficients: Single pane reference Select to specify data with single glass
reference
Shading coefficients: Double pane reference Select to specify data with double pane
reference
Shading coefficients: SHGC, Solar Heat Gain Coefficient Displayed when Absolute value
has been selected above. Fraction of the radiation, incident on the window, that heats the
room. SHGC includes both the radiation that passes through the window directly and the
radiation that is first absorbed in the panes and thereafter reaches the zone as convection and
long-wave radiation.
SHGC is short for Solar Heat Gain Coefficient and is sometimes also called: g, TST, total
transmission, SF, etc.
Shading coefficients: T, Solar transmittance Displayed when absolute value has been
selected above. Fraction of incident radiation that passes the glazing as direct radiation.
T is sometimes also called Tsol, ST, DET, etc.
Shading coefficients: F1, total shading coefficient Displayed when Double pane reference
has been selected above. Fraction incoming radiation (in relation to a 2-pane window) that
heats the zone. F1 includes both the radiation that passes through the window directly and the
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radiation that is first absorbed in the panes and thereafter reaches the zone as convection and
long-wave radiation.
Shading coefficients: F2, shortwave shading coefficient Displayed when Double pane
reference has been selected above. Fraction of incoming radiation (in relation to a 2-pane
window) which passes through the pane. This is radiation that passes the window in the form
of shortwave radiation.
Shading coefficients: Sc, total shading coefficient Displayed when single pane reference
has been selected above.
Shading coefficients: Ssc, shortwave shading coefficient Displayed when single pane
reference has been selected above.
Glazing U-value Heat transfer coefficient for the glazing (without frame), including internal
and external film coefficients (W/m2 °C) The window models calculate actual internal and
external (wind dependent) film coefficients. From the given U-value the program subtracts
0.17 (m2 K)/W and the remaining U-value is considered to equal the heat transfer coefficient
of the glass.
Internal emissivity Innermost glass emissivity (inwards) for longwave radiation.
External emissivity Outermost glass emissivity (outwards) for longwave radiation. Has, in
normal cases, limited influence on the result.
The total entering heat load is given by the following expression:
Ptotal = SHGC* A * I / 0.76
Pshortwave = T* A * I / 0.76
where A [m²] is glass surface area and I [W/m²] is the total incoming radiation through a
double pane reference window. This calculation takes into consideration the influence of the
sun’s incidence angle and includes both direct and diffuse radiation on the facade.
Ptotal - Pshortwave determines the part of the radiation that reaches the zone via absorption
in the window.
The directly transmitted radiation (Pshortwave) is spread diffusely to the zone surfaces. When
the Climate model has been selected, the view factors are based on zone geometry, otherwise
only on surface areas.
For combinations of glazing and internal shadings, e.g., curtains or blinds, data is given for
the internal shading object that modifies the given parameters for the glazing. See Dialog for
internal shading.
The dialog for a glass constructions is opened from the Right button menu with the cursor
over an object of the Glass construction type (e.g. 3-glass, clear, 4-12-4-12-4) in the Glazing
field in the form for a window or in the form for IDA-resources.
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Dialog for internal shading

This dialog is used for giving parameters belonging to the objects of the internal shading type,
for example, a curtain or blind. The multipliers modify the corresponding parameters for the
window when the shading is on.
Field descriptions, etc:
Multiplier for SHGC, Solar Heat Gain Coefficient
Multiplier for T, Solar transmittance
Multiplier for U-value
Object: Name and description
Internal shading (blinds, curtains, etc.) concerns all types of shading in the window’s plane,
even external blinds. (External shading concerns permanent shading objects, on the facade,
near the window, e.g. side fins etc.).
Three parameters are given for internal shading. These provide multipliers, which indicate the
effects of the shading in combination with the glazing. See Dialog for glass construction for
definitions of SHGC, T and U for the glazing.
When the inner shading is on (drawn) the effective parameters become
SHGC_effective = SHGC * multiplier for SHGC
T_ effective = T * multiplier for T
U_ effective = U * multiplier for U
The dialog for an internal shading is opened from the Right button menu with the cursor over
an object of the internal shading type (e.g. Light dense curtain between the panes) in the
Internal shading field in the form for one window or in the form for IDA-resources.
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Editing an external shading

This form is used to edit an object of the External shading type. The window and the external
wall are shown in a side view. An external shading is a combination of the shading elements
Balcony with sides, Simple screen, Side fins and Marquee with sides. The window’s external
recess depth is also included in its external shading.
The Shading editor form is opened by double clicking on the Drawing view from the side to
describe external shading button, in the window form. A new shading object is inserted by
selecting New object… in the Insert menu with the Shading editor being the active window.
In the Insert object dialog then opened there are four alternatives:
Balcony with sides
Simple screen
Side fins
Marquee with sides
When the selection is made the editor is redisplayed. Place the cursor beside the wall to the
right of the window, hold down the left button and drag the shading to the desired size. For
the Simple screen alternative, draw a polyline by clicking a start point, break points, and end
point in the form. End by clicking once with the Right button and selecting OK. The small
number field is for the width of the shading (for side fins, the distance between them), i.e the
extension perpendicular to the editor plane. Repeat this procedure to insert further shading
objects.
The window’s position in the wall, the so-called recess depth, is changed by dragging the
window line to the desired position. The cursor changes appearance when it is placed over the
window line.
The faint horizontal line in the wall over the window indicates ceiling height in the zone
where the window is located.
In the Shading editor there is a tab Control. Via this, one can specify limits when the shading
should be withdrawn due to strong wind or low solar radiation.
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Shading control

No control
No automatic control
Wind
The shading is withdrawn at high local wind speed
Radiation
The shading is drawn (extended) at high solar radiation
Radiation and wind
Control by wind and sun; wind has priority
Wind speed, above which shading is withdrawn
If the wind speed for this facade exceeds this level, the shades are withdrawn.
Radiation, incident on window, above which shading is used
If the radiation in the plane of the window, with shades withdrawn, exceeds this level, the
shades are extended.
12.5.14.

Form for balcony, marquee and screens

This form describes one of the objects Balcony with sides, Simple screen, Side fins and
Marquee with sides.
Field description:
Width The extension of the shading device perpendicular to the editor plane (m)
Shading type Fixed or controllable device; select parameters for all controllable devices
under the tab Control.
Vertices (m)
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The form for a shading object is opened from the Right button menu with the cursor over an
object of this type (e.g., Balcony with sides) in the Shading editor.
Shading objects cannot be changed to independent IDA-resources, but will be saved, as
resources or data base objects, combined with the window’s size and positioning in the wall
(see Edit an external shading).
12.5.15.

Form for Skylight

The skylight is a roof lantern. It can be used to study solar radiation and climate effects for
different forms of glazed openings in roofs, e.g. glazed saddle roofs. The skylight object is
shaped as a pyramid with rectangular base and with the top removed by a horizontal cut.
Thus, it has five sides, which can be glazed to different extents.
A detailed ray tracing calculation is performed, and e.g. direct light entering through one
surface and leaving through another is handled correctly. Light reaching the base of the
pyramid is transmitted to the zone as diffuse light.
Each skylight object inserted in a zone (see Insert object) is edited in this form.
Field description, etc:
Geometry:
X Coordinate of the lower left corner, can be entered in Applet (m)
Y Coordinate of the lower left corner, can be entered in Applet (m)
DX Extension of base rectangle in x-direction (m)
DY Extension of base rectangle in y-direction (m)
DZ The height of the skylight above the roof (m)
L1, ... L4 Distance in the roof plane between the borders of the base and top rectangles;
four values for the four sides of the rectangle, numbered by the closest zone
Walls 1-4 (m)
Construction:
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Glass area: Wall 1, ... 4 Glazed area on side towards Wall 1 [m2]
Glass area: Roof Glazed area in top surface of pyramid [m2]
Walls Construction selected for unglazed parts of all five sides [Data base sellection of
bwall construction]
Glazing Selection of glazing construction, optical and thermal properties [Data base
selection of glazing constructionn]
In the zone model, the skylight has the thermal properties of a wall subsurface. The
temperature of this surface is set to a weighted average of the temperatures of the glazed and
unglazed parts of the five surfaces of the skylight. This model should rather well represent the
long-wave and convective properties of a heated skylight. Downdraughts from cold vertical
surfaces in the skylight will not be as well reproduced.
12.5.16.

Form for opening (door)

Field description, etc:
Opening schedule
Object: Name and description
An opening between two zones (or in an external wall) gives rise to a (sometimes bidirectional) air flow, that will reduce the differences in temperature, humidity and carbon
dioxide content between the air masses. No radiation is considered to occur through the
opening. When the opening is closed, it is considered to have the same thermal characteristics
as the surrounding wall.
The opening is defined by inserting an opening component in a wall. For internal walls, this is
only done in one of the zones. The other zone then displays a gray surface on its
corresponding section of wall.
The form for an opening is opened by double clicking on an object of the Opening (door) type
in the Surface editor (The surface editor is reached by double clicking in the drawing box in
the form for wall, floor and ceiling, ceiling or floor that contains the opening).
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Chimney

Field description, etc:
Inlet loss coeff. Pressure drop in the inlet air terminal [-]
Outlet loss coeff. Pressure drop in the outlet air terminal [-]
Diameter Hydraulic diameter (m)
Total rise from inlet to outlet Height difference between inlet and outlet (governs the stack
effect) (m)
Total duct length Total hydraulic length for the duct (provides flow resistance) (m)
Object Name and description
The chimney can be inserted in ceiling or wall to describe a natural ventilation system. The
model can calculate flow in both directions, i.e. if the zone pressure is low enough, air will
enter the zone through the chimney. The rise of the duct and the vertical position of the input
will determine the stack effects.
12.5.18.

Leak

Object: building  zone  enclosing surface  leak
Available from: Wall editor
Description: Describes a leak between zones or between zone and environment.

Field description, etc:
x, y The position of the leak on the wall. Only the y coordinate will affect the result. (m)
Leak area at 4 Pa ELA Equivalent leakage area in the envelope, according to ASHRAE's
definition [m2].
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A leak between zone and environment is always present in the ICE Building model. The size
of this (default) leak is given in the Zone form. Additional leaks to the environment and leaks
between zones may be inserted in walls, ceiling, and floor, see Wall editor form.
The standard leak is positioned 1 m above the floor level in the external wall with the lowest
wall number or in the ceiling if no external wall exists, or in the floor towards crawl space if
no external surfaces exist. Thus also completely internal zones have some connection with the
ambient.
12.5.19.

Wall part

Object: building  zone  enclosing surface  wall part
Available from: Wall editor
Description: Describes a part of wall, floor or ceiling with different construction or
adjacency conditions, or with different surface temperature.
Views: General (identical to enclosing element's advanced view)
A wall part is an object that can be inserted into another wall and which can be given other
properties than the rest of the wall. All parameters that can be specified for a wall, under the
Advanced tab, can be specified independantly for a wall part.
When a wall adjoins more than one zone or building face, each separate contact will
automatically be modeled as an implicit wall part. The user should not specify these
partitions explicitly.
Each wall part (both explicit and implicit) is modeled with its own (time dependent) surface
temperature. Wall partitions can be used to model non-homogeneous temperature
distributions over a wall.
Wall features (windows, radiators, etc) can be placed inside wall parts, but must not intersect
the part’s borders (on either side of the wall).
See also:
Enclosing element, advanced view.
12.5.20.

Form for wall, floor and ceiling
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Open the form for walls, floor and ceiling by double clicking on the corresponding object of
type Wall, Floor or Ceiling in the zone form, and selecting the Advanced tab.
Field descriptions, etc:
Thermal connection
If no adjacent zone or face:
Ignore net heat transmission
Normally select this alternative for internal walls. An adiabatic surface is placed in the
geometric middle of the wall.
Constant surface temp on other side
Select this only when no adjacent zone is simulated, but heat transmission is
significant. A surface temperature is specified on the opposite side of the wall (note:
not air temperature). Could mean significant energy transports.
Connect to face:
Connect to facade; specify face in adjacent field. The facade itself does not have to
adjoin the wall. This allows modeling of buildings with non-prismatic shape.
Connect to ground
Use for 'slab on grade' or basement floor; under-slab-construction and ground
temperature are given in the Ground properties dialog in available from the main
building form
Construction Choice of material and thickness of layers.
For external walls Choice of materials and thickness of layers for the part of the wall
which is external.
For internal walls Choice of materials and thickness of layers for the part of the wall
which is internal.
Inner surface Description of the optical properties of the inner surface. These are of
minor importance in normal cases.
Outer surface Description of the optical properties of the outer surface. Only for
building elements facing the surroundings.
If <Default> is left in the construction fields, the corresponding construction is fetched
from the Defaults tab in the building form.
If the wall is not adjoining a facade or another zone, one has a free choice of thermal
treatments. The choice Ignore net heat transmission will give a wall with thermal mass
exposed but no heat transmission over extended periods. Other choices are explained above.
Note that when a zone is moved in a way that, e.g. changes an external wall to an internal one,
the choice of wall construction will be automatically adapted to the new role. This also
applies to parts of walls.
Walls are automatically coupled to geometrically adjoining zones or facades. The user should
not create these couplings.

152

IDA Indoor Climate and Energy 3.0
12.5.21.

EQUA Simulation AB 2002

Dialog for wall definition

Objects of the Wall definition type are used to define the construction of walls and floors. A
wall definition has a name, a description and a number of layers.
Field descriptions, etc:
Name Object name
Description Object description.
U-value Overall U-value, including film coefficients (W/(m2 * ?K))
Layers: Floor top/Wall inside A list of layers in the wall
AddButton to add additional layer.
DeleteButton to delete an existing layer.
PromoteButton to move a layer up one step.
DemoteButton to move a layer down one step.
Layer data
Name Layer name.
Description Layer description.
Material The button with the right arrow gives a menu of possible operations:
Open Open the Material dialog.
Load from database… Load object of the Material type from database.
Thickness Layer thickness. (m)
The dialog for a wall definition is opened by the menu option Open, after pressing the Right
button with the cursor over an object of the wall definition type (e.g Internal wall with
insulation) in the Construction field in the form for a wall or in the form for IDA-resources.
The layers the wall consists of are displayed in the list box in the Layers box. Floor layers are
given in order of floor surface to floor bottom (usually ceiling below). Wall layers are given
in order of inside to outside. The Add button is used to add new layers in a wall definition.
The layers selected in the list box can be deleted with the Delete button and moved up or
down respectively with the Promote and Demote buttons.
Layer data for the selected layer is displayed in the Layer data box to the right in the dialog.
Every layer has a name, a description and a thickness given in meters, and consists of a
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material that can be selected under the Material heading. If the desired material isn’t on the
list, additional material definitions can be loaded from the database by clicking right arrow
symbol and selecting Load from database. Use the Open choice in the same menu to open the
selected material definition. Similarly, a new material can be created by selecting New
Resource and the selected material can be stored in the database by selecting Write to
database.
Dialog for material data

Field descriptions, etc:
Description Material description.
Heat conductivity Heat conductivity. (W/m*K)
Density Density. (kg/m3)
Specific heat Specific heat. (J/kg*K)
The Dialog for a material is opened from Wall definition dialog by clicking on the Open
button. Access a resource from the Right button menu with the cursor over an object of the
Material type (e.g., Concrete), in the form for IDA-resources.
12.5.22.

Dialog for surface

This dialog is used to edit objects of the Surface type. A surface object has a name (Default
surface in the figure), a description and two parameters.
Field descriptions, etc:
Description
Longwave emissivity (0–1)
Shortwave reflectance (0–1)
The dialog for a surface is opened by the menu option Open, after pressing the Right button
with the cursor over an object of the Surface type, (e.g. Light surface) in one of the Interior
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surface or Exterior surface fields in the form for wall, ceiling and floor or in the form for
IDA-resources.
12.6.
12.6.1.

Mathematical Model
Schema for zone (advanced level)

The figure shows the schema-view (the advanced level) of a zone with a detailed zone model.
To access this window, select Build model from the Tools menu, after filling in all necessary
information at the standard level.
The contents of the window depend on which objects have been inserted. In this case a
radiator, a cooling panel and external shading have been inserted at the standard level. When
Build model has been completed, it is possible to change between Forms (standard level) and
Schema (advanced level) in the View menu. The different groups of components have been
numbered in the following categories:
1. Supply and exhaust air terminals (VAV), with controller
2. Ceiling
3. Air leak to ambient
4. Solar irradiation and external film coefficient, external wall
5. One external wall and three internal walls
6. Window and shading calculation component
7. Floor
8. Radiator with controller and wall portion behind radiator (with solar irradiation)
9. Cooling panel with controller and ceiling portion behind
10. The actual zone model in which radiation, convection and loads etc. are modeled
See also Chapters 5 and 6 of the manual.
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12.7.

IDA Resources and Database

12.7.1.

Forms for IDA-resources

This form contains the IDA-resources currently or previously used in a project. If, for
example, an Internal wall with insulation is chosen for somewhere in the building, the IDA
resources Internal wall with insulation, Gypsum, Air in 30 mm vertical gap and Lightweight
insulation will appear in the list. (The Internal wall with insulation contains references to a set
of material resources).
A change made in an IDA resource at the building level applies to all the instances in the
building where it has been used. If, for example, the density is changed for the IDA resource
concrete from 2300 kg/m3 to 2400 kg/m3 at the building level, this change will influence all
walls and floors in the building that contain concrete.
Resources that have no references to them (aren’t used) can be deleted.
The IDA-resources handled in IDA Indoor Climate and Energy can also be stored in the
database. A list of all available types can be found in the chapter Database objects in IDA
Indoor Climate and Energy.
Study also Chapter 3 of the manual.
12.7.2.

Database objects in IDA Indoor Climate and Energy

The following types of database objects, which can be found in the IDA database, are used in
IDA Indoor Climate and Energy:
Wall definition
Material
Glass definition
Internal shading
Location
Wind profile
Schedule
Profile
External shading
Climate data
Occupant load
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Equipment load
Lights
Controller setpoints
Surface
Cooling device
Heating device
Window
Energy price
Settings for new zones
12.7.3.

Convert objects to resources

For a description see To save resource to database.
If the resource is stored at building level in IDA Indoor Climate and Energy, it appears in the
IDA resources box to the left in the building form.
12.7.4.

Make a resource a database object

Select the resource, either in a dialog in which it is referred to, or in the form for IDAresources which is accessed by selecting Display IDA-resources in the Tools menu. The
resource can now be saved to the database from the Right button menu.
12.7.5.

Convert database objects to resources

For a description see To load a resource from Database.
12.7.6.

Dialog for Schedule

Schedules are used to define how something varies with time. Examples of this are the
presence of occupants or operation time of fans. A schedule has a name, a description and a
number of rules. One of these is always in effect. The schedule value at any given point in
time is the value of the rule in effect at that time.
The dialog for editing the schedule has two appearances, one simple and one advanced, which
correspond to a simple and an advanced definition of a specific schedule. The program
automatically controls which one of these is displayed, depending on the character of the
schedule. A simple schedule can always be changed to an advanced schedule (by clicking on
the Advanced key… in the simple schedule).
The dialog for a schedule is opened e.g. by selecting 'Open' after pressing the right arrow
beside an object of type Schedule, in any of the forms containing such fields (e.g. form for
Occupant load) or in the form for IDA-resources.
Simple schedule
A simple schedule has only a single rule. The rule defines the switching between two values
that alternate in the same way every day, regardless of the calendar. One value is defined in
the Value field and applies from Start time to Finish time. The other value is zero.
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Field descriptions, etc:
Name <ej i statusraden>
Description Object description.
Daily schedule: Start time: Hour Start hour.
Daily schedule: Start time: Minute Start minute.
Daily schedule: Stop time: Hour End hour.
Daily schedule: Stop time: Minute End minute.
Daily schedule: Value
Advanced schedule
If the simple definition is not enough to define the variation with time, an advanced definition
can be given. The following picture illustrates the Schedule dialog with the advanced
definition displayed.

Field descriptions, etc:
Name <ej i statusraden>
Description Object description.
Rules Rule name.
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Add Add a new rule to the Schema.
Delete Delete the selected rule from the Schema.
Promote Promote the selected rule in the Schema.
Demote Demote the selected rule in the Schema.
Daily schedule:: Constant
Daily schedule: On/Off
Daily schedule: Profile
Daily schedule: Start time: Hour Start hour.
Daily schedule: Start time: Minute Start minute.
Daily schedule: Stop time: Hour End hour.
Daily schedule: Stop time: Minute End minute.
Daily schedule: On value
Daily schedule: Off value
Valid days: Start date
Valid days: End date
Calender
In the Rules list box, new rules can be added with the Add button, and existing rules deleted
with the Delete button. The rule furthest up applies in the first hand, and the one furthest
down applies last. The rule selected in the list box can be moved up and down with the Move
up and Move down buttons, respectively.
When a simple schedule is changed via the Advanced button, the simple schedule appears as
the only rule and is given the name Default. The rule output can be changed, but not its time
of validity. The Default rule is always valid (the Valid days box is inactive when this rule is
elected), and the rule also always remains as the last rule. This guarantees that the schedule’s
value is always defined.
In the Daily schedule box, data for the rule selected under Rules is given. There are three
alternatives and the box changes appearance depending on which alternative is selected.
Clicking on the Constant button (as in the figure) displays the constant value in the field under
the button. If On/Off is selected, the start time, stop time and two values are given. The On
value applies between the start and stop time; otherwise the Off value applies.
If the Profile button is selected, the desired 24 h time profile can be selected from the list box
displayed under the button. If the desired profile isn’t already in the list, use the Load button
to search for the desired profile in the database. The Open button is used to display the
selected profile. This can then be edited in the Profile dialog. Selecting New creates a new
IDA-resource of the Profile type in the Create new resource object dialog.
Validity time for the selected rule is given in the lower right half of the dialog. In the Start
date and End date fields the validity time for the rule can be limited to a portion of the year. If
no start date is indicated the rule applies from the beginning of the year. If no end date is
indicated the rule applies until the end of the year. The Calendar button is used to open the
Calendar dialog, which aids selection of an existing date. In the Valid days box, the rule can
be limited to apply only to certain days of the week (by crossing those days the rule is
applicable).
When a new schedule has been defined it is useful to test that it actually delivers the intended
values. This can be done by right clicking in the combo box where the schedule is selected
and choosing Open with Diagram. This will “play the schedule for the time period selected in
Time slice on the Options menu.
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Editing a Profile

Objects of the Profile type are used to define how a value varies during the day. Examples of
these are the presence of people or operation time of fans. A profile has a name, a description
and a number of diagram points with time and value. A profile can be edited by indicating
time and value points in text form (Data tab, figure above), or by drawing a diagram (Diagram
tab, figure below)
Field descriptions, etc:
Name
Description Object description.
Points
Add
Delete
Selected point: Hour Hour.
Selected point: Minute Minute.
Selected point: Value Value.
The Dialog box for a profile is opened from the Right button menu with the cursor over an
object of the Profile (e.g., Office, Occupants) type in the /Profile/ field in one of the forms or
dialogs containing this field (e.g., the dialog for an advanced schedule) or in the form for
IDA-resources.
In the Points list box, time and value points can be added with the Add button. The Delete
button is used to delete a selected point. The times 0:00 and 24:00 can never be deleted. The
data values for the selected point can be changed in the Selected point box. Note that the
point’s value in the list box is not changed until the cursor is moved from the field that has
been changed. (Hour, Minute or Value). When times are changed or added, the points are
automatically rearranged into time order in the list box.
To edit the profile in diagram form instead, select the Diagram Tab.
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Field descriptions, etc:
Edit
Properties
Click on the Edit button and the profile breakpoints are marked with small squares in the
figure. These can be moved with the mouse. However, the breakpoints can never be moved in
such a way that the profile no longer is a pure function of time. When editing is complete,
click on the Done button. To cancel editing and return to the original state, click instead on
the Abort button. The Properties button is used to change the properties of the diagram, the
scale of the axes among other things.
12.8.

Simulation Results

The Results tab is shown automatically, after a completed simulation.
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Field description:
Detailed results A list of all result objects requested before the simulation.
Modified The time when the model was last changed. Only shown if the model was changed
after the latest simulation.
Simulated The time when the latest simulation was run.
Saved The time when the case was last saved on disk.
Make report When pressed, the results are combined into a single Word document.
Implemented only for Word 2000 or later.
12.8.1.

Dialog for choice of output

Output from a simulation is presented as diagrams and reports. There are several different
diagrams to chose from. The selection is made from the Choice of output dialog that is
accessed by clicking on the Requested output button in the building form or if Choose output
is selected in the Tools menu. The following diagram and reports exist (those marked with #
are pre-selected but can be deleted):
Diagrams
Building level:
AHU temperatures(#) Air temperatures in central AHU
AHU airflows Air flows through central AHU
Plant temperatures Plant temperatures: Boiler & chiller, in & out
Power supplied by plant (#) Heat and cooling supplied by plant
Zone level:
Main temperatures(#) Air and operative temperatures
Heat balance Detailed heat balance for zone
Air temperatures at floor and ceiling Air temperatures at floor and ceiling in case of
displacement ventilation.
Fanger’s comfort indices Fanger's comfort indices, PPD, PMV
Indoor Air Quality Indoor air quality measures: Ac/h, CO2 level, humidity
Daylighting Daylight level at desktop (1st person)
Directed operative temperatures
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Air flow in zone Air flows in zone, in/out through internal/external walls or
mechanical ventilation
Airborne heat flow into zone Airborne net heat flows into zone, through internal walls,
envelope and mechanical ventilation
Reports
Building level:
Purchased Energy Totals of purchased energy, by source: Electricity, primary energy
Used energy Details of energy used: Central coils, local units, others
Lost work Account of work hours lost due to over or under heating
Free energy Free energy, transmitted through zone envelope or generated within zones
Zone level:
Temps and heat balance in zone Zone temperatures and summary of heat balance for
the last day of simulation. This object object a lot of memory and should only be used
for short (periodic) simulations.
Free energy Free energy, transmitted through zone envelope or generated within zone
12.8.2.

Result – AHU (Air Handling Unit) temperatures

This diagram displays exhaust air, supply air and outdoor air temperatures. The exhaust air
temperature is the mixed temperature where each zone’s air is multiplied by weights (number
of zones of this type) given in the zone’s form. Air supply temperature gives the temperature,
which reaches the zone’s air terminal after any increase in the fans and duct system. Note that
the setpoint for the supply air temperature applies to the air temperature before this increase.
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Result – Airflow through the Air Handling Unit

The flows accounted for are the combined flows for all zones served by the AHU. The flows
in the zone are multiplied with weights (Number of zones of this type) which are indicated in
each zone’s form.
Flows are volumetric as measured at actual temperature conditions. They may therefore vary
slightly with respect to zone setpoint flows, which are given as massflows, due to density
variations.
12.8.4.

Result – Primary system’s temperatures

The supply and return temperatures for the primary system are displayed. Return temperatures
from local cooling and heating devices are weighed together with weights (Number of zones
of this type) which are indicated in the zone’s form.
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Result – Primary system power

This diagram displays central and local heating and cooling power. The power is calculated
based on the mass flow and temperature changes (supply – return) in respective circuit.
Cooling power is accounted for as a positive quantity.
12.8.6.

Result – Main temperatures

This diagram shows the mean temperature for the zone’s air and operative temperatures for
the locations of added occupant loads. When Climate model has been selected, the operative
temperatures are shown for the position of every occupant load in the zone.
Occupant loads are inserted in the zone form and their position may be altered in the floor
surface editor of the zone.

165

IDA Indoor Climate and Energy 3.0
12.8.7.

EQUA Simulation AB 2002

Result – Heat balance

Found here are all the energy flows of the zone’s heat balance, divided into the following
categories:
category
comment
Heat from air flows and cold
All air flows are accounted here, i.e. mechanical
bridges
ventilation as well as infiltration and flows from
other zones. Heat from cold bridges is also included
here for technical reasons. For a detailed account of
airborne heat flows, see also separate result object:
Airborne heat flow into zone.
Heat from occupants
Includes both sensible (dry) and latent (moist) heat
emitted by the occupants. The moisture is ventilated
away and will this way be included in the air flow
heat balance.
Heat from appliances (other loads) Emitted as convection or radiation according to user
such as computers, printers etc.
input.
Heat from controlled room units
The split between convection and radiation is
such as chilled beams and radiators. automatically calculated (see Chapter 6 in manual.)
NB! Floor heating is not included here but is
regarded as coming from floor and ceiling.
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Incoming solar radiation affects room conditions in
two ways:
1. as directly transmitted (short wave) radiation,
which is repeatedly reflected at room
surfaces but is ultimately absorbed by these
2. as heat which is first absorbed in the window
pane and then reaches the room through
convection and radiation.
The latter is accounted for here together with
window transmission. The first is separately
displayed (see below).

Heat from walls and floors, i.e. heat In the account, the control volume is just underneath
which has been stored in the
each surface. Accordingly, the curve represents
structure
conductive heat through the structure including both
storage, net transmission and any internal heat
sources such as floor heating. Heat stored in internal
masses, e.g. furniture, is also accounted for here.
Heat from electrical lighting
Emitted as convection or radiation according to user
input.
Heat from daylight passing through Se previous comment.
the window pane.
12.8.8.

Result – Air temperature at floor and ceiling

When a gradient calculation in the zone has been selected (non-well mixed zone), all
temperatures become dependent on the height from the floor. Examples of influences of this
are:
- comfort around occupants
- air removed via exhaust air or leaks
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convection at zone surfaces.

The result object is only available if Climate model has been selected in the zone’s form.
12.8.9.

Result – Fanger’s comfort indices

PPD =Predicted Percentage of Dissatisfied
PMV = Predicted Mean Vote
These measures of comfort take into consideration temperature, radiation, moisture and
draught as well as occupant clothing and level of activity. PPD varies between 0 and 100 and
the ideal value is 5, i.e., at least five percent are always dissatisfied. If occupants in the zone
think it is too warm or too cold, PMV varies between +3 (too warm) and -3 (too cold), and
should preferably lie close to zero. NB! The measurement for PMV has been multiplied by 10
in the diagram.
The comfort measurement is calculated only for times when respective occupant loads are
present.
For further information about the index see ASHRAE Fundamentals.
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Result – Air quality

Air changes. See comments in the figure above.
CO2 content given in ppm (with respect to volume), but is scaled here with a factor of 0.01 to
make the diagram more understandable. Normal limits during demand controlled ventilation
is 1000-1200 ppm, but considerably higher values can occur without health risks.
Air humidity indicated in %, but has been scaled with a factor of 0.1 to make the diagram
more understandable. Suitable limits vary greatly with the zone use.
12.8.11.

Result – Daylight level

Shows lighting on a horizontal surface at the first occupant load. Only daylight, not electric
lighting is accounted for.
The result object is only available if Climate model has been selected in the zone’s form.
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Directed operative temperatures

The directed operative temperatures are calculated for the position of the first occupant load
in each of the six main directions. The positions of occupant loads are displayed as chairs in
the surface editor of the floor. The height coordinate can be given adjacent to the symbol.
The directed operative temperature is calculated as the average of the local air temperature
and the mean radiant temperature from surfaces that are visible in the current direction.
The result object is only available if Climate model has been selected in the zone’s form.
12.8.13.

Air flow in zone

Displays volumetric air flows through openings, leaks and mechanical ventilation.
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Airborne heat flow into zone

Displays heat flows (sensible and latent) via supply air streams through openings, leaks and
mechanical ventilation.
12.8.15.

Result – Purchased Energy

Consumed energy is divided into:
- electrical energy
- primary energy.
Primary energy is used by the boiler and normally comes from fossil fuel or district heating.
Consumed amount of fuel is measured in terms of its fuel value in kWh. For district heating,
the boiler’s efficiency should be set close to one, as conversion losses are normally very
small.
171

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

All other energy consumption is accounted for as electric energy, divided into central
(building) and local (zones).
12.8.16.

Result - Used energy

The report shows how supplied energy has been utilized. Monthly sums and totals for the
simulation period for the following categories are presented:
category
Heating energy delivered by room units
Cooling energy delivered by room units
Heating energy delivered by central air
handling units
Cooling energy delivered by central air
handling units
Energy recovered by central air handling
units
Energy used by fans

Energy used by pumps

comment
Heat from controlled room units such as heating
beams and radiators. Floor heating is included.
Cooling from controlled room units such as
chilled beams and panels.
Heating energy supplied to all heating coils of
air handling units.
Energy removed by all cooling coils of air
handling units.
Heating energy recovered in central heat
exchanger. Recovered cooling energy is
accounted as negative.
Fan electricity consumption is based on
computed air flows and user supplied pressure
heads and efficiencies (see the form for the
default air handling unit). Fans are regarded as
being ideally pressure controlled, i.e. they
provide a fixed pressure increase independent
of flow.
Pump electricity consumption is based on
computed water flows and user supplied
pressure heads and efficiencies (see the form
for the Plant.) Pumps are regarded as being
ideally pressure controlled, i.e. they provide a
fixed pressure increase independent of flow.
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The electricity consumption of equipment such
as computers, copiers etc. is computed from
given rated input power and time schedules.
The electricity consumption of lights is
computed from given rated input power and
time schedules.
The energy content of DHW is based on the
user supplied consumption schedule and a cold
water temperature 5 ºC.

Result - Lost work

Too high or too low temperatures in a room result in production losses from workers. In ICE
3.0 some models for this according to Wyon have been included. For operative temperatures
between 20 and 25 °C no work is regarded as lost. Above and below these limits experiments
show an average loss of 2 % in performance per degree.
Reference: Wyon, D. 2000. Individual control at each workplace: the means and the potential
benefits In: Clements- Croome, D. (editor). Creating the productive workplace. E & FN Spon.
London and New York.
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Result – Zone temperatures and loads

The report describes the conditions during the last day of simulation. The values are hourly
and represent the average condition during the previous hour.
The heat balance is a condensed version of the detailed Heat balance diagram. Contributing
heat flows has been grouped in the following way:
1
2
3

4

Heat from surfaces
= from walls, ceiling and floor
Heat from direct sun through window = from direct transmitted (shortwave)
radiation
Other loads, i.e., heat from
- airflow and thermal bridges
- furniture
- occupants
- equipment
- window surfaces (convection + absorbed sun)
- lights
Heat from local heating/cooling = waterborne power local heating and cooling
units

For further comments, see Heat balance.
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Result - Free energy

The report shows free energy flows, supplied through the envelope or generated inside.
Monthly sums and totals for the simulation period for the following categories are presented:
category
comment
Wall transmission and cold Heat through walls (not windows), floors, ceilings and cold bridges.
bridges
Window transmission
Heat through (black) window, excluding all heat due to solar
radiation.
Ventilation (not always
Heat supplied by mechanical ventilation.
free)
Heat via infiltration and
Heat supplied via air from leaks and openings. For systems with
openings
only mechanical exhaust ventilation, all supply air will be accounted
for here.
Solar energy, direct and
Heat supplied solar radiation passing through the window as well as
indirect
through radiation that is first absorbed by the window and internal
shading devices and then is transmitted to the zone.
Heat (incl. latent) from
Heat from people in the zone, including perspiration.
occupants

12.9.
12.9.1.

Diagnostic messages
Wall construction not defined in xxx

The wall construction (either for exterior or interior parts) is not defined in the named
enclosing element or wall part, and no default construction is defined for this type of surfaces.
Possible actions:
• Define default wall construction for this type of enclosing surfaces (this is the
default action; double click the message to display appropriate form)
• Define the wall construction for this element.
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• Check the position of the zone in the building. The wall type (exterior or interior) is
derived from the zone position relative to the building faces.
12.9.2.

Intersecting zones xxx and yyy

The named zones (partially) overlap. IDA Modeler cannot also calculate adjacency of these
two zones with other zones. Both zones are treated as having no adjacent zones.
12.9.3.

Setpoint errors

Max exhaust air flow must exceed min.
Max humidity setpoint must exceed min.
Max CO2 setpoint must exceed min.
Max setpoint for comfort temperature should exceed min …
In setpoint collection, the maximal values should exceed the corresponding minimal values.
The comfort temperature setpoints are used to switch heating and cooling devices on and off.
Wrong order of setpoints may result in simultaneous heating and cooling (this is not a wellposed problem: it is not possible to calculate required cooling and heating if they are applied
simultaneously).
Double click the message to open the setpoint collection for editing.
12.9.4.

Zone airflow exceeds 20 air changes per hour

In the system with constant air ventilation (CAV), the ventilation seems to be too intensive.
Double click the message to open the setpoint collection and edit the minimal air flow.
Also wrong zone height may cause this warning.
12.9.5.

Selected exhaust air flow in zone xxx is out of the recommended bounds …

In the system with constant air ventilation (CAV), the requested air flow is out of the bounds
recommended in Controller setpoints.
This is only a warning. These setpoints are not used in case of CAV.
12.9.6.

U-value for envelope element exceeds 5 W/m2K

U-value for envelope element (external wall, floor, or roof) exceeds 5 W/m2K. This is a poor
insulation level and may be due to a mistake in input data.
Double click the message to open the wall construction for editing.
Another possible source of errors: a wall construction resource designed for internal elements
is used for envelope elements.
12.9.7.

Improper features

Openings facing to ground are ignored
Openings in unconnected internal walls are ignored
Openings in floor and ceiling are ignored
Leaks to ground are not simulated
Leaks in unconnected internal walls are not simulates
Windows in internal walls are not supported
This version of Indoor Climate and Energy supports openings and leaks in building faces and
between zones. Openings are supported in vertical walls only.
Windows are simulated only in external walls and roof. A window between zones is
simulated as opening (unless it is always closed).
12.9.8.

Wrong temperatures

Dry-bulb min exceeds Dry-bulb max in xxx
176

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

Wet-bulb max exceeds Dry-bulb max in xxx
An impossible combination of dry-bulb and wet-bulb temperatures in location resource.
Double click the message to open the location object for editing.
12.9.9.

The overlapping area of zones xxx and yyy is too complicate

The common floor between two zones has too complicated shape to be simulates using
climate model. This may be in two cases: either the zones have different orientation (the
difference is not multiple of 90 Deg) or one of the zones is non-rectangular.
The heat flow thru the floor is ignored.
The eventual leaks between zones are simulated.
The heat transfer thru parts of the floors occupied by features (cooling devices, floor heats,
etc.), or defined as wall parts are still simulated.
12.9.10.

Unable to create a zone from non-adjacent IFC spaces

Attempt to create a zone from non-adjacent IFC spaces.
ICE Building model does not support non-connected (consisting of non-adjacent parts) zones.
The zone is not created.
12.9.11.

The wall between zones xxx and yyy is defined with different construction

The construction of a wall between two zones should be defined identically from both sides,
taking in account that layers for vertical walls are counted in reverse order. If a default
construction is used from both sides, this default construction should be symmetric (for
vertical walls only).
12.9.12.

The zone ceiling is above the roof

The height of zone ceiling above the ground is greater than the building height.
Fix one of three values: ceiling height, floor height over the ground, or building height.
12.9.13.

Shading control is not used in xxx

The external shading has shading control, but no shading device is controlled.
12.9.14.

Synthetic climate is only intended for periodic simulations

The synthetic climate will generate the same weather conditions every day (except sun
radiation that is calculated from the actual sun position).
12.9.15.

The size of the device was changed ...

The size of cooling or heating devices is tightly connected with its thermal behaviour.
If the parameters of the devise were selected from desired power (alternative input), these
parameters will not be relevant after change of size.
Click Ok to accept new size; then open the object and check the parameters.
Click Cancel to restore the previous size.
12.9.16.

The synthetic climate does not correspond to the selected simulation time

The selected synthetic climate (summer or winter) does not correspond to the selected
simulation time and place.
Select “Run anyway to continue simulation.
Select “Cancel to fix the mistake before running simulation.
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12.9.17.
Do you want to remove producer-supplied information and use a
simplified model instead?
The Active Beam object may be defined either by producer-supplied parameters (fetched
from database) or by simplified user-defined parameters.
Click Yes switch to user-defined parameters. It will be not possible to restore the original
information, if it is not saved to a file.
See Active Beam for details.
12.9.18.

The object xxx is not inside yyy

The feature (window, radiator, etc.) is located [partially] outside the enclosing surface.
To fix it, either move the feature inside the wall, or change the zone size.
12.9.19.

Overlapping features xxx and yyy

The features (windows, radiators, etc.) should not overlap, including features defined on
different sides of a wall. There are however two exception from this rule:
• Leaks and active beams may overlap with other features
• Floor heat may share the place with features on ceiling in the zone below. Partial
overlapping is not allowed in this case; the feature should be completely under the
floor heat.
Wall parts should not overlap on the same side of a wall.
Features should not intersect the boundaries of wall parts, both explicit (on either side of the
wall) and derived from adjacency, but may be placed inside a wall part. There are also two
exceptions:
• Leaks and active beams may overlap with wall parts
• Floor heat may intersect with wall parts defined on the ceiling below and with
implicit parts derived from adjacency.
If the zone’s floor and the ceiling are modelled as a single surface (cyclic connection), all the
restrictions above are applied to this combined enclosing surface.
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IDA Reference Manual
Overview
Introduction

IDA is an object-oriented simulation environment designated to handle a wide range of
different types of simulation problems. The systems to be simulated are decomposed into
subsystems that are modeled using the Neutral Model Format (NMF). These models are then
connected together to form a simulation model of the original system. The equation solver can
solve most systems of differential-algebraic equations that can be formulated in NMF. Both
steady-state and dynamic problems can be dealt with, as well as discontinuities in the
solutions.
The basic IDA help documentation consists of the following sections:
Modeling
How to build an IDA system: creating a system, inserting components, parameters,
boundary conditions, connections, etc.
Simulating
How to simulate an IDA model.
Viewing the system and the result
Navigating in IDA system: view types; saving and printing results.
Advanced features
Extra features that may be implemented in IDA applications: resources, database,
parameter mapping, calendar, etc.
Graphical Editor
How to edit the forms.
Help to user interface
Help topics about menu, dialogs, diagnostic messages, etc.
Information about IDA applications
Introduction
Help to IDA applications
Information for application developers
Writing new applications
Inside IDA Modeler
A single or several systems are stored in an IDA document. To each document there is a
corresponding file on the disk. The IDA simulation environment can also handle a few other
types of files, e.g., text files and plot files (time series).
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The system(s) to be simulated is constructed in an open document by adding different types of
objects. There is one symbol corresponding to each object. Some objects represent single
NMF-components. Others represent boundary conditions, connections or entire systems.
Some objects are mere graphical symbols designed to make it easier to understand the
structure of the whole system. See also Modeling.
An object may be selected at any time. It then becomes a part of the selection. Many functions
operate on the selected objects. A selected object may be unselected at any time. See To select
objects for instructions on how to select and unselect objects.
A system that can be simulated is called an executable system. It order to be executable a
system must, among other things, be well-posed, i.e., it must contain a correct set of boundary
conditions. A system that is not well-posed may still be used as a component in another
system.
13.1.2.

IDA Applications

The IDA Simulation Environment is a framework for creating IDA applications for different
domains.
A simple application contains a set of equation objects to build the mathematical models of
the simulating objects. More sophisticated applications builds the mathematical model
themselves using a physical description of the object.
The suite of IDA applications may differ in different releases of IDA Simulation Software.
Additional IDA Applications may be purchased and installed afterward. With the Developer’s
Release, the users can develop their own applications.
Click help to applications to see the available application-specific help information.
13.1.3.
IDA SE
IDA system
Document
Model
NMF Model

Macro Model
Data object
Modeling
Simulation
Parameter

Variable
Interface
Array

Glossary
IDA Simulation Environment, the simulation tool. Consists of IDA
Modeler, IDA Solver and IDA NMF Translator.
A full description of a simulation problem
Either an IDA system or an auxiliary document: form, picture, plot file,
text file
A component of an IDA system or another model
A model described in the NMF language. In IDA Modeler, the user has
access to the parameters, variables and interfaces (links) in NMF
models, but cannot change the structure and equations of the NMF
models.
A model that consists of connected models. Using IDA Modeler, the
user can create macro models, change their structure and connections.
A common conception for the whole IDA system and any part of the
system
The process of building an IDA system
The process of solving a simulation problem. IDA SE uses the IDA
Solver.
A property of the system that is not changed during the simulation. IDA
SE supports several kinds of parameters: numerical, logical (Boolean),
symbolical, strings, filenames, pointers to resources. The start values of
variables are regarded as parameters.
A (potentially) time-dependent property of system. IDA SE supports
only numerical variables.
An ordered set of variables used for connections
A collection of objects of the same type. IDA SE supports arrays of
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variables, parameters and (only 1-dimensional) interfaces. The size of
array may be either constant or parameter(s).
Connection
The connection between two interfaces means that the corresponding
variables are either equal or opposite (for flow variables with opposite
directions). In some cases a direct connection between variables is
possible.
Connection line
A line between two models in the schema that represents a connection
between two interfaces of these models
Boundary
A connection with a constant or a given variable or interface.
Symbol
Graphical representation of a model in the schema. The inserting and
deleting of the symbol means the inserting or deleting of the model.
Field
Graphical object that show (and sometimes allows to edit) the value of
some parameter in IDA system
Graphical element Auxiliary graphical object used as illustration
Text element
Auxiliary graphical object containing text
Button element
Graphical object in form of 3-d button
View
View of the object is a window on the user’s display that show the
object using some view type
View type
The method of showing a data object. The most common view types are
form, editor, schema, outline, diagram and dialog.
To open an object Open a view to the object
Simulation data
Set of parameters that describes how the system should be simulated,
e.g., start- and end time.
Resource
Model used indirectly (by pointers or as templates).
NMF
Neutral Model Format
Right-button menu The menu that pops up when the user click an object with right mouse
(context menu)
button
13.2.

Modeling

The systems that are to be simulated are constructed by inserting different types of graphical
elements into the schema view of the system. Some elements represent a single NMF
component. Others represent a boundary condition, a connection or an entire system. Some
elements are mere graphical symbols designed to make it easier to understand the structure of
the whole system. There are also control elements, such as buttons or input/output fields.
13.2.1.

Levels of IDA systems.

IDA systems may exist on three different levels:
Wizard level. The user fills in a form (or a few forms in turn) and starts a simulation. The
user has no direct control over the physical or mathematical model of the simulated system.
Physical level. The user builds a physical model of the simulated system, but has no direct
control over the mathematical model.
Mathematical level. The user directly builds the mathematical model of the simulated
system. No physical model required.
The simplest IDA applications only support the mathematical level.
To support the physical level, the application should contain
(1) models and forms for physical components,
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(2) the algorithm required to build the mathematical model (Invoke algorithm).
To support the wizard level, the application should contain
(1) model and form(s) of wizard object,
(2) the algorithm(s) required to build the physical or mathematical models (Invoke algorithm).
An IDA application may provide a possibility for gradual modeling: the user may start by
filling in the wizard form and then convert it to the physical model, modify this description,
and convert it to the mathematical model.
IDA applications may also support folders (multi-system projects) that may consist of several
systems of any level.
13.2.1.1.
Modeling at the mathematical level
A math model is built by inserting objects into an open document and then connecting some
of them. Objects mostly appear as boxes with explanatory pictures and connections as lines
between boxes. Objects can be of different types. The basic type is the equation object that
represents a single NMF component. Other types represent a boundary condition, or even a
small subsystem (macro object). Some objects are mere graphical elements designed to
make it easier to understand the structure of the entire system. Each IDA application can
accept only those equation objects that are specific to the chosen application.
13.2.1.2.
Modeling at the physical level
A physical model has a hierarchical object structure, made available in an open document.
A physical object in the structure is shown as a form containing fields for parameters and
list fields for lists of subcomponents of different types. The object model is changed by
inserting components and editing parameters via the open form. For example, the form for a
Zone model may have list fields for walls and loads.
The user may open subcomponents to edit their parameters and possibly insert
subcomponents etc.
In some cases, objects at the mathematical level can appear as components in the physical
model.
See also Physical models in applications.
13.2.1.3.
Modeling at the wizard level
There is really no modeling at the wizard level. The user should just fill in all the fields of
the wizard form(s) and press the Start button, which is available both in the toolbar and in
some form.
See also Wizards in applications.
13.2.1.4.
Gradual modeling
With gradual modeling, the user first builds a model at the physical or wizard level, as it is
described in the sections Modeling at wizard level and Modeling at physical level.
If the modeling facilities available at the chosen level are inadequate for the problem, the user
can switch to the next level by selecting the Tools | Build model menu item. IDA Modeler
either converts the model to the next, more detailed level or creates a new model, at the next
level, from the existing one.
The user can then continue the modeling at the new level.
Note changes made at one level cannot be reflected at a less detailed level.
Not all IDA applications support gradual modeling. See gradual modeling in applications for
details.
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13.2.1.5.
Modeling a multi-system project
The user may insert IDA systems of any available type in a multi-system project (see insert
object). The project may contain resources, and boundary and output objects that are available
from all systems in the project.
13.2.2.

Working with IDA systems

13.2.2.1.
Creating a new Document
To create a new document, do the following:
1.

Select the File | New... menu item

or press the New button in the toolbar
2. In the New document dialog, select the desired application and type of document (or document
template if defined).
3. Press the OK button

A new document is displayed on the screen.
Applications may also provide buttons in the toolbar for opening of documents

New Document dialog
13.2.2.2.
Opening an existing Document
To open an existing document, do the following:
First method: use menu or toolbar
1. Select the File | Open menu item
or press the Open button in the toolbar
2. From the Open dialog, select a file(s) to open
3. Press the OK button

The selected document is displayed on the screen.
The File menu also contains a list of the 4 last used documents. Select them to reopen these
documents.
Second method: drag and drop
Drag the file icon from Windows’ folder and drop it into IDA window.
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13.2.2.3.
Saving an existing Document
To save an existing document, do the following:
1. Select a window showing the document that is to be saved
2. Select the File | Save name menu item
or press the Save button in the toolbar

See also:
Saving a Document with a new Name.
13.2.2.4.
Saving a Document with a new Name
To save an existing document under a new name, do the following:
1. Select a window showing the document that is to be saved
2. Select the File | Save as... menu item
3. Select the directory in the dialog box that is displayed
4. Input the file name
5. Press the OK button

13.2.2.5.

To save a system as a template

1. Prepare the document
2. Select the File | Save as... menu item
3. Select the subdirectory <ida directory>\lib\<application name>\<system type> in the application
directory (example: <application name> = ice, <system type> = building or ahu)
4. Save the document in this directory.

The template will appear in the New document dialog.
If the system is saved with the name default.idm, it will be used as a default template for
systems of that type.
13.2.2.6.
Closing a Document
To close a document, do the following:
5. Select a window showing the document that is to be closed
6. Select the File | Close name menu item
or press Shift+F4
If there are changes to the document that have not previously been saved, the program asks if these
should be saved or not.

13.2.3.

Quitting the Program

To quit the program, do the following:
1. Select the File | Exit menu item
or press Alt+F4
or click the cross button in the upper right corner of the main window
or click the icon in the upper left corner of the main window and select Close from the menu
or right click the IDA button in the Windows Task bar and select Close from the menu.
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You will be prompted to save any changed documents.

13.2.4.

Navigation in the IDA system

13.2.4.1.

Hierarchy of Data objects

The IDA System is a hierarchy of data objects (components). Every data object has a list of
attributes (e.g., name, description, type, value) and components (subcomponents). The
components are also data objects.
Every data object has a parent object which is the object containing it.
Primary data objects (without components) are parameters, variables and interfaces.
A parameter describes some property of the containing object. A parameter value is not
changed during a simulation. The parameters may be numerical, logical, textual, symbolical
(alternatives) and pointers to resources.
A variable represents a single time-dependent value. The dependence may be either given
(using tables, files of functions) or calculated in the simulation. Only numerical variables are
implemented in the current version of IDA SE.
An interface is an ordered list of variables, used for connections. Note that the variables
are not subcomponents of the interface, but rather act as references to e.g. an equation object
where they belong.
Composite data objects are models and resources.
A model represents a description of a physical object (e.g. room , wall , window , etc.)
or an abstract object used in a simulation (NMF model , macro object , input or output
file , report ).
A resource is a set of parameters that may be used as a parameter entry (e.g., wall
construction , schedule , building material ) and as a template (object type) for other
data objects.
See also Object types in applications.
13.2.4.2.
Object Name
Every data object has a name. The name is unique among the components of the same parent.
The names of built-in objects may appear translated to the current language.
To rename an object

1. Select Rename... from the object’s shortcut menu.
2. In the Rename Object dialog, type the new name and press OK.
The user can rename any inserted object and no built-in objects.

The names are used to reference the objects in parameter mapping, binding, fields in forms,
etc. IDA Modeler tries to modify all references to the renamed object, but this is not always
possible. Therefore we recommend renaming objects straight after insertion only.
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Object Name dialog
13.2.4.3.
To Open an Object
All data objects may be opened, that is shown in a separate window.
To open an object in the selected document do the following:
1.

Select the object to be opened.

2.

Select the Object | Open menu item,
or select the Open menu item from the object’s shortcut menu,

or double click on the object (if the cursor

has an "opening book" pictogram),

or (for selection in outline or list field) press the Enter (or Return) key.
The object is now opened.

13.2.4.4.
To Open a specific view of an Object
Every data object may be shown in different aspects, or using different views.
To open an object in a specific view, do the following:
1. Select the object to be opened.
2. Select the Open with... menu item from the object’s shortcut menu
3. Select the desired view from the submenu.

The object is now opened.
13.2.4.5.
To change the view of the Object
To open another view of the object shown in the current view:
1. Select the View | view type menu item (where view type is the desired view)

13.2.4.6.
To open the parent Object
To open the parent object (i.e., the object that contains the object shown in the current view):
1. Select the View | object name menu item (where object name is the name of the parent object)

13.2.4.7.
To close a view of an object
To close the active window, do one of:
• Select the View | Close menu item
• Press the Ctrl+F4 keys
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• Click the cross button in the upper right corner of the window
• Click the icon in the upper left corner of the window and select Close item from the menu.
If the window is the main view of an IDA system, you will be prompted to confirm the
closing of the system.
If the window contains any changed form or text, you will be prompted to save the form or
text file.
13.2.5.

Working with objects

13.2.5.1.
Inserting components
There are three different methods of inserting a new component:
Insert, method 1: use menu
1. Select the Insert | New object menu to get the Insert Component dialog.
2. Select the desired component type. Optionally supply the component name and
description. Press OK.
3. If your form contains a list field for the components of the selected type, the component
will be included in this list. If not, point out the place for the component’s symbol by
clicking in the form (see placing the objects)
Only in this way you can also insert (a) an existing macro object from file and (b) a symbol for the
whole macro (it may be used for connections).

Insert, method 2: copy and paste
1. Open an object that contain a component of the required type (the application may provide
a “library that contains components of different types).
2. Select the appropriate component(s) and copy to clipboard
3. Paste the copy of the component(s) into your document
4. Optionally rename the component(s).
Insert, method 3: drag and drop
1. Open an object that contain a component of the required type (the application may provide
a “library that contains components of different types).
2. Select the appropriate component(s) and press the left mouse button.
3. Drag the selected component into your document (with the left button pressed).
4. Release the button.
5. Optionally rename the component(s).
13.2.5.2.

Insert Component Dialog

The Insert Component dialog is used for inserting new components or replacing a
component with a new one.
The dialog contains three boxes: Template, Name and Description.
In the simplest case (if there are no user-defined templates), the Template box contains a list
of the classes of insertable objects. This list may be divided into sections.
When user-defined templates are available, the Template box is the outline of the hierarchy
of available templates.
To select a component to insert
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1. Select the desired template in the Template box.
2. In the Name and Description boxes, type the name and description of the new object.
3. Select the OK button.
The Database button enables insertion of components from the database. The button is available only
if the database contains objects corresponding to the selected template.

The Template box may also contain some special items:
Insert existing macro
Enables the insertion of a copy of an existing IDA system from a file
Insert symbol for the current macro
Allows insertion of a symbol that represents the boundary of the current IDA system. It
may then be used for connections.
If the Autochoice boxes are marked, IDA Modeler proposes the name and/or description of
inserted object each time a template is selected.
The Name box is disabled in situations when the user has no control over the component's
name.

Insert Component dialog
13.2.5.3.
Removing components
The user may remove any component inserted in a data object. Built-in components cannot be
removed.
The standard editing functions are used for removing components, see To delete, To paste.
When a connected component is removed, all connections of this component are also
removed.
13.2.5.4.
Macro objects
When there are too many objects in a scheme it can appear untidy. Avoid this by inserting a
macro object into the main document. A group of objects can reside within this macro. In
this way, a macro object is a placeholder for ordinary objects just like a directory (folder) is
a placeholder for files. The main document can also be considered as being a main macro
(something like root directory). Macros can be nested, exactly like directories and
subdirectories.

188

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

A new macro can be inserted into the current macro object exactly as any other object (see
Insert object). Double-clicking on it opens the macro, which can then be filled in or edited
in the same way as the main macro object.
The application may provide ready-made macro objects. See Macro objects in applications.
13.2.5.5.
To copy a data object
“To copy a data object means the same as “To insert a copy of a data object.
See To insert a component.
13.2.5.6.
To replace a data object or a graphical element
A data object may be replaced either with a new component or with the current clipboard
content.
A graphical element (field, shape, text, button) may be replaced with a new element or with
the current clipboard content.
To replace a component or element with a copy of another one,
1. Copy a desired component or element to the clipboard
2. Select the component to be replaced and select Replace... from the shortcut menu.
3. In the Replace selected object dialog select From clipboard. This choice will not be
available if the replacing and replacement objects are incompatible.
4. For data objects, make the desired selection for the check boxes “Keep user-defined
values and “Reset default values. See the table below.
For graphical elements, check the box "Keep graphical attributes" to preserve the font,
color and style of the replaced element.
5. Click the OK button.
To replace a component or graphical element with a new one,
1. Select the component or graphical element to be replaced and select Replace... from the
shortcut menu.
2. In the Replace selected object dialog select With new object (may be shape, field, etc.
instead of object)
3. For data objects, make the desired choice for the check boxes “Keep user-defined values
and “Reset default values. See the table below.
For graphical elements, check the box "Keep graphical attributes" to preserve the font,
color and style of the replaced element.
4. Click the OK button.
5. From the Insert Object dialog, select the desired object and press OK.

Replace selected object dialog
The replacement of a data object is in fact not a single operation, but three slightly different
operations. Depending on what is required, select the values for the check boxes in the Replace
selected object dialog:

Operation
Replace with the exact copy
of the other object.

Keep user-defined
values
Uncheck
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Check

Check

Connections

13.2.6.1.
Connect objects via interfaces
Two objects with compatible interfaces can be connected. The connection implies that the
corresponding variables in these interfaces have to be equal during simulation (or be equal
with opposite sign for flow variables with different directions of definition). The equalities
may be modeled using equations (acausal connections) or assignments (causal connection
features). Causal connections between two continuous objects are forbidden. In the current
version of IDA SE causal connections are not visible on the schema.
13.2.6.2.
Acausal (visible) connections
If two equation objects contain vacant compatible interfaces and reside in the same macro,
they can be connected via these interfaces. Such a connection is visible and is represented as
a polyline in the scheme view. Objects that can be connected normally have a threedimensional border. When placed above this border, the cursor changes its shape to ,
showing that the object may be connected (has vacant interfaces of compatible type).
To establish a connection
1. Double-click on the object’s border to select the first object. A little uncolored square
appears at this spot.
2. Mark the path of the connection line by clicking as the cursor is moved between the
objects.
3. Put the cursor onto the border of another object. The cursors must change its shape to
4.
5.
6.
7.

, otherwise the connection is impossible.
Click there to select the second object. Again a little uncolored square appears at this
spot, and the Connect dialog opens for the pair of selected objects. Two boxes contain
all the vacant interfaces that have a vacant compatible match in the opposite object.
To select an interface, select it in one of the Connect dialog boxes. Only the interfaces
that are compatible with the selected one remain in the opposite box.
To select the second interface, click it in the opposite box of the Connect dialog.
Click OK. The dialog closes, and a line between the two little squares appears to
represent the connection.

190

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

Connection dialog
13.2.6.3.
Vector interfaces
Vector interfaces are shown in the Connect dialog boxes in a special way: each element
separately. When all elements are vacant, n+1 of them are shown, where n is the current
vector dimension, i.e. the current value of the corresponding model parameter. The elements
have indices from 1 to n+1; the last element is extra and is marked as NEW. If it is selected
for connection, then the value of the model parameter n automatically increases by 1. For
example, if the model parameter is nWall=2, then interface TQWALL[nWall] is shown as
TQWALL[1]
TQWALL[2]
TQWALL[3](new)
If TQWALL[3](new) is selected for connection, then nWall is set to 3, otherwise nWall
remains unchanged. Keep in mind that a new value of a model parameter can also affect
other arrays.
13.2.6.4.
Nice looking connection lines
A connection line is a polyline that consists of vertical, horizontal and possibly slanted
segments. If drawn automatically or carelessly, between two points on a schema, it may not
look very nice, crossing graphical symbols etc.
To draw a connection line manually, do the following:
1. Double-click on the first object's border to choose a starting point (a little square).
2. Click at the point on the same vertical or horizontal line to mark the end of the first
segment.
3. Click to mark the end of the second segment (horizontal or vertical), and so on. After
each click the next dotted segment appears.
4. Click on the border of the second object to end the connection line and thereby open the
Connect dialog.
Existing connection lines may also be edited after their creation. Select Edit from the short
cut menu that is shown by right clicking on the line. Edit as polyline .
13.2.6.5.
Deleting a visible connection
To delete a visible connection mark the connection line by clicking on the open right button
menu and selecting Delete. The line disappears and the connection is disconnected.
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13.2.6.6.
View of all the connections between two objects
When two objects have several connections, it may be difficult to gain overview of the
situation. The user can look through such connections and compatible interfaces for the two
chosen objects simultaneously. Select both objects simultaneously (Shift-click on the
second). In the right button menu for any of the objects select Connect. A two-column table
will appear, divided into sections by horizontal lines.
In each section interfaces in the left column is compatible with interfaces in the right. Any
pair of connected interfaces appear on the same line with a double arrow <---> between. An
interface that is connected with some other (non selected) object is shown with arrows
pointing outwards.
13.2.6.7.
Connection via border of macro
Two interfaces from objects in different macros cannot be connected directly; such a
connection is made up of several parts. Imagine the connection as a line crossing the macro's
borders. Then each part from one border to the next is a separate connection, and each
intersection of the line and border is called an interface reference.
The border of a macro is always visible when viewed from outside, as the border of the
macro symbol. But to make it visible from within the macro a Symbol for the current macro
object must be explicitly inserted. Once inserted, this object looks like a normal box. To
separate it from other symbols, expand it and make it look like a border around all the other
objects in the macro. Without the specially inserted visible border, interfaces internal
objects cannot be connected to the outside.
For example, to connect an object X from the main system to an object Y from a macro in
the main system, one must connect interfaces from the chosen objects to the same interfacereference of the macro.
To establish this composite connection, open the main system (in the scheme view) and draw
a connection polyline between X and the macro in the usual way (see Acausal (visible)
connections). In the Connect dialog a list of vacant interfaces for X and (usually) an empty
window for the macro can now be viewed. Select a vacant interface for X and type a name
(Int_ref1 is suggested") for the new interface reference object into the Interface slot (just over
the empty window) and click OK. That establishes the connection between X and the macro.
Now open the macro, draw a connection polyline between the Y and the (previously inserted)
border of the macro and in the Connect dialog select the interface in Y and the interface
reference Int_ref1.
Click OK to finish the connection.
The same connection can just as well be created by starting from inside the macro and
connecting Y to the border first.
13.2.6.8.
Disconnecting a composite connection
To disconnect a composite connection, delete in the usual way (see Delete visible
connection) at last one connection lines it consists of. Undeleted parts remain valid and
visible and can be used to establish a new composite connection.
13.2.6.9.
Causal connection characteristics
A causal connection from object A to object B fetches values from object B (source) to a
single or a set of variables in object A.
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Unlike the situation for acausal connections, several objects can obtain values via causal
connections from the same interface (or variable) in the source object. Furthermore, a causal
connection can be made directly to a subobject of a different macro or to some built-in
object of IDA SE (e.g., plugs).
Causal connections are [in the current version] never shown in the schema. To see them,
one has to open the receiving subobject (using the form or the outline view) and look at
interfaces. An interface that is connected (either causally or acausally) will be shown like
this:
CLIMIN <--- CLIMATE.DATAOUT (here the interface CLIMIN in the opened object is
connected to the interface DATAOUT in the object CLIMATE). The connection cannot be
seen at all from the sending interface. (DATAOUT in the example above.)
Keep in mind that an opened document is not always automatically redrawn after each
change. Select the View | Refresh menu item after establishing or disconnecting a
connection to display an updated view.
13.2.6.10.
Establishing a causal connection
1. Select the interface which is to receive data.
2. Open the dialog Connect interface for that interface.
3. Choose a source interface.
More specifically,
(1) to select a receiving interface (with the name, say, XXX), open the object where it
resides with some form or outline and find the interface,
(2) to open the dialog Connect interface XXX, right-click on the interface and select
Binding in the menu displayed,
(3) to select a source interface:
a) switch the radio buttons to object in ... (the source object belongs to some macro of
the present system) or built-in object (get data from a source object that is built into
the application). Only objects of compatible type will be shown in the left window.
b) in the left window, select from the list an object or a macro object (which contains the
source interface.)
c) in the right window, select the source interface from outline. Keep in mind that only
compatible interfaces and their placeholders are shown. If a placeholder cannot be
opened there are no compatible interfaces.
d) click on the Connect button to finish the process.
13.2.6.11.
K+Disconnecting a causal connection
1. Select the interface which is receiving data.
2. Open the dialog Connect interface for that interface by right-clicking and selecting
Binding in the displayed menu.
3. Disconnect the connection interface by clicking on Disconnect in the dialog.
Remember that an opened document is not automatically redrawn after each change. To see
an updated view select the View | Refresh item in the menu bar after establishing or
disconnecting a connection. For a causal connection only the receiving interface is shown as
being connected.
13.2.6.12.
Connect a variable
To connect an individual variable (say, XXX) open the dialog Connect variable XXX:
1 Open a form with XXX value slot, and use the right mouse button to click on the slot.
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2 Select Binding... from the right button menu.
To select a source:
1. Switch the radio button, if necessary. There are 4 options
(1) use the given value,
(2) use the initial value,
(3) follow invoke procedure,
(4) connect to a variable of ... .
2. Complete the connection. The procedure depends on the (radio-button) case:
(1) Fill in the value field and click on the Connect button.
(2) Click the Connect button.This involves no further choice – XXX will be tied to its
own initial value.
(3) Click the Connect button. This alternative, if available, sets the source for XXX to
an object defined by an invoke algorithm. This source appears in the right window.
Any attempt to browse the right window or to change the source will automatically
switch the radio button to (4).
(4) Select a source:
1. Select an object that contains the source variable or parameter from the left
window.
2. Select the variable (or parameter) from the outline in the right window.
3. Click on the Connect button.
Tips. Only compatible variables, parameters, and their placeholders are shown in the
right window. If a placeholder cannot be opened there are no compatible sources.
Se also Boundary conditions.
13.2.6.13.
Disconnecting a variable
To disconnect a connected variable (say, XXX), open the dialog Connect variable XXX
(see Connect a variable) and click the button Disconnect.
13.2.7.

Parameter setting

To set parameter values in a data object:

1.
2.
3.
4.

Open the object. A form or dialog is displayed.
Check all fields in the form or dialog. Change the required fields.
If the form or the dialog contains references to components, open them to set parameters.
Close the form (if it is not the main form). For dialogs – click on the OK button.

Depending on the type of value, it is edited in a different way:

type

how to edit

Number or string

type in the new value

Boolean

Click in check-box

Symbol

Select from available values

Resource

Select from available values or select “Search in database.
Alternatively click with the right mouse button (or “ button if
present) and select “New resource... or “Load from database...
from the shortcut menu.
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Filename

Type in the filename or press “... button if present and select the
file

Date

Double-click to open the calendar or edit directly.

If a parameter has a default value, the field has cyan background color. To restore the default
value, right-click and select Mapping | Restore link from the shortcut menu.
See also Parameter mapping.

13.2.8.

Start Conditions

The Start conditions are the set of initial values for the variables.
For static or periodic simulations they are used as initial guess only.
In case of a dynamic simulation, the start values may be significant for the final result.
An application may use several methods for working with initial values:
• The fields for initial values may be included in forms.
• The initial values may be mapped to some parameters or calculated from the parameters.
• A startup phase may precede the main (calculation) phase. A Startup-phase is a a
simulation with the sole purpose of selecting a suitable starting point for the real
experiment.
13.2.9.

Boundary conditions

The term boundary conditions in an IDA system means two things:
1) the set of variables in the system which are given (as opposed to calculated by the
model);
2) the values assigned to the set of given variables. For dynamic simulations the values
may be time dependent.
The boundary condition for a given variable is established in one of two principal ways:

• as an explicitly given value or as a reference to the initial value of the variable (for
constant conditions);
• as a causal connection to a boundary object.
The following types of boundary objects are available in IDA applications:
Source file
A file containing time series (plot file)
Source table
A collection of time series stored directly in the system
Algorithmic object
A model written in NMF that generates time series
Plug
A set of constant (time-independent) boundary values
See Connect a variable for instructions on how to establish a boundary condition.
13.2.9.1.
Source file
A Source File object contains
• a reference (pathname) to a file (plot file or prn-file) containing a single or several time
series;
• the description of each time series (variable) in the plot file;
An IDA application may provide source files of a specific format (i.e., with a fixed set of variables). A
source file object may also contain interfaces.
The user may define custom Source File objects.
See also Source Files in applications
To specify a standard Source file
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If your system already contains the required Source File object, the file name only should be
specified. If the system does not contain the required object, or if more than one source file is
required, it can be first inserted (see Inserting Component).
Open the Source File object and type the pathname of the plot file. The Browse... (or “...)
button can also be used to select the file.
To specify a custom Source file

1.
2.
3.
4.

Insert an empty Source File object (see Inserting Components).
Open the inserted object. The Source File dialog is displayed.
Type the file name or press Browse and select the file name.
Using the Add button, add the variables corresponding to the columns of the plot file. If
the plot file contains a header line, press the “Take a list of variables from file button
instead.
5. Press OK.
To use a Source file

The variables in the source file may be used as boundaries for variables in models (see
Connecting a variable).
Standard source files may also contain interfaces for interface-level causal connections.
To view the contents of a plot file, select Open with... | Diagram (or Text, or Report) from
the shortcut menu.
13.2.9.2.
Source File dialog box
The Source File dialog box is used to specify the parameters of a custom source file object.
To display this dialog, open a source file object.

Source File dialog box
Object name
Shows the name of the Source file object
Filename
Type here the pathname of the plot file associated to this object. Alternatively press
Browse button and select the file using the Open File dialog box.
Description
Type here any additional information about the object or plot file.
Variables
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If the plot file does not contain column headers, use the buttons to prepare the list of
variables corresponding to the columns in the plot file. The number of variables should
agree with the number of columns in the plot file (the first column contains time, it is not
counted).
If the plot file contains column headers, press the button “Take the list of variables from
file to prepare the list of variables. Then you can reorder the variables and remove
unnecessary variables.
Browse
Press the Browse button to select the plot file using Open File dialog box.
13.2.9.3.
Source Table
A table contains a list of time-dependent variables given as time series. Unlike Source files,
the time series in tables are stored directly in the table.
The tables supported by IDA applications may also contain interfaces and parameters.
See also Source Tables in applications.
To prepare a table

1. Insert a Table object into your system (see Inserting Component). It may either be a table
supported by the application or an empty table.
2. Select the system variable that you want to connect to the table: select Binding... from the
variable’s shortcut menu. (For application-supported tables, that contain interfaces, you
can connect on the interface rather than on the variable level.)
3. In the Connect variable dialog, establish the connection to a variable in the table. If the
table does not (yet) have an appropriate variable, click the “New... button to add a variable
to the table and then click OK in the Add new variable dialog.
4. Click Connect.
5. Repeat items 2-4 for every variable you want to bind.
To edit the time series in the table

1. Open the table by double clicking on it. The diagram view is opened. (The default view
may be different for the tables supported by applications)
2. Click on the diagram with right mouse button and choose Properties... from the shortcut
menu.
3. In the Diagram properties dialog, select appropriate X (time) and Y ranges. Click on the
OK button.
4. To edit the time series, edit the corresponding plot line.
13.2.9.4.
Soutce Table Dialog Box
The Source Table dialog box is used to show and edit time series in a source Table object.
To display this dialog, open a source file object.
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Source Table dialog box
Table
Shows the name of the Source Table object
Description
Type here any additional information about the object.
Values
Type here the time and the values of the variables. The rows are automatically sorted by
time column and new rows are automatically added to the end of the table.
Variable values may remain empty.
The rows with empty time will be discarded after closing the dialog.
Add row
Click here to add a row before the current one.
Delete row
Click here to delete the current row.
13.2.9.5.
Plugs
An application may provide Plug objects that contain parameters and interfaces. They may be
used to define time-independent boundary conditions. Plugs may either be built-in in the
application (then the user cannot change the parameters of the plug) or insertable in the IDA
system.
Plugs may be connected at interface level only.
A plug inserted in the user’s system may be opened to edit the values of the parameters.
Plugs in applications

13.2.10.

Preparing output

Systems of the wizard and physical levels have predefined sets of output files and reports.
At the physical level the user has control over the output by switching (predefined) files and
reports on and off:
1. Select the Tools | Choose output... menu item (the system’s form may also contain a
button for this purpose)
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2. In the Choice of output dialog mark the desired files and/or reports
3. Press OK.
At the mathematical level the user can insert custom output files:

1. Insert one or more Output file objects (see Inserting Components). Note that the system
may already contain an empty output file.
2. To a variable in an output file, open the variable and switch “Logged to to the desired
output file.
See also Output in applications
13.3.

Simulating

13.3.1.

Running a simulation

To start simulation, select the Tools | Run menu item (the system’s form may also contain a
button for this purpose).
The algorithm of the Run command may include a checking of parameters and connections,
building the mathematical model (for wizard and the physical levels). If some problems occur
at that time, they will be reported in the log window and simulation will be suppressed.
The IDA Modeler prepares IDA input file and calls the IDA Solver. During simulation, a
monitor window is displayed. It shows the execution time, current solver activity, and the
values of up to 3 variables.
After successful simulation, IDA Modeler reads the results of simulation and prepares the
reports.
If the simulation failed, a text document may be opened containing error messages that can be
used to find the reason for the failure. A common reason for failure is that the simulated
system does not constitute a well-posed problem.
13.3.2.

Well-posed problem

In order to be executable a system must, among other things, be well-posed, i. e., it must
contain a correct set of boundary conditions.
Different IDA-applications contain different algorithms to set up well-posed problems.
For wizard-level systems the application should guarantee the well-posing of the
mathematical model.
For physical systems, any physically correct system should be converted to a well-posed
mathematical model.
For user-defined mathematical models, the user is responsible for the quality of the model.
The application may contain tools for (1) setting up a typical problem and (2) checking and
advising on non-typical problems.
13.3.3.

Simulation data

The simulation data include
• the start and end time of simulation (or simulation phases)
• the type of simulation (periodic or dynamic)
• some configuration parameters for IDA Solver, such as step size
The main simulation data are available via Simulation data dialog.
The default dialog contains fields:
Calculation tab
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Type of integration
Dynamic or periodic (available only for applications that support periodic simulations)
From time (or From date)
The start time of the calculation phase (in the specified time units).
For calendar-based applications, this field contains start date; the dialog contains also
Calendar... button.
To time (or To date)
The end time of the calculation phase (in the specified time units).
For calendar-based applications, this field contains start date; the dialog contains also
Calendar... button.
Startup tab

For applications that support startup phase, this tab contains the type and the start and end
time of the startup phase of simulation. This tab is not shown for periodic simulation.
Advanced tab

Tolerance
This number determines how accurately equations are to be solved (-)
Minimal timestep
The smallest timestep to be taken under normal conditions (h)
Maximal timestep
The largest timestep to be taken (h)
Maximum number of periods
Maximal number of periods in a periodic phase of simulation
Tolerance for periodicity
Tolerance for periodicity in a periodic simulation (-).
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The IDA applications may define different Simulation data dialogs, see Simulation data in
applications.
The simulation data may be unavailable at wizard level.
More solver parameters are available in the IDA Solver's configuration file ida.cfg in the
application directory. The structure of the configuration file is described in IDA Solver User
Guide.
Note that the solver configuration file is part of the IDA application. Any change of
parameters in this file will affect the simulation of all IDA system in this application.
13.3.4.

Monitor Dialog

During the simulation, IDA Modeler shows the Monitor window that displays the progress of
the simulation and the values of up to 3 variables.
To interrupt the simulation, press the Stop button. Select at this point to continue or cancel the
simulation.
In mathematical-level systems, the user may select the variables to be shown.

Monitor window
13.3.4.1.
To add a variable to monitor list
1. Select the variable.
2. Select Monitor item from the shortcut menu.
3. In Monitor variables dialog box
a) Using buttons Promote and Demote, select the position of the variable in the monitor
list
b) Choose the scale by supplying the values of the variable that corresponds to the two
horizontal lines on the Monitor diagram.
c) Type the legend to be shown under the monitor diagram.
d) Click on OK.
Only the top 3 variables in the monitor list are displayed in the Monitor diagram. More
variables may be provided in store to be able to reorder this list afterwards.
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13.3.4.2.
To edit the monitor list
1. Select the Tools | Monitor menu item (not all applications support editing of monitor
list).
2. In the Monitor variables dialog you can
a) Edit the list of monitor variables using the Promote, Demote and Delete buttons;
b) Change the scale of any variable by typing the values of the variable that corresponds
to the two horizontal lines on the Monitor diagram;
c) Change the legend to be shown under the monitor diagram;
d) Supply the maximal time period that fit in the Monitor diagram. By default, the
whole simulation time will fit in the diagram. This feature is not available for
applications with calendar-based time scale;
3. Click on OK.
13.3.4.3.
Monitor Variables dialog box
The Monitor Variables dialog box is used to edit the list of variables that are shown during
the simulation in the Monitor window.
To display this dialog, select a variable and choose Monitor item from its shortcut menu. The
dialog is also displayed when a variable is added to the monitor list.

Monitor Variable dialog box
Max time per screen
Specify the time period (in simulation time units) corresponding to the width of the
monitor window. This field is not used in applications with calendar-based time scale.
Monitor variables
Displays the list of the variables in monitor list. The buttons to the right of the list allows
reordering and deleting variables from the list.
In the current version of IDA Modeler, only the top 3 variables are displayed in Monitor
window.
Range
Supply two values of the selected variable. These values should correspond to the
horizontal lines on the Monitor window.
Legend
Specify the explanation text for the selected variable to be displayed in the Monitor
window.
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View the system and the results
View types

Every data object may be shown in different aspects. View type of a window is the name of
this aspect.
The standard view types are
• General View
• Schema
• Editor View
• Geometry View
• Diagram View
• Report View
• Text View
• Outline
• Inspector View (for mathematical level only)
• Dialog View
• Other view types may be defined in IDA applications.
For every data object the list of available views is shown in the submenu Open with… of the
Right-button menu. When one view is active, other views are available via the View menu in
the menu bar. Double clicking on the background of the window opens the first view (or the
second if the current is the first one).
13.4.1.1.
General View
A data object may be shown in different aspects (views)
General view is a default view for most data objects. The form consists of a fixed number of
fields that may be filled in by the user (as in a paper form).
In a form, the user can edit parameters, insert objects, open other views, etc.
The forms do not have OK and Cancel buttons; the changes made in a form take effect
immediately.
The descriptions of forms are generally stored in the application’s library (some forms are
automatically generated).
The library forms cannot contain variable fields, such as symbols for insertable components.
If the data object may contains insertable components, the form should contain list field(s) for
these components
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Form Example

Example of form. Zone form in IDA Indoor Climate and Energy application (Vers. 2.1)
13.4.1.2.
Schema
A data object may be shown in different aspects (views)
Schema view is a default view for macro objects in the mathematical models.
The components are shown as object’s symbols. They may be inserted and removed.
Generally a symbol is a rectangular box with a 3-dimensional border and a picture inside.
Connections between models are shown with connection lines.
The schema can contain also fixed fields (as a form).
The description of the schema is stored together with the corresponding macro object.
13.4.1.2.1.1.
Schema Example

Example of schema. Zone schema in IDA Indoor Climate and Energy application (Vers. 2.1)
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13.4.1.3.
Editor View
A data object may be shown in different aspects (views)
Editor view shows and let editing the shape of the data object and/or its components.
The components are shown as pictures in the real scale. They may be inserted and removed.
The user may change the geometrical parameters of the components by moving and reshaping
the pictures.
The editor views are automatically generated.
13.4.1.4.
Geometry View
A data object may be shown in different aspects (views)
Geometry view is a specialized form view for geometrical parameters. It is used as an
alternative (or complement) to the Editor view.
The Geometry and Editor views are synchronized: any change in one of these views is
reflected in the other one.
13.4.1.5.
Diagram View
A data object may be shown in different aspects (views)
Diagram view is an automatically generated view for input/output objects and for variables
from these objects. It contains a Diagram field, axes, legend and some explanatory text.
Unlike other views, the diagram views are by default rescaled after change of the window
size.
If an input/output object has a form view (= there is a form description in the library), the
form most likely contains all these fields (customized to the particular object). The diagram
view is the default view for input/output objects that have no form view.
13.4.1.6.
Report View
A data object may be shown in different aspects (views)
Report view contains the textual description of the object. The report is shown as a read-only
text window.
13.4.1.7.
Text View
A data object may be shown in different aspects (views)
Text view shows the object as a text file. Used for input and output files.
13.4.1.8.
Outline
A data object may be shown in different aspects (views)
Outline view shows the hierarchical structure of the data object and its components.
The user can
• navigate in outline using arrow keys and/or mouse;
• open the selected object (in a separate window) by double clicking or using the Enter key;
• pop up the shortcut menu by clicking with the right mouse button or pressing the
Shift+Enter key.
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13.4.1.9.
Expand and Collapse Nodes
To expand a node of an outline view means to show the subitems of this node in the same
view.
To collapse a node of an outline view means to hide the subitems of this node.
The sign to the right of the item's icon indicates than this item may be expanded.
The sign indicates that the item is expanded and may be collapsed.
To expand an item in the outline view, do one of the following:
• Left click the item's icon or the sign
• Select the item and click on the right arrow key on the keyboard
• Select Expand from the item's shortcut menu
To collapse an item in the outline view,
• Left click on the item's icon or the sign
• Select the item and click on the left arrow key on the keyboard
13.4.1.10.
Inspector view
A data object may be shown in different aspects (views)
Inspector view shows the parameters, variables, and connections in NMF equation objects
and macro objects.
The Inspector Status dialog box allows selecting what information should be included in the
inspector view.
The inspector view consists of 4 tabs: Variables, Parameters, Interfaces, and Balance.
Variables tab

Shows the variables in the selected object.
The following options may be selected in the Inspector Status dialog box:
• Show variables in interfaces
Include the variables that belong to interfaces.
• Show variables not in interfaces
Include input and output variables that that does not belong to any interface.
• Show local variables
Include the NMF "local" variables.
• Show assigned states
Include the NMF "assigned states" variables.
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• Show only given variables
Show only the variables that are assigned in IDA Modeler
• Show descriptions
Show the NMF descriptions of variables.
Parameters tab

Shows the parameters of NMF components of the selected object.
The following options may be selected in the Inspector Status dialog box:
• Show parameters in equation objects
Include the parameters that that are defined in NMF code.
• Show parameters added by IDA Modeler
Include the parameters that are defined in the IDA application.
Interfaces tab

Shows the interfaces and connections in NMF components annd macro components of the
selected object.
The following options may be selected in the Inspector Status dialog box:
• Show connected interfaces
Include the connected interfaces and connections.
• Show free interfaces
Show the interfaces that are available for connections
• Show void references
Show the interfaces in macro object that are not connected to any object inside the macro.
Balance tab

Shows the balance between the number of equations and variables in the selected object and
its components. The balance of the whole system should be equal to 0.
The balance of a component is calculated by formula
Bal = In - Exp - Giv - Conn/2
where
In
is the internal balance of the object i.e., the difference between the number of equations and
variables in the object
Exp is the number of variables exported to the parent object.
Giv is the number of variables whose values are given via bindings or causal connections
Conn in the number of variables that are connected via acausal connections
13.4.1.11.
Dialog View
A data object may be shown in different aspects (views)
Pop-up dialogs are used as views of objects with complicated internal logic and for object
that requires special protection against accidental changes. The dialog may be either built-in
or based on a form.
The changes made in a dialog view take effect when the user clicks on the OK button. All
changes are discarded if the user clicks on Cancel.
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13.4.1.11.1.1.

13.4.2.

Dialog Example

View Options

13.4.2.1.
Scaling
The picture in a graphical view may be scaled in several ways:
No scaling
Auto scale
Scale to 100%
Full page
Fit one side

The picture is not scaled. This is best for editing because scaling
may distort the picture. On the other hand, the size of picture
without scaling depends on the screen resolution.
The picture is scale to 75-100% in order to fit in the window.
The picture is scaled in order to compensate the screen
resolution. Unfortunately, the information about the resolution is
not always correct.
The picture is scaled in order to fit in the window. It is rescaled
every time the size of the window is changed.
The picture is scaled in order to fit in the window’s height or
width. It is rescaled every time the size of the window is
changed.

All these alternatives are available via the View menu in the menu bar.
The scale may also be changed temporarily by zooming and unzumming.
13.4.2.2.
To Zoom in
To zoom in the selected document do the following:
1. Select the View | Zoom in menu item
2. The cursor is transformed into
dragging and releasing

and the desired area (rectangular) may be selected by

The selected area occupies the whole window.
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13.4.2.3.
To Zoom out
To zoom out the selected document do the following:
1. Select the View | Zoom out menu item

The previous display mode (before zooming) is restored.
Alternatively, you can select one of the display modes: No scaling, Scale to 100%, Full page,
or Fit one side.
13.4.3.

Refreshing the view

The direct changes in the objects are reflected immediately in all views of the object. The
views may however have indirect dependencies (via connections, bindings, parameter
mapping etc.) that are not automatically updated.
To refresh the picture in the window,
1. Select the View | Refresh menu item

13.4.4.

To print, copy, or save a view

The contents of any window may be printed, copied, or saved to file.
Depending on the printer driver used, the print operation may also store the graphical window
in a file, commonly in PostScript format (ps or eps). There are also drivers that store images
in Portable Document Format (pdf).
The graphical windows may also be stored as Windows Metafiles (wmf) or Enhanced
Windows Metafiles (emf), see To Save a picture. These files may be inserted in Microsoft
Office documents and other Windows’ applications.
The text-based views may be stored as text files.
13.4.4.1.
Printing a view
To print a document, do the following:
1. Select the view that is to be printed
2. Select the File | Print menu item
3. Input the desired printer driver and settings in the dialog box that is displayed
4. Select the OK button

Depending on printer driver, the view may also be saved to a file (usually in PostScript
format).
13.4.4.2.
Saving a view to a file
To save a view to a graphic file or the contents of a text view, do the following:
1. Select the view that is to be stored
2. Select the File | Save picture/text… menu item
3. Select desired file name.
4. Select the OK button
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The graphic images are stored in Windows Metafiles format (*.wmf) or Enhanced Windows
Metafile format (*.emf) and may be inserted in different Windows’ applications (e.g., in
Microsoft Office documents.)
The text-based views are stored as text files.
13.4.4.3.
To copy a view
A graphical view may be copied to Windows clipboard and pasted to a different Windows’
application (e.g., in Microsoft Office documents.)
To copy a view, do the following:
1. Select the view that is to be copied
2. Select the Edit | Copy picture menu item
3. Switch to the target Windows’ application.
4. Select Paste or Paste Special menu item from the Edit menu of that application.

13.4.5.

Graphic Print Options

In the Graphic Print Options dialog the user can select the default scale and the orientation
for printing graphic windows. These options are:
Scale options:
100%-scale
Window’s scale
Full page
Explicit
Orientation options:
Portrait
Landscape
Best fit

Print in the natural scale
Use the current window’s scale
Scale the picture to fit in the paper size
Type in the scale
The larger side of the paper is vertical
The larger side of the paper is horizontal
The larger side of the paper corresponds to the larger side of the
picture

Notes
1. These options are used for printing graphical pictures only. They are not applied to text
and outline windows.
2. Not all printer drivers support orientation.
3. The scaling is implemented independently of the printer driver. If you select the scaling in
the driver's properties dialog, it will be applied after the IDA Modeler’s scaling.
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Diagrams

13.4.6.1.
Diagram data
A diagram shows, in graphical form, data that consist of one or several data series. Each
series is an ordered list of pairs of numbers. The first number in a pair is an X-coordinate
(usually time); the latter is a Y-coordinate. The pairs are ordered so that X increases. Y is
considered as being a function of one variable. A plot line is a polyline that graphically
represents this function. Each numerical pair is represented as a point - the polyline vertex.
The graph consists of several segments that go from point to point sequentially from left to
right.
13.4.6.2.
Edit a plot line in a diagram
Diagram data can be editable or read-only. This is a diagram property written in the slot
Read-only. Data in a read-only diagram cannot be edited. For some diagrams the Readonly slot is available in the Diagram properties dialog, so its value can be changed, and
read-only data made editable. Other diagrams and theirs data are always read-only.
To edit a plot line one must:
a) Enter edit mode for this line.
b) Edit a dashed copy of the line.
c) Confirm the changes.
Here is a more detailed explanation:
(a) Double-click on a plot line to enter a direct edit mode for this plot line (double clicking
on a blank space opens a menu for selecting line for editing). A dashed copy of the plot line
must appear with all its vertices marked as little squares.
(b) During editing, change the dashed line, comparing it with the unchanged original plot
line. In fact a user changes point positions and sometimes changes a number of points,
while the dashed plot changes automatically in accordance. Each operation with a point
changes two adjoining segments on the plot line. The vertices of the plot line are sorted in
the increasing order of the horizontal coordinate. This sorting preserves during editing.
A point can be moved using the usual drag and drop technique. Each point, except for those
furthest to the left and right, can be freely moved within a rectangle between the two
adjoining vertices to the left and right, and between the upper and lower border of the
screen (e.g. far beyond the diagram). Only the points furthest to the left and right can be
restricted in their movement (if the left and right border of the data is fixed, e.g. for
Profile). In that case these two points can be moved only up and down. Be aware that the
diagram can only show a part of the entire plot line, so some vertices may be invisible (e.g.
furthest to the right).
To add a vertex just click on the desired spot. To remove a vertex click on it with the right
button and choose Remove point in the menu displayed. If the left and right borders of the
data are fixed, then the points furthest to the left and right cannot be deleted (except for the
case when the next point has the same X-value).
(c) To affirm the changes and return from edit mode click on the right button and select
Done, or press Enter.
13.4.6.3.
Diagram dialog
A diagram may be embedded in a dialog.
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It is common in this case that the dialog has two tabs to show the data: Diagram and Data.
The Diagram tab shows the diagram in a graphical form. Enter the plot line edit mode (see
Edit a plot line in a diagram) by clicking on the Edit button. The edit mode is quite the
same as in Edit a plot line in a diagram. The only difference is that there are a number of
buttons in the dialog, while in the direct edit mode the same options are provided with items
in the shortcut menu.
To affirm the changes and return from edit mode click on the Done button.
The Data tab shows the time series data as a table. One can browse through the table and
change coordinate values directly as numbers. The Add and Delete buttons are used to add
and remove rows in the table.
13.4.6.4.

Diagram Properties

To open the Diagram Properties dialog,
1. Selects the diagram or the diagram’s legend.
2. Select Properties... from the Object menu or from the shortcut menu
The Diagram Properties dialog consists of two tabs: General and Variables.
The General tab controls the general properties of the diagram and legend:
Read-Only
Disables editing of the diagram data. If the diagram data are not intended for editing (e.g., are
calculated), this item is not available.
X-Range
Controls the data range along the horizontal axis (usually the time). Auto means include all
points.
The choice Use time slice is available for time series with Calendar time.
Y-Range
Controls the data range along the vertical axis. Auto means include all points.
Font
Select the font for the legend
Diagram type (for time series only)
Normal (detailed)
Show all points
Integral
Show the integral function of the time series. Note that the
values of integral functions have different ranges, measurement
units, and descriptions. Therefore Y-range and the legends and
scales for variables should also be changed to attain a correct
integral diagram.
Duration
Shows the duration diagram
Average
Shows the average value during hours, days, weeks and months
(for Calendar time only)
Weight schedule
The weight function for a duration diagram. Normally it is a 0-1 schedule, where 1 means the
counted time and 0 means the discarded time. For example, the schedule equal to 1 from 9:00
to 17:00 in the workdays may be used to restrict the duration diagram to the working time
only.
The weight diagram may have any value (not only 0 and 1). The weight is used as a
coefficient in the time counting. For example, lunchtime may be counted with coefficient 0.5.
The Variables tab controls the properties of data series
Select a row in the Data series box. The properties of that series will be displayed in the right
side of the dialog box:
Description
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Type the text in the legend or select Auto to use the description and the measurement
unit of the variable.
Line color,
Line style
Select the color and the thickness or pattern of the plot line
Adjustment
Select the scale and the offset of the plot line in order to fit in the selected Y-range. The
displayed plot line will have a y-coordinate equal to scale * value + offset. Remember to
mention the scale and offset in the legend (the Auto legend automatically includes this
information).
13.4.6.4.1.1.
Diagram Properties dialog

Diagram Properties dialog, general tab
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Diagram Properties dialog, Variables tab
13.4.6.5.
Graph ranges
The most common change of a diagram view is to zoom or zoom out a picture. As the
diagram "screen" is always of the same size, the user can zoom only a part of a graph. To do
this select a new, smaller range for the X-axis and an appropriate range for the Y-axis.
If X is time (the common case), select a standard period for a diagram: day, week, month or
year. Select Time slice in the Options submenu, and then in the Time slice dialog select a
suitable time period. The diagram will be redrawn automatically, both the X-axis and plot
lines. The X-axis will be supplied with appropriate tickmarks. Those are 24 hours for a day,
day of week for a week, day of month for a month and months for a year.
An entire simulation period can be different from the standard or selected period. So a part
of diagram that is not covered with data will be empty.
Entire simulation period in Time slice dialog can also be selected. This opportunity
facilitates entire plot lines fitting the diagram width exactly. But X-tickmarks show hours
elapsed from the beginning of the year, which is rather inconvenient.
Selecting another time slice (or directly changing an X-range) makes plot lines expand or
shrink along the X-axis, while their height does not change. The Y-range is chosen
automatically so that the plot lines for the entire simulation period fit exactly. Then for
shorter period plot lines can’t go beyond upper or lower border, though there can be too
much waste space.
To make plot lines fill in the diagram screen from top to bottom you can change Y-range
directly. To do those open the General tab in the Diagram properties dialog and switch
the radio button in the Y-range group box to Fixed. This makes the min and max slots
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available. Change them as you wish. The same applies to the X-range when it is necessary
to change it directly. Click on OK to confirm changes and to exit the Properties dialog.
To restore the default ranges re-open the dialog and switch the corresponding radio button
to Auto. To restore time slice usage, restore the X-range radio button to Use time slice.
13.4.6.6.
Diagram Axes
The diagrams are created with two axes: the horizontal X-axis and the vertical Y-axis.
The horizontal X-axis shows the values of the independent variable (usually the time). If the
time slice is used, the tick marks depends on the current time slice: a day slice is divided in 24
hours, a week and a month are divided in days, a year is divided into months. For “entire
simulation period the tick marks show the hours from the beginning of the year.
If the time slice is not used, the tick marks are selected automatically using the selected Xrange. The user can select the number and format of tick marks.
The vertical Y-axis shows the values of the dependent variables (with possible scale factor
and offset, see Adjustment in diagram properties).
Axis properties dialog

To open the Axis Properties dialog,
1. Selects the axis.
2. Select Properties... from the Object menu or from the shortcut menu

The Axis Properties dialog contains:
Axis text
The text to be displayed at the axis’ arrow
Font
The font for the axis text and tick marks
Color
Select the color of the axis and text
Tick marks
The approximate number of tick marks on the axis. The actual number of tick marks
may slightly differ from the proposed one, depending on the range of the variable.
Scale factor
The labels of the tick marks are multiplied by this factor
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Reports

A report is a textual description of the IDA system or some part of system. IDA Modeler
may generate a report about any data object in any IDA system.
To get a report, do one of the following:
1. Open the desired data object
2. Select the Tools | Report menu item

The reports are shown in a textual Report view. The user can print the report or save it in a
text file.
In the current version of IDA Modeler, the size of text windows is limited. For large reports
the user is prompted to save the report to a file. The file is open using Microsoft Notepad.
This default report looks like an outline view (except the reports for plot files that look like
tables). The applications may define special formats for some data objects.
There is also a special type of data object, the report object, which is specially designed for
reports.

13.5.

Advanced features

This section describes the advanced features that may be implemented in applications. They
are described here from the user’s point of view. The Customizing the application section
describes the same features, but from the point of view of the application’s designer.
13.5.1.

Resources

A resource is a data object that stores the common parameters for other data objects. Unlike
other components, the resources are not interpreted as parts of the containing object.
Example 1. A building can contain the resource Concrete (of type Material). This does not
mean that there is some amount of concrete in the building. This means that Concrete may
be used as a material for any wall layer, for any wall in the building. If a change is made in
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any of the parameters of the object Concrete it is changed in all places where the object
Concrete is used.
Example 2. A building contains the resources “Big Window and “Small Window (both of
type Window). When the user wishes to insert a window in some wall of the building, the
“Insert new object dialog will suggest three variants (types) of windows: “Window, “Small
window and “Big window.
The parameters of the resource object “Big Window are used as the default settings for
windows of type “Big window. If some of these parameters are changed, the corresponding
parameters in the real window are given new default values. This will lead to a change in
the actual values for parameters that are marked as using the default value (cyan
background).
IDA applications contain templates for all possible components in the IDA systems.
The resources can be stored in a database.
13.5.1.1.
User-defined resources. Scope of resource.
Every IDA application provides templates (object types) for all components and resources.
These are part of the application and are not stored in the IDA systems. The user cannot edit
the built-in templates, but can instead create the private templates (object types), available
only in the system or component. The private templates are stored within the system.
The resources loaded from the database are also stored within the system. So, the saved IDA
system does not depend on the database.
The scope of the resource is the component where the resource is available. The default scope
for all resources is the whole IDA system.
13.5.1.2.

Form for IDA resources

To display this form, select Tools | Show IDA resources menu item. The main form of the
IDA system may also contain a button to show resources.
The form contains the IDA-resources currently used or those that have been used previously
in the IDA system. If, for example, a medium heavy floor is chosen for floor somewhere in the
building model, the IDA resources Medium heavy floor, Cement, Light cement and Linoleum
will appear on the display.
A change made in an IDA resource, in a building model, applies to all the areas of the
building model where the resource has been used. If, for example, the density is changed for
the IDA resource Cement from 2300 kg/m3 to 2400 kg/m3, this change will influence all the
walls and all the floors in the building model containing Cement.
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Resource parameters

Resource parameters are a special class of parameters. The value of a resource parameter is a
pointer to a resource. So, the use of the resource parameter is equivalent to the use of
resource. The resource parameters are included in the contents of the components that use the
resource.
This value is displayed in the screen forms using the combo-box dialog item. The combo-box
range contains all resources of the same class available in the system. The last entry in the
range, "Search in database…", is used to load a new resource from the database. When it is
selected, the Insert resource dialog is displayed, allowing any compatible resource from the
database to be inserted in the system. The user can select the database entry, the name of the
new resources and the scope i.e., the component of the IDA system where the resource will be
available.
13.5.1.4.

Creating a new resource

A resource is automatically created when it is used for the first time. To create a resource the
user must instruct IDA Modeller that a new resource is desired. This can be done in different
ways:
The way to do this, depends on how the resource is to be used.
New resource, method 1: a new resource as a copy of an existing one
1. Select a resource or resource parameter of the desired type. From the shortcut menu, select
New resource…
2. In the New resource dialog select the name, template and scope for the new resource. A
copy of the selected resource is created.
3. If required, edit the resource.
New resource, method 2: Edit dialog and Save as...
1. Open the resource or the resource parameter with a dialog (not all resources allows this).
2. Edit the resource.
3. Select the button Save as….
4. In the New resource dialog select the name, template and scope for the new resource.
New resource, method 3: creating new object type.
1.

Select a component. From the Shortcut menu, select the Convert to resource… item.

2.

In the New resource dialog select the name, template and scope for the new resource.

3.

The new resource is now used as an object type of the selected component. More objects
of the same type may be inserted.

New resource, method 4: copy/paste
1.

Copy to clipboard (or drag with mouse) an existing resource from any system (of the same
IDA application) or a database object of the corresponding type.

2.

Paste (or drop) the resource to the desired scope.

3.

If required, edit the resource.
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13.5.1.5.
New Resource dialog
The New Resource dialog is displayed when the user actions require creating a new resource
object. This may happen in two cases
• The user selects an object and chooses the Convert to resource... menu item from the
object's shortcut menu.
• The user selects a resource and chooses New resource... from the resource's shortcut
menu.
The dialog allows user to select the name, type and scope of the created resource.
Two other fields, type and scope are rarely used.

Create New Resource dialog
13.5.2.

Using a Database

An IDA application may use a database to store typical examples of data objects. The
selection of entities that may be stored in the application’s database is however fixed within a
specific IDA application.
In forms and dialogs, whenever the user is prompted to select between the previously used or
defined data objects, there is also an option to load a new object from the database.
A database consists of a standard part provided by the application, and a user's part. In the
latter the user can store the objects that are of interest in other projects as well.
Please note, that any IDA system stores copies of all inserted data objects, so that any changes
made in a database do not affect any previously defined IDA systems.
To open a database, select the Tools | Database menu item. This selection is only possible in
applications that use a database.
The database is displayed in outline view.
13.5.2.1.
To load a resource from a Database
Method 1: using menus
1. Select a resource or resource parameter of the desired entity. From Shortcut menu, select
Load from database…
or Select Search in database from the list of available values of a resource parameter.
2. In the Load resource from database dialog select the database entry and the name,
description, and scope for the new resource. Press OK.
3. If required, edit the resource.
Method 2: copy and paste
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1. Open the database and select the desired object.
2. Copy the object from the database and paste it to the desired scope
or drag the object from the database and drop it to the desired scope.
3. If required, edit the resource.
Method 3: using the Insert Object dialog (only for resources used as object types)
1. In the Insert Object dialog (see inserting components) select the desired entity and press
the Database button (this button is only available for entities intended for database
storage).
2. In the Load resource from database dialog select the database entry and the name,
description, and scope for the new object type. Press OK.
13.5.2.2.
Load Resource dialog
The Load resource from database dialog allows the user to select the appropriate database
object and insert it as a resource in the active IDA system.

Load Resource dialog
Select template

Select a database entry to be used as a template for the new resource

Name

The name of the created resource.

Description

The description of the created resource.

Available in

The scope where the resource should be available. Usually the
complete IDA system

13.5.2.3.
To save resource to database
Method 1: using menus
1. Select the resource or a resource parameter that points to the resource.
2. From the Shortcut menu, select Write to database.
Method 2: copy and paste
1. Select the resource.
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2. Open the database.
3. Copy the resource and paste it to the database
or drag the resource and drop it in the database.
13.5.3.

Parameter mapping

The value of a parameter may by
• user-supplied
• default, i.e. bound to the value of the corresponding parameter in the template;
• invoked, i.e. assigned by IDA Modeler;
• mapped, i.e. bound to the value of some other parameter (master parameter);
• calculated, i.e. dependent on the values of other parameters.
The dependent values are changed automatically when the master values are changed (except
the invoked values, which are recalculated all together on user request).
The user can freely change the user-supplied values. For dependent values some restrictions
may be introduced:
• The value may be non-editable
• The change of the value may change the master’s value
• The change of the value may break the mapping (this is the default action)
• The user may be asked to select from the previous three cases.
If the mapping is broken, the value is treated as user-defined.
The background color of the parameter’s field show the mapping mode of the parameter:
user-supplied value
default value
invoked value
mapped or calculated value
the value was mapped, calculated, or invoked. The mapping is broken
The mapping may be changed using the Mapping submenu of the Right Button menu. It
contains the following items concerning the mapping:
Edit link
open the mapping dialog
Break link
break the mapping, so the value will not change if the master’s value is
changed
Restore link
restore the broken mapping. The value is also recalculated.
Default link
set the default mapping. The default mapping is:
• invoked – if the parameter was generated with invoked mapping;
• mapped or calculated – if the prototype parameter is mapped or calculated
• default – if the prototype’s value is default or user-defined
• user-defined – if the parameter has no prototype
• Show master – Display the form containing the master parameter.
In case of vector or matrix parameters, only the operation Break link, Restore link and Show
master may be applied to the elements of array.
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Editing forms

IDA applications provide forms for most types of data objects. A form consists of a fixed
number of fields that may be filled by the user (as in a paper form).
In some cases the form does not contain all the parameters of the data object, but only a
selection. An experienced user may have a different opinion on which parameters to be
dipsplayed. To change the parameter selection, edit the library forms.
The user may also design forms for user-defined object types, please see To edit a form for
user-defined object type.
13.5.4.1.
To edit a library form
1. Ensure that you have write permissions in the application directory.
2. Ensure that the option Options | Editable forms is selected.
3. Open an object of the required type in the required view (e.g., Form, Geometry).
4. Edit the form by adding or editing fields and other graphical elements. See the section
Graphical editor for details.
5. Save the form.
13.5.4.2.
To edit a form for a user-defined object type
1. Save the system that contains the user-defined type to a file (e.g., d:\dir\system.idm).
2. Ensure that the option Options | Editable forms is selected.
3. Create an object of a defined type (i.e., insert such an object where it is possible).
4. Open the object in the required view (e.g., Form, Geometry).
5. Edit the form by adding and editing fields and other graphical elements. See the Graphical
editor section for details.
6. Select the File | Save form as... menu item and save the form in file
d:\dir\system\type.idc, where type is the name of the user-defined type.
13.5.4.3.
Saving a Form
To save a form, do as follows:
1. Select a window that uses the form
2. Select the File | Save form menu item

Note that only the form of the selected view is saved. No IDA systems or data are saved by
this operation.
13.5.4.4.
Saving a Form with a new Name
To save a form under a new name, do the following:
1. Select a vindow that uses the form
2. Select the File | Save form as... menu item
3. Select a directory in the dialog box
4. Input a file name
5. Select the OK button

13.5.4.5.
Changing the Properties of a Form
To change the properties of a form do the following:
1.

Select the File | Form Properties menu item

The dialog box Form Properties is displayed. It allows a change of the form’s size and
description.
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Click the Calculate button to calculate the form size using the form's contents.
The changes made are applied to all views using this form.

Form Properties dialog
13.5.5.

Reports

The report contains a textual description of IDA system or some part of system. IDA SE may
generate a report about any data object in any IDA system. This default report looks like an
outline view (except the reports for plot files which look like tables).
The applications may define special formats for some data objects.
There is also a special type of data objects, report object, which is specially designed for
reports.
See also Reports in applications
13.5.6.

Calendar Features

The IDA applications may use either a Real time scale (where the time is measured in seconds
or other fixed units) or the Calendar time scale, where the time is measured in hours, days,
weeks, months, and years.
This section describes the features available for the applications with the calendar time scale.
13.5.6.1.
Schedules
A schedule object describes a calendar-dependent periodic variable.
Schedules may be opened as dialogs (this is the default view) or as diagrams.
There are two dialogs for the schedules: Basic Schedule dialog for simple schedules, and
Advanced Schedule dialog for general schedules. Both dialogs are used to edit the
parameters of schedules.
The diagram view is read-only. It shows the time evolution of the scheduled variable, i.e. the
result of the schedule´s description..
Simple schedule

In the simplest case, the value of the schedule is
• a given value (default is 1) every day from the given start time to the given stop time
• otherwise zero
Note that the start time may be after the stop time (for night-time-on schedule).
All the listed values may be entered in the Basic Schedule dialog. The dialog has also the
Advanced... button for switching to the general schedule.
General schedule

A schedule consists of a list of schedule rules. Every rule describes the values of the variable
during the 24 hours. A set of conditions determines if the rule is valid for the given day. The
last rule should always be valid. The value of the schedule at the given time is the value of the
first valid rule.
The general schedule is opened with the Advanced Schedule dialog.
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In the left side of the dialog, there is a list of schedule rules. Use the buttons near the list to
add, remove and reorder the rules. The first rule in the list has the highest priority. The name
of the selected rule is displayed separately and may be edited.
At the right side of the dialog, the settings for the selected rule are displayed. The Daily
schedule section describes the rule values, while the Valid days section describes the
conditions for the rule.
The Daily schedule may be given as Constant, On/Off, and Profile. Press the corresponding
button to select the alternative.
For the Constant alternative, type the desired value in the Value field.
For the On/Off alternative, select the start time, stop time, and two values: On-value
and Off-value. The value of the rule will be the on-value between start time and stop
time, or otherwise the off-value.
For the Profile alternative, the value of the rule is given as a profile, that is a 24-hour
time series. To select a profile, either select one of the profiles available in the system, or
press Load to load a profile from the database (see To load a resource from database), or
press New to create a new profile (see To create new resource).
Press Open to look at or edit the profile.
The profiles are resource objects, so several rules and schedules may use the same
profile.
The Valid days may be restricted in two ways:
The rule may be restricted to selected weekdays by using the weekday check boxes.
The rule may be valid from Start date to End date (including the given dates). The
format of the date is mm-dd (for example 02-23) or yyyy-mm-dd (e.g., 1998-10-28). If
no years are supplied, the rule is valid for any year. Note that the start date may be after
the end date (without years) in order to include the New-Year day. If no start date is
supplied, the rule is valid from the beginning of the year. If no end date is supplied, the
rule is valid to the end of the year. The Calendar... buttons may be used to select the
desired date from the Calendar dialog.
13.5.6.2.
Profiles
A profile is a 24-hour time series.
Profiles are resource objects and may be stored in database.
Profiles are used in schedules.
The profiles may be opened from the Advanced Schedule dialog or from the list of IDA
resources.
The profiles are shown with diagram dialog.
13.5.6.3.
Calendar Parameters
The Calendar parameter value is a calendar date. When included in a form, calendar
parameters are displayed as year-month-day, weekday. The default view of the
calendar parameter is Calendar Dialog. This dialog is used to edit the value of calendar
parameters.
13.5.6.4.
Calendar Dialog
The Calendar dialog is used to select a date.
The year and the month are selected in the corresponding fields at the top of the dialog.
The day is selected from the calendar pane.
The result is displayed in the field at the bottom of the dialog. The Date includes year check
box controls whether or not the result should include the year. This box is disabled if the
format of the result if predefined.
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Press OK to confirm the choice of date. The selected date will be inserted in the field from
which the dialog was started.

Calendar dialog
13.5.6.5.
Time Slice
The time slice is a globally selected time period that may be used in diagrams and reports.
The time slice feature is implemented for Calendar time applications only.
To select the current time slice, select the Options | Time slice... menu item and select the
desired alternative in the Time slice dialog:
Date
Select the desired day, month, and year or press the Calendar... button to
select from Calendar dialog.
Week
Select the desired week and year.
Month
Select the desired month and year
Year
Select the desired year
Last day of simulation
The last day of simulation period given in the Simulation
Data is used as the time slice date.
Entire simulation period The slice period is the whole simulation period given in the
Simulation Data.
All diagrams that use the time slice are redrawn after a change of the current time slice.

Time Slice dialog
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Multi-language support

13.5.7.1.
Selecting Language in the Program
To select a language in the program, do the following:
1. From the Window Menu, select Language
2. Select the desired language from the displayed list

All texts in the program are changed in accordance with the selected language.
13.5.8.

Batch mode

To run the IDA SE from the command prompt or from a batch file, type the command
path\idamod.exe command
Here is the list of available commands (the optional parts are enclosed in square brackets []):
[-O] file[.idm]

open a file (the key is optional)

-N app doctype [file[.idm]]
create a new document of given type
and with given IDA application. The optional argument file
gives an alternative template file.
-R file[.idm]

run file in the interactive (normal) mode

-B [logfile] files

run files in the batch mode.

In batch mode, IDA SE writes all messages to a log file rather than to the log window.
The list of files in batch mode may contain names with wildcards * and ? (in the file name
only).
It may also contain references to response files in the form @file (without wildcards). The
response file should contain a list of files separated by white space (space character, tab
character, or line break).
The first file in the list of files is treated as the name of the log file, if it has an extension not
equal to .idm.
Otherwise the name of the log file is generated from the first file by changing the extension to
.log. If the first name contains wildcards, the name of the log file is idamod.log.
The file names may be enclosed in double quotes. This is required for names containing space
characters.
The space character after keys -O,-N, -R and -B is optional.
13.6.
13.6.1.

Graphical Editor
Types of graphical elements.

All graphical elements are divided into classes: object's symbols, connection lines, fields,
buttons, shapes and text.
Component’s symbols represent the components of the system. Inserting or removing a
symbol is equivalent to adding or deleting a component (there is one exception: the symbol
that represents the system itself).
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A connection line represents a connection between two components. Adding and deleting a
connection line between two symbols will result in connection or disconnection of the
corresponding components.
Fields provide access to the values of the variables, parameters and other information in the
system. Adding and deleting fields do not affect the structure of the system.
Buttons provides access to different tools.
Shapes and text elements have no connection to the system. They are used as titles, help
information, illustrations, etc.
13.6.2.

Object Symbols

An Object Symbol is a graphical representation of a data object in the schema and editor
views.
Inserting and deleting the symbols is equivalent to inserting and deleting the corresponding
data objects.
In the schema, the symbols may be connected. This is interpreted as a connection between
data objects.
In the editor view, the size and the position of the symbol determine the parameters of the
object. The change of the position or the size will be interpreted as a change of the
parameters.
Double click on the symbol to open the corresponding object.
13.6.3.

Connection Line

A connection line represents a connection between two models (or more precisely, between
two interfaces in the models).
Double click on the connection line to see the connected interfaces.
Delete the connection line to disconnect the interfaces.
The connection line connects the object symbols of the two modules. The line may be edited
as an ordinary line.
13.6.4.

Shapes

Box-type shapes

The following elements are edited by selecting them and dragging one of the handles at the
objects border (see Moving and reshaping). Some of the elements have special points for
editing the parameters.
Box
An area with it’s sides parallel to the page’s sides.
Rounded Box
A box with rounded corners. Moving the handle placed in the center of the bottom-right
rounding ellipse changes the radii of the rounded corners.
Circle
Can only be resized proportionally.
Circle Arc, Circle Sector
Two handles show the start and the end of the arc. Selecting both handles (use the Shift
key), the arc can be rotated.
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Ellipse
A supplementary handle shows the focus of the ellipse. When dragging the focus, the
ellipse is rotated and reshaped (with area unchanged).
Line-type shapes

The following element are edited by adding, moving and deleting their vertices, as is
described in Editing the line.
Point set
Point set is a set of points (filled circles) with the same color and thickness.
Polyline
Polyline is a set of linked segments with the same color and style.
Polygon
Polygon is either closed polyline or a filled region bounded by this line.
Arc (not implemented yet)
A circle/ellipse arc with two given endpoints and one point inside the arc. First, a circle
arc is drawn. It is changed to an ellipse arc if the bounding box is resized. The arc of the
rotated ellipse is not implemented yet.
Plot line
Plot line is a polyline that graphically represents a function of one variable. The vertices
of the plot line are sorted in increasing order of the horizontal coordinate. Plot lines may
only be inserted in diagram fields.
13.6.5.

Text elements

Three styles of text objects are Text, Header, and Label. They differ in the default attributes
only. The text objects may be outlined; the background may be either transparent or colored.
The fourth type of text object is Frame box with heading. The difference from other text
objects is that (a) the frame box is outlined by default and (b) the text is written over the top
side of the outlining box.
Editing a text element

To start editing a text object, double click on it or select Edit from the Shortcut menu .
The text is edited as in text editor, with one exception: press Ctrl+Enter rather than Enter to
break a line. Copy and Paste is available, including the possibility to copy text from or to
other Windows applications.
To end editing, press Enter or click outside of the editing object.
To discard editing, press Ecs key.
13.6.6.

Fields

A field is an interface to the system’s data. A field can show the values, names, status, and
properties of parameters, variables and other objects in the system. The fields can be edited
but also moved or resized as graphical objects.
A user-supplied help information is displayed in the status bar when the mouse cursor enters
the editable area of the field.
Note that adding a field does not add a new variable.
13.6.6.1.

Field types

Slot Field
228

IDA Indoor Climate and Energy 3.0

EQUA Simulation AB 2002

Shows and allows editing of any simple value, as numbers, names, text, switches. The
slots are implemented as Windows’ dialog items. The appropriate item class is selected
automatically, depending on the mode of editing the value: read only, input by typing
(with restricted range of values), selecting from a list, switching. For slots use for input by
typing, the user can supply an error message that is displayed in case of range violation.
Quantity Field
Shows the name, value (either initial or current) and measurement units of a variable or
parameter. The value may be editable. For arrays of parameters or variables, the
dimension is displayed instead of the value. Double clicking on the slot (outside the
editable area) will open a window with details.
The user can supply a help message that is displayed in the status bar and an error
message that is displayed in case of value range violation.
Table
Shows the values of array elements.
In the current version implemented only for arrays of points.
Interface Field
Shows the name and the connection of an interface. Double clicking opens more details.
For vector interfaces the dimension is shown.
Diagram
Shows the graphics of a time-dependent variable (or a list of variables). The user can
select the scale and the line style and color for every graphic. The diagram may be
editable.
List
Shows a list of data elements (e.g., list of all interfaces in a model). The user can select an
element from the list and work with this element. See List Fields.
Outline
Shows the structure of a selected data element (as in outline view). The user can navigate
in the structure and work with its members.
Subform (Shortcut, Icon)
Shows an icon representing the selected data element. A separate view is open when the
user double clicks the icon.
Sketch
Shows the structure of a selected data element. Double clicking on a detail of the sketch
opens the corresponding subobject.
Menu button
A button with pointer picture. Displays object’s menu when pressed.
13.6.6.2.
List Fields
List field is a special class of field elements designed to show a list of components of a certain
class (e.g., all interfaces in an equation object).
You can select an element from the list and work with it:
• Double click on or press the Enter key to open the element;
• Use the commands from the Edit and Object menus
• Right click or press Shift+Enter to open the shortcut menu. This menu contains commands
appropriate to the pointed element. If no element is pointed, the shortcut menu contains
commands appropriate to the List field itself.
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• Drag the element to copy it to some other place
• Press the Delete key to remove the element
• Press the arrow keys to change the selection
To select the field itself, click at the border of the field. In this way you can copy the field, move or
reshape it, change the graphical attributes, replace or remove the field.

13.6.7.

Button

Performs user-defined actions when pressed.
See also Graphical attributes, Button Properties dialog.
13.6.8.

Insert a new Element into a Document

To insert a new element into the edited document do the following:
1.

Select the element from the Insert Menu: Object, Field, Text, Shape, or Button. A dialog
normally appear.

2.

If a dialog is displayed, select the desired type of new object from the dialog and press the OK
button (the dialogs for inserting objects and fields are more complicated, see Insert Component
Dialog, Insert Field Dialog for details).

3.

If the cursor in the document changes its form to
selected object.

4.

For the Text class one must also type in a string. The cursor (vertical line) shows where to
begin. Press Enter to end typing. See Text elements for details.

, choose a place, a size and a form for the

These are typical steps. Sometimes they can be different.
2a) If there is no choice of type (i.e., objects of a single type may be inserted) step 2 is skipped.
3a) For lines (polyline, polygon, and arc) step 3 is completely different; see Editing the line.

Insert Text dialog

Insert Graphics dialog

13.6.8.1.

Insert Field Dialog

The Insert Field dialog is used for inserting new field in a form and for replacing an existing
field with a new one.
The dialog contains two boxes: Data Outline box and Field Type box.
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To insert a field, do the following:
1. Navigating in Data Outline, select a data object to be displayed in the new field.
2. From the Show As dialog box chose which aspect of the object should be shown, e.g., an
attribute (e.g., name, value), or a section in the contents of an object (e.g., parameters,
variables). An appropriate field type will be selected automatically.
3. Select the OK button

Insert Field dialog
13.6.9.

Graphical attributes

Various graphical attributes can be assigned to any graphical element.

To edit the properties of a graphical element in the selected document do the following:
1. Select the Properties of the graphical element to be edited
2. Select the Object | Properties... menu item
or select the Properties... menu item from the object’s Shortcut menu,
3. Complete the displayed dialog and click on the OK button.
The dialog is different for different types of graphical elements:

13.6.9.1.

Element Properties dialog

The Element Properties dialog is used to change the graphical attributes of a component's
symbol, shape and text element.
The content of this dialog depends on the type of graphical element:
Symbol - selecting and rotating an icon.
Shapes - selecting line options as thickness, pattern and color and fill options as pattern and
colors.
Text - editing the text (line break is shown as \\), text attributes (font, size, color) and
attributes of the outlined box.
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Example of Element Property dialog
13.6.9.2.

Field Properties dialog

The Field Properties dialog is used to change the graphical attributes of the selected field.
The dialog allows selecting
• text style (font, size, color)
• numerical format (for numerical fields only).
• read-only option
• text strings associated with the field (label, help message, error message, etc.)

Field Properties dialog
13.6.9.3.
Button Properties dialog
The Button Properties dialog allows selecting
• The command to be executed when user clicks the button (see scripts)
• Text of the label and help message
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• The font for the label

Button Properties dialog
13.6.10.

Reading the cursor

The cursor consists of 1-3 pictures: one main and two supplementary. The shape of the cursor
shows the possible mouse operations, as indicated in the following tables:
Picture
Shows the possible action on ...
Main
click on mouse button
Left supplementary
double click on left button
Right supplementary drag with left button pressed
Main picture: action on click
The cursor points to background or some object.
Click left selects the pointed object or deselects all
objects (with Shift add to selection or remove from
selection).
Click right opens the pane’s or object’s pop-up menu.
Context help
A new point is expected.
Click left enters the point.
Click right pops up the editor menu

Left supplementary picture: action on double click left button
Open the object
Start editing
Start a connection
Right supplementary picture: drag action
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Move the element(s)
Reshape the element(s) by the border
Reshape the element using a handle
Enter a box
13.6.11.

Selection

Selecting an object (or several objects) is a first step of editing operations. The selection is the
list of currently selected objects in the active window. Handles mark the selection in a special
color. The selection may be moved, reshaped, copied.
• To select a single graphical element, move the cursor over it and click on the left mouse
button. (For editable fields: pointing inside such a field will select something in the
contents of the field; to select the field itself, point at the field’s border).
All other elements in the window are deselected.
• To select an element behind the selected one, click the left mouse button with Ctrl key
pressed. All elements under the cursor will be selected in turn.
• To add or delete one element to/from the selection, hold the Shift key pressed while
pointing the object.
• To select more than one element at once, press the left mouse button on a free space and
draw a rectangle around the objects by dragging the mouse. Now release the button and
the new selection will consist of all objects that are completely inside the rectangle.
• To add or delete several elements to/from the selection, hold the Shift key pressed while
drawing a rectangle around the objects. All objects inside the rectangle will be added to
the selection (unless they were all already selected, in which case they are deselected).
• To deselect all elements, click the left mouse button on a free space or inside some
editable field.
• To select an object from a list or outline, point it with the mouse and click on the left
mouse button. It is not possible to select more than one object in a list or outline.

13.6.12.

To move or reshape graphical elements

To move an element
1.

Move the mouse cursor over the element.

2.

Press the left button.

3.

Drag the element to it’s new position.

4.

Release the button.

To rotate the element, move it with the Alt key depressed.
To cancel moving, click Esc key before releasing the mouse button.
To move more than one element at once,

1. Select all elements.
2. Move the mouse cursor over one of the selected elements.
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3. Press the left button.
4. Drag the selected elements to their new position.
5. Release the button.
The connection lines are moved together with the connected component's symbols.
While the Shift key is pressed, movement is constrained to four directions, horizontal, vertical
and the two diagonals (relative to the initial position).
To resize or reshape an element

1. Select the element.
2. Move the mouse cursor over one of the handles on the surrounding rectangle.
3. Press the left button.
4. Change the shape or size of the element by mouse movements.
5. Release the button.
By simultaneously pressing the Shift key, the element will change it size proportionally to its
original size.
By simultaneously pressing the Control key, the center of the surrounding rectangle is fixed.
To cancel resizing, click Esc key before releasing the mouse button.
To resize or reshape more than one element at once

1. Select all elements.
2. Move the mouse cursor over one of the handles on the surrounding rectangle.
3. Press the left button.
4. Change the shape or size of the elements by mouse movements.
5. Release the button.
By simultaneously pressing the Shift key, the elements will change their size proportionally to
their original size.
By simultaneously pressing the Control key, the center of the surrounding rectangle is fixed.
13.6.13.

Copy, Cut, Paste and Delete

See also Drag and Drop.
The Copy, Cut and Paste operations use the Windows' clipboard.
What is copied?

The Copy operation copies the selected elements to the Windows' clipboard. The details
depends on what is selected:
1. One or more graphical elements. All selected graphics are copied. If there are
component’s symbols among the selected elements, the components are also copied. The
connection lines between the selected symbols are also copied.
2. A component in the list field or outline. The selected component is copied.
3. A value in a non-typable field. The value is copied.
4. A portion of text in a typable field or text element. The selected text is copied.
To copy one or more elements to the clipboard

1. Select the element(s)
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2. Choose the Edit | Copy menu item,
or press the Copy button on the toolbar,
or press Ctrl+Insert or Ctrl+C,
or point the mouse at one of the selected elements, press the right button and select Copy
from pop-up menu,
The connection lines are copied to the clipboard if both connected components’ symbols are
copied.
The graphical elements copied to the clipboard may be also pasted in other Windows’
applications (e.g., in Microsoft Office documents). See also To copy a view.
To cut (i.e., copy to clipboard and delete from window) one or more elements,

1. Select the element(s)
2. Select the Edit | Cut menu item,
or press the Cut button on the toolbar,
or press Shift+Delete or Ctrl+X,
or point the mouse at one of the selected elements, press the right button and select Cut
from pop-up menu,
To delete (without copying to clipboard) one or more elements,

1. Select the element(s) that are to be removed from the document
2. Choose the Edit | Delete menu item,
or press Delete key,
or point the mouse at one of the selected elements, press right button and select Delete
from pop-up menu,
To paste (i.e., insert) the contents of the clipboard:

1. Select the window to which the elements are to be pasted,
2. Choose the Edit | Paste item from the Edit menu,
or press the Paste button on the toolbar,
or press Shift+Insert or Ctrl+V.
(this happens only when copying from a list or an
3. If the cursor changes its form to
outline to a form), then show the position where to insert the selection.
To paste an element from the clipboard to a specific position:

1. Move the mouse cursor to the desired position. The position must be outside of any other
element.
2. Press the right button.
3. Choose Paste here from the pop-up menu.
13.6.14.

Drag and Drop

By using the Drag and Drop technique, one or more objects may be copied from one view to
another.
While the selected objects are dragged inside their own view, this is interpreted as graphical
movement. But when the cursor goes out of the source view, the dragging is interpreted as
attempt to copy the selected elements to another location.
It is possible also to drag an object from a list field or outline.
The cursor

shows the possibility of copying, while
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Place for inserted element

When the mouse cursor changes its shape to a cross with square, this means that IDA Modeler
is waiting for a directive on where to insert a new graphical element. The user can Press the
left mouse button at the desired place. A dotted rectangle will indicate a possible position.
Release the button if the position is suitable. If it is not suitable, change the size of the
rectangle by dragging. One corner always stays pinned (or the center - if Control key is
pressed). After the mouse button is released the dotted line disappears and the new element is
displayed in the window.
Exception: when an empty text element is entered, it is displayed in the editing mode as a text
cursor.
13.6.16.

Snap to Grid

In Snap to Grid mode, the positions of the corners of the graphical elements are aligned with
an invisible grid. This is made in order to facilitate the form design.
Snap to Grid affects the operation of inserting, moving and reshaping the graphical elements.
To toggle the mode, choose the Options | Snap to grid menu item.
13.6.17.

Edit lines

The IDA Editor provides five types of line-type elements: point sets, polylines, polygons, arcs
and plot lines (see Shapes) [arcs are not implemented yet].
A special mode is used for line editing. In this mode all mouse events are interpreted as input
for the line. All other graphical objects are unavailable. There is no possibility to edit two
lines at the same time (even in different windows).
There are two editing methods for polylines, polygons and plot lines: isotropic and
orthogonal.
The isotropic method (with Control key pressed): For lines with an arbitrary direction of the
segments.
The orthogonal method (with Shift key pressed): For lines with horizontal or vertical
segments only.
The default method (with neither Shift nor Control pressed) depends on the context. When
editing pure graphical elements, the default method is the isotropic. For connection lines the
default method is the orthogonal.
To start editing

Insert a new line (see Insert new element)
or
Move the mouse cursor over an existing line, press the right button and select Edit from the
pop-up menu
or
Double-click the line
To end the editing mode

Press Enter (this accepts all changes)
or
Press Esc (this cancels all changes)
or
Press the right mouse button and select any item from the pop-up menu:
• Done: accept all changes;
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• Cancel: rejects all changes;
• Delete: delete the editing line.
To add a vertex

1. Move the cursor to the desired location. The cursor must be a cross.
2. Press the left button and drag to a desired position.
While editing a polyline or an arc, the first inserted vertex will be added to the nearest endpoint. The
subsequent vertexes are added to the same end.

For polygons the point is inserted into the nearest segment.
For plot lines, the points are sorted in the increasing order of x-coordinate.
For arcs, only three points may be inserted.
When using orthogonal method, the previous vertex is moved in order to ensure the orthodirection of the new segment. If the previous segment is oblique, one extra vertex may be
inserted. For polygons, the orthogonal insertion is possible on an existing segment only (see
the next section).
To add a vertex inside a segment

A. Isotropic method or oblique segment
1. Move the cursor to the segment (the cursor will change shape to a cross with a point
inside).
2. Press the left mouse button. A new vertex will divide the pointed segment.
3. Drag the new vertex to the desired position.
4. Release the button
B. Orthogonal method and horizontal or vertical segment
1. Move the cursor to the segment (the cursor will change shape to

or

),

2. Click on the left mouse button. A new vertex will divide the pointed segment.
To move a vertex

1. Move cursor to the vertex until the cursor changes to an arrow.
2. Press the left mouse button and drag the vertex.
3. Release the button
You must drag at least at the distance equal to the size of the sensitive point. Otherwise your
action will be considered as clicking and the point will be deleted (see To delete a vertex)
To cancel moving, click Esc key before releasing the mouse button.
When the orthogonal method is being used, the vertical and horizontal segments adjacent to
the moving vertex are also moved. Extra vertices may be inserted. The oblique adjacent
segments are changed as in the isotropic method.
To move a segment (only for orthogonal method and horizontal/vertical segment)
1. Move the cursor to the segment until it changes shape to
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2. Press the left mouse button.
3. Drag the segment.
4. Release the button.
To delete a vertex

1. Move cursor to the vertex until the cursor changes to an arrow
2. Click on the left mouse button.
Deleting a non-terminal vertex means replacing the two adjacent segments with a single
segment. This is not possible for the orthogonal method (unless the adjacent segments have
the same direction, either horizontal or vertical). Two segments are inserted in this case, one
vertical and one horizontal. There are two possibilities to do this; they are used in rotation.

13.7.
13.7.1.

User Interface
The Main Window

When starting IDA, the first window to open is the Main Window. It may contain several
other windows. Each open window within the Main Window contains a document. One of the
open documents is always selected. It can be recognized by a special headline color. A
document is selected by clicking within its window.
The main window also contains the menu bar, toolbar and status bar.
In most cases, clicking within a window with the right mouse button will display the shortcut
menu containing alternatives suitable for the occasion.
13.7.2.

The Menu Bar

The Menu Bar displays all the available menus across the top of The Main Window below the
title bar. It contains the following menus:
File
Edit
View
Insert
Object
Tools
Options
Window
Help
13.7.3.

The File Menu

The File Menu contains various alternatives for managing the documents. These are
New...
Create and open a new document
Open...
Open a document from a file
Close system
Close the selected system or document
Save system
Save the selected system or document
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Save the selected system or document with new name
Save the form of the selected window
Save the form with a new name
For graphic views: save the image in the selected window in
Windows Metafile (wmf) or Enhanced Metafile (emf) format.
For text-based views: save the text to file
Open the Form Properties dialog
Select the graphical printing options
Print the contents of the selected window
Quit the IDA Modeler

In addition, the four documents most recently opened are easily within reach from this menu.
Choosing one of their file names opens the corresponding document.
See also Shortcut menu.
13.7.4.

The Edit Menu

The Edit Menu contains various alternatives for editing within a document. These are:
Cut
Delete the selected element(s) and put them in the clipboard
Copy
Copy the selected element(s) to the clipboard
Paste
Insert the contents of the clipboard to the selected document
Delete
Delete the selected element(s).
Replace...
Replace the selected element either with an element from clipboard or
with a new element.
Copy Picture
Copy the image of the current view to the clipboard
The following menu items are used for text windows only:
Find & Replace... Textual search and replace
Find next
Repeat the previous textual search
Replace next
Repeat the previous textual replacement
Go to line...
Move the cursor position to the given line
See also To select Objects.
13.7.5.

The View Menu

The View Menu contains various alternatives for controlling how an object is displayed.
These are:
Refresh
Redraw the selected view
Close
Close the selected view
Zoom in
Display a zoomed fragment of the selected view.
Zoom out
Revert the Zoom in operation
No scaling
Display the selected view without scaling
Auto scale
The picture is scale to 75-100% in order to fit in the window.
Scale to 100%
Display the selected view in the natural size
Full page
Display the whole view in the window (without scroll bars)
Fit one side
Display the selected view with one scroll bar (either vertical or
horizontal)
When the active window shows a data object, the View menu also contains two groups of
items that are links to other views of the object and to the object’s parents, i.e., objects
containing the one shown. You can open these views or objects by selecting them in the
menu. The current view is marked with a check mark.

240

IDA Indoor Climate and Energy 3.0
13.7.6.

EQUA Simulation AB 2002

The Insert Menu

The Object Menu contains various alternatives for managing the objects of a document. These
are:
New Object
Insert a new component in the object shown in the selected view
New field
Insert a new field in the selected view
New Text
Insert a new text element in the selected view
New Graphics
Insert a new shape element in the selected view
New Button
Insert a new button in the selected view
13.7.7.

The Object Menu

The Object Menu contains the main alternatives for managing the objects of a document.
These are:
Open
Open the selected object (with default view)
Properties
Edit the graphical attributes of the selected object
Edit
Edit the selected line, text or icon
Other alternatives may be found in the shortcut menu for objects.
13.7.8.

The Tools Menu

The Tools Menu contains various alternatives for managing the objects of a document. Some
tools are built-in in IDA SE, other may be defined in applications. Not all tools are available
for concrete IDA system. The built-in tools are:
Run
Simulates the system
Invoke
Checks the system and tries to set a well-posed problem
Show IDA Resources Opens the window showing the list of resources
Show source code
Open the NMF source code of the selected equation object
Choose Output
Pops up Choice of Output dialog
Diagram
Shows the results of simulation as a diagram
Report
Shows a report about the system and simulation
Database
Opens the database window
New application
Pops up the Install Application dialog (available in Development
Release only)
These functions always affect the system(s) that is currently selected.
See also:
To select Objects
Tools in applications
13.7.9.

The Options Menu

The Options Menu contains various alternatives. These are:
Toolbar

Display and hide the toolbar

Status Bar

Display and hide the status bar

Property Page

Enable and disable the property page

Language

Choose the language

Time Slice

Choose the time slice for diagrams. Available for
applications with a calendar-based time scale

Editable Forms

Allow editing forms

Snap to grid

Restrict the movement of the graphical element
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Settings for Inspector view

Display the dialog with options for Inspector view.

Plot lines with markers

Specify that the plot lines in diagrams should be marked.

13.7.10.

The Window Menu

The Tools Menu contains various alternatives for managing the windows of the program.
These are:
Cascade

Arrange the windows in cascade

Tile Horizontal

Arrange the windows horizontally

Tile Vertical

Arrange the windows vertically

Arrange Icons

Arrange minimized windows

In addition, all open windows are included in the window menu. A window may be selected by
choosing the corresponding alternative in this menu.

13.7.11.

The Help Menu

The Help Menu contains various alternatives for obtaining help about the program. These are:
Help topic
Display the help topic associated with selected object
Contents
Display the contents of the IDA Help. Press F1 for information on how to
use the Help Contents.
Search
Display the Index of the IDA Help. Press F1 for information on how to
use the Help Index.
IDA on the Web A submenu with Internet links related to the IDA Simulation
Environment and IDA application
Mail support... Display Mail Support dialog that facilitates sending e-mail messages to
the support groups for IDA Modeler and IDA applications.
About
Display information about the IDA Modeler, version and license.
13.7.11.1.
Mail support
The Mail Support dialog box allows user to send e-mail messages to IDA support group and
to support groups of IDA applications.
To display Mail Support dialog, select Help | Mail support... menu item.

Mail support dialog
Subject
Select one of predefined subjects (question, proposal, bug report) or type your own
subject.
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Application
If your message is concerning an IDA application, select this application. Your message
will be sent to the support group of the selected application.
If you select IDA Modeler, your message will be sent to the IDA support group
Attach files
A list of documents to be attached to the message. By default, all open IDA systems are
included.
To add a document, click on the Add... button and select a file. If you select an IDA
system (a file with extension .idm), all files that form the system will be attached (the
source files are not attached if they are stored separately).
To exclude documents, select them in the list box and click on Remove. Alternatively
click Remove all to clean the list of attachment.
Solver files
Check this box to attach the IDA Solver's input and output files.
Ask for confirmation
If this box is checked, the program will ask for confirmation for every attached file. This
may be useful if your IDA system contains large output files (with extension .prn).
Message
Type your message here. The program will automatically append some information about
program version and license.
Send
The Mail Support program compresses the attached files and call the mail software
installed on your computer. Press Send button in the displayed dialog.
Save
Use this button if you have no e-mail installed on your computer.
The Mail Support program compresses the attached files, writes the message to a file, and
displays this file. You have to copy this file and the compressed attachment and send them
manually.
The first lines of the saved message contain instruction how to send it.
13.7.12.

About IDA dialog

The About IDA dialog displays information about the IDA Modeler, version and license.
These data should be included in bug reports.
To access the dialog, select the Help | About IDA menu item.

About IDA dialog
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The Toolbar

The Toolbar is situated (by default) at the top of The Main Window, below The Menu Bar. It
contains buttons for frequently used functions. When the cursor is placed on a button, The
Status Bar displays the button’s function.
The Toolbar may be hidden in order to free space in the main window.
To hide the Toolbar

Select the Options | Toolbar menu item
or click the toolbar with the right mouse button and select Hide from the toolbar's shortcut
menu.
To restore the hidden toolbar

Select the Options | Toolbar menu item.
To change the position of the toolbar in the Main Window

Click the toolbar with the right mouse button and select Top, Left, or Right from the
toolbar's shortcut menu.
13.7.14.

The Status Bar

The Status Bar is situated at the bottom of The Main Window. It is frequently used for
displaying help texts and messages to the user. For example, it shows a short explanation of
the pointed field in forms or dialogs.
If something is not clear, look in the status bar first
The Status Bar may be hidden in order to free space in the main window.
To display or hide the Status Bar

Select the Options | Status bar menu item
13.7.15.

Property Page

The property page is a window that shows some properties of the currently selected object.
The usage and the contents of the property page is determined by IDA applications.
The property page may be enabled or disabled.
To enable or disable the Property Page

Select the Options | Property Page menu item
13.7.16.

Messages

When executing the user commands, the IDA Modeler may produce status messages and
diagnostic messages.
The status messages describe what IDA Modeler is currently doing. They are shown in the
Status bar.
The diagnostic messages that require immediate response are displayed in the pop-up message
boxes.
Other messages are displayed in the Log window.
13.7.17.

Log Window

The Log window shows the messages produced while the last user command was executed.
• To see the data object that contains the reason for a message
Select the message with the cursor
Press Enter or select Show source from the Shortcut menu.
Note: This works only for messages that are related to some data object

• To get an explanation to a message
Select the message with the cursor
Press F1 or select Help from the Shortcut menu.
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• To save the messages in file
Select Save messages from the Shortcut menu.
• To clear the message and hide the window
Select Clear messages from the Shortcut menu.
• To resize the Log window
Drag the border with the mouse.
13.7.18.

Pop-up Messages

The diagnostic messages that require immediate response are displayed in pop-up message
boxes.
The user should select an appropriate solution by clicking on a button and/or selecting a
variant from the list of solutions.
For an explanation, press F1 or click on the Help button.
13.7.19.

Shortcut menu

Clicking with the right mouse button in a window will display a menu with appropriate
alternatives. Most of these alternatives are also available via the Menu bar.
The content of the shortcut menu depends on what is pointed by the cursor or selected in the
window.
• The Object menu
a) Right click on an object, either graphical or a member of a list or outline (except when the
object is one of several selected)
b)

or select an object and right click in any place with the Shift key pressed

c)

or (for lists and outlines only) select the object and press Shift+Return.

The Object menu contains operations appropriate to the pointed object. The list of alternatives
depends on the nature of the object. Here is the full list of alternatives supported by IDA SE.
The applications may add more alternatives.
Expand
For outlines only. Open the node.
Object name
Rename the object
Open
Open the object with the standard view
Open with...
Submenu with the list of available views
Rename
Rename the object
Convert to resource
Define a new object type
New resource
Define a new resource of the same type
Load from database
Load a resource from the database
Write to database
Store a resource to the database
Mapping
Submenu with Mapping tools
Binding...
Set the boundary conditions
Monitor
Add the variable to the list of monitored variables
Edit
Edit the line, text or symbol
Properties
Change the graphical attributes of the object
Replace
Replace the object with some other object
• The Pane menu
Right click on the background of a graphical window (outside any visible object) or right click on a graphical
window with the Ctrl key pressed.

The Pane menu includes the copy/paste operations, Insert menu and list of views
from the View menu. The Paste operation is treated as Paste Here: the pasted objects
will be inserted at the cursor position.
• The Multiple selection menu
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Select more than one graphical object and right click on one of them.
The Multiple selection menu contain copy/paste operations and the connect operation.

• The Log window menu

Right click on the background of the Log window.

• The File menu
Right click on the background of the Main window (outside any child window)
13.7.20.

Dialogs in IDA

Here is the list of dialogs in IDA.
Click here to see the application-specific dialogs.
New document
Form properties
Print options
Insert component
Insert field
Insert shape/text
Element properties
Field properties
Diagram properties
Object name
Connect
Create new resource
Load resource from database
Calendar
Time slice
Source Table Editor
Monitor window
About IDA
Mail Support
Most dialogs contain the standard buttons:
OK
Accept the selection and close the dialog
Cancel
Abort all changes and close the dialog
Help
Show the help information about the dialog (alternatively press F1)
13.8.
13.8.1.

Diagnostic messages
Can not create a math model

As a result of earlier reported errors IDA Modeler failed to create a math model of the
physical system. Correct the errors and try again. If no other errors were reported please
inform the distributor of the application.
13.8.2.

Mapped or calculated parameter value is out of range

The value proved to be out of range after assignment or calculation. To handle the problem
the user must either change the value of master parameter (specified as source) or sever
mapping.
13.8.3.

Parameter or variable is out of range

The value of a parameter or a variable proved to be out of range. Just change the wrong value.
If you are sure that the value is correct inform the developer of the application so that the
range would be changed.
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Missing value of parameter

A value of the parameter must be specified before attempt to build a math model. Doubleclicking on the message will put the cursor on the corresponding slot.
13.8.5.

Missing subobject

Required object was deleted. Either restore it (e.g. insert such object or load a previous saved
version of the system), or change the system so that it can do without such object (e.g. change
mapping).
13.8.6.

Resource not found

Probably resource name was unwary changed. Double-click on message and change the
parameter value (select from list, or load from database, or create a new resource) so that the
value refers to an existing resource.
13.8.7.

Invalid number of objects

A number of such objects (e.g. layers in a wall construction) are restricted. Double-click the
message and add or delete some objects to comply with the range.
13.8.8.

No document path in source object

The source object must be an input file, but no file name is specified. Double click on the
message and specify a filename or select an existing file.
13.8.9.

An error when searching a subobject

An additional message to explain circumstances for the previous error.
13.8.10.

Rank error in previous results

Previously calculated results are very suspicious: they are beyond range.
13.8.11.

Unknown variable in the end file

Probably the parts of IDA application contradict to each other (libname.eo file and
libname.dll are of different versions).
13.8.12.

Erroneous end value

IDA Solver error: a string produced instead of number. Make sure you have enough memory
and disk space.
13.8.13.

The result file is missing

IDA Solver failed to produce final results. Probably the cause was reported earlier, or the
User interrupted IDA Solver, or there is not enough space on the hard disk.
13.8.14.

The log file is missing

IDA Solver failed to produce file with messages. Probably there is not enough space on the
hard disk, or disk is write protected, or Solver failed to start.
13.8.15.

The plot file is missing

IDA Solver failed to produce file with the results during the calculated period, though those
results were requested. Probably there is not enough space on the hard disk.
13.8.16.

Unable to compose report

Requested report can’t be composed: no data available. That can happen either if IDA Solver
failed to start or it failed to produce result files.
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Unable to insert

The object of this type can’t be inserted there (e.g., a window can’t be inserted into a
radiator).
13.8.18.

Paste failed

Paste failed because of an earlier reported error. If no other error was reported, contact with
the developer of IDA Modeler.
13.8.19.

Unable to run solver

Microsoft Windows failed to run file idakrn.dll and gave the message after colon. Try to
understand it.
Probable cause
Way of correction
File idakrn.dll not found. Copy the file into a proper place or change path in
Autoexec.bat.
Insufficient memory

Close unnecessary applications.

Insufficient disk space

Delete some old or unnecessary files from your disk.

13.8.20.

No default form

Attempt to open selected object failed because IDA Modeler doesn’t know what form must be
used. There are 4 possibilities:
1. Open outline. Look at the object as on the tree with the branches, that opens dynamically.
2. Create new. A missing form can be created on the spot and saved for further usage. In the
dialog opened one can select those parameters, variables and interfaces of the object, that
must be shown. By default all the parameters and interfaces are selected, but no variables.
Selected items are in the right box, deselected are in the left one. Select items your want to
move to another box and then click on an arrow. Click on the Create button after selecting
and deselecting was completed. A new form will appear. One can save it, and further on
use as a default form for the object.
3. Browse. Try to find the file with an appropriate form. That makes sense only when you
are sure, that such file exists somewhere in another directory, or when a form for the other
object can be used for this object also.
4. Cancel.
13.8.21.

Saving an identical resource in a database

You want to save a new resource to a database, but there are one or several identical resources
with other names in the database. These resources can be used instead of the new one. Click
Yes if you still want to add the resource to the database, or No if you changed your mind.
13.8.22.

Replacing a resource in a database

You want to save a new resource to a database, but there is a resource with the same name
and of the same type as the new one. If you click Yes, this resource will be replaced with the
new one. Click No, if you want to keep the old resource in the database. If you want have
both resources in the database, rename the new one before saving.
13.8.23.

The object was not written to a database

You wanted to save the object to a database. Some problems have occurred when saving it’s
subobject (probably, that was reported). The subobject wasn’t saved, so the object can’t be
saved also.
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13.8.24.
The object in a database is corrupted: the value of the parameter not
found
Some information is missing in the database, or the value, that points to the information, is
erroneous. The database is corrupted. Try to recover uncorrupted copy of the database.
13.8.25.

Do you want to disconnect the connection?

You are editing a connection line that connects two objects. You have tried to remove an
endpoint of the line. This point is on the border of an object. Make yourself clear:
What do you want?

What to do

To disconnect the object

Select Yes. Then the connection will be severed. The
connection line will have a loose end, which can be
connected to another object.

Just to improve a form of the
line

Select No. Then the chosen point will disappear. The next
point on the connection line will be moved to the object
border (if necessary) and become the endpoint. The
connection will be kept.

Nothing, that was a mistake

Select Cancel.

13.8.26.

Renaming of an automatically created object

You are trying to rename the object that has been created automatically. Be careful: there can
be references to it you don’t know about.
13.8.27.

The plot file contains an unexpected number of data series

An attempt to show a plot diagram of a data object failed, because of an unexpected number
of columns in the plot file. This number must be the same as the number of variables
(requested plot lines) in the data object.
If the problem occurs with a file that is standard in the used application, then a wrong
filename is specified. Open the object and replace file name with the right one.
In case of user-defined file, one can also change a number of variables, that must be shown.
13.8.28.

The plot file contains no column with the specified name

That can happen, when the plot file has the format with named columns. An attempt to show a
plot diagram of a data object failed, because the named column (or columns) is missing in the
plot file. There is a list of variables in the data object, and for each variable must be a column
with the same name in the plot file. Mind, that an opposite correspondence is not necessary: a
plot file can contain some extra column names, they causes no problem.
Possible cause

What to do

An output file is corrupted.

Replace the output file with the uncorrupted one, or open it as
a text file and correct column names. If nothing of this is
possible

A wrong plot file is specified
in the input data object

Open the object form and replace file name with the right
one.
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Open it as a text file and correct column names. See the IDA
application's documentation about the format of source files.

Incorrect variable names in the Click the object, open a dialog and edit the list, delete missing
user defined input object (not variables and add those you wish to see (be sure they are
applicable for climate).
present in the plot file).
13.8.29.

Can't find the source file

The source file (e.g. climate file) is missing, though it must be. Probably, it was lost during
copying. Move the file to the proper place, or specify another file for the source object (e.g.
open the object's form and type in a new file name).
13.8.30.

The value is not a resource

You are trying to look at the details of a resource, but what you have is just an ersatz. It has
no details, though works correctly. Make up your mind:
What do you want? What to do
I just want to see
details.

Sorry, no details. Just click Cancel.

I want to edit this
thing.

An ersatz can’t be edited. First you must replace it with a true
resource. There are 3 options for the resource:

13.8.31.

A resource, that is
already used

Click Cancel, then click the button to the
right of the ersatz and select a resource
from the list below.

A new ready-made
resource

Click Load from database, and select
an appropriate resource there.

A brand new
resource

Click Create new. Then the dialog
Create new resource will be opened at
your disposal, and you can make a
resource whatever you wish.

Wrong values!

The values you have entered must obey some requirements. Look for these requirements in
the dialog you are in and enter the right values!
13.8.32.

Unknown object type

You make an attempt to open a document that was created in a non-standard extended version
of the used IDA application. Additional components were used. Communicate with the
document’s authors and ask them for missing components.
13.8.33.

Unable delete the resource: it is used

You make an attempt to delete the resource. But it is used at least once. Delete canceled,
otherwise the model would be corrupted. Click View to see where the resource is used,
otherwise just click OK or Cancel.
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Index
Acausal, 190
acausal (visible) connections, 190
Active Beam, 136
Advanced, 216
advanced level, 155
aggregate, 164
Air flow in zone, 170
air handling aggregate, 163
Air handling system, 120
air quality measurement, 169
air temperature, 128
air temperatures at floor and ceiling, 167
Airborne heat flow into zone, 171
airflow, 164
Application, 180
Arange Icons, 242
ASHRAE, 119
attributes, 185, 231
balance, 206, 207
balcony, 146, 147, 148
Batch, 226
boiler, 119
Boundary, 195
Box, 227, 237
building, 101, 102, 114
building form, 101
building orientation, 108
building shape, 108
Button, 230, 232, 233
CAD import, 115
calendar, 200, 223, 224, 225
Cascade, 242
ceiling, 135, 152, 167
change, 222
Change database objects to resources, 157
chiller, 120
chiller (air), 122
Chimney, 150
Choice of simulation data, 105
climate data, 104
clipboard, 235, 236
close, 184, 186
Collapse, 206
comfort index, 168
Command, 226
component, 185, 187, 188
Component, 187, 188
conditions, 195
connect, 190
Connect, 190, 192
Connect objects via interface, 190
connection, 190, 191, 192
Connection, 192, 227
connection line, 191, 227
Connection via border of macro, 192
connections, 206, 207
controller setpoints, 128, 129
Convective internal mass, 133
cooling coil, 120, 122
cooling device, 139
copy, 189, 210
Copy, 235, 236
create, 183, 218
cursor, 233
Cut, 236
Data object, 185, 189, 227
database, 156, 157
Database, 219, 220, 221
database object, 157

Database object in IDA Indoor Climate and Energy, 156
daylight level, 169
Default settings, 116
delete, 188, 238, 239
Delete, 236
deselect, 234
diagram, 162, 163, 164, 165, 166, 167, 168, 169
Diagram, 205, 212
dialog, 99, 102, 103, 104, 112, 113, 143, 144, 145, 154,
157, 158, 159, 162, 231, 232
Dialog, 187, 188, 196, 197, 202, 207, 224, 225, 230,
231, 246
Dialog for choice of output, 162
Dialog for controller setpoints, 129
Dialog for energy price, 112
Dialog for glass construction, 143
Dialog for internal shading, 145
Dialog for location, 102
Dialog for material data, 154
Dialog for schedule, 157
Dialog for surface, 154
Dialog for Wall definition, 153
Dialog for wind profile, 104
Directed operative temperatures, 170
Disconnect, 192, 194
Disconnect a composite connection, 192
document, 183, 184
door, 149
Drag, 236
Drop, 236
edit, 109, 124, 135, 138, 140, 146, 160, 161, 222
Edit, 211, 222, 237, 240
Edit a cooling device, 138
Edit a occupant load, 130
Edit a profile, 160
Edit a water radiator water radiator, 139
Edit an external shading, 146
edit floor plan, 113
Edit objects on a surface, 135
Edit position of zone in floor plan, 113
Edit temperature depending input, 124
Edit the shape and orientation of the building, 108
Editor, 205
Electric radiator, 141
Element, 189, 230, 231, 232
empty, 108
energy meter, 112
energy price, 112, 113
energy totals, 171
equipment load, 133
exhaust fan, 120
existing, 183, 184
exit, 184
expand, 206
Fanger, 168
Field, 226, 228, 229, 230, 231, 232
file, 195, 196, 197
File, 239, 240
Find, 240
Fllor level dialog, 114
floor, 135, 152, 167
Floor Heat, 138
form, 101, 102, 104, 108, 109, 112, 122, 125, 126, 127,
128, 130, 132, 133, 142, 143, 146, 147, 148, 149,
152, 156, 222, 223
Form, 203, 217
Form for balcony, 147
Form for choice of schedule, 122
Form for climate data, 103
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Form for cooling coil, 122
Form for energy meter, 112
Form for equipment load, 133
Form for heat exchanger, 123
Form for heating coil, 121
Form for IDA-resources, 156
Form for lights, 132
Form for opening (door), 149
Form for project data, 108
Form for wall, 151
Form for window, 142
Form for zone, 125
forms, 99
FTX-system, 120
geometry, 97, 98, 114, 135, 136
Geometry, 205
Geometry in ICE, 97
glass, 143, 144
glass construction, 143, 144
glass definition, 143
Go to line, 240
Graphical elements, 226, 227
graphics, 231
Grid, 237
Ground conditions, 111
heat balance, 166
heat exchanger, 120, 123
heater (air), 121
heating coil, 120, 121
Help, 242
Hierarchy, 185
Hierarchy of Data objects, 185
ICE application, 97
IDA Indoor Climate and Energy, 97
IDA-resources, 156
IFC mapping, 115
initial guess, 195
insert, 237
Insert, 187, 188, 230, 231, 241
inspector, 206, 207
interface, 190, 191
Interface, 185, 239
interfaces, 206, 207
Intersecting zones, 176
introduction, 179
Label, 228
language, 226
Language, 226
Leak, 150, 151
leaks, 119
library, 222
lights, 132
line, 237, 238
List field, 229
Load, 219, 220
location, 102, 103
Log, 244, 245
log file, 226
Macro object, 188
mail, 242, 243
Mail, 242
main temperature, 165
main window, 239
Make a resource a database object, 157
Make an object a resource, 157
mapping, 221
marquee, 146, 147
material, 154
material data, 154
mathematical level, 182
menu, 239, 240, 241, 242, 245, 246
menu bar, 239
message, 245
messages, 244, 245
Messages, 244
Metafile, 209

Missing construction, 175
Model, 185
Modeling, 182, 183
Monitor, 201, 202
Monitor Variables, 202
move, 234, 235, 237, 238, 239
multi-system project, 183
name, 184, 185, 186, 222
Name, 184
new, 183, 184, 218, 219, 222, 230
New, 187, 241
Nice connection line, 191
object, 99, 100, 135, 136, 156, 157, 185, 186, 189, 190
Object, 241
Objects in ICE (in alphabetical order), 99
Objects in ICE (in hierarchical order), 100
occupant load, 130
open, 183, 186
Open, 183, 186
opening, 149
Operative temperatures, 129
options, 210, 241, 242
Options, 210
Outline, 205
output, 162, 198, 199
Overlapping features xxx and yyy, 178
parameter, 185, 218, 221, 224
Parameter, 194, 195
parameters, 206, 207
parent, 185, 186
Paste, 209, 210, 236
physical level, 182
place, 237
plot line, 211
Plug, 198
Polygon, 228
Polyline, 228
pop up, 245
PostScript, 209
power, 165
primary system, 164, 165
Primary system, 119, 120
print, 209, 210
problem, 199
profile, 160, 161
Profile, 224
program, 184, 226
project data, 108
property, 222, 231, 232
Property Page, 244
quit, 184
Refresh, 209
remove, 188
Rename, 185
replace, 189
Replace, 240
report, 162, 171, 174
Report, 205, 216, 223
reshape, 235
resize, 235
resource, 156, 157, 185, 216, 217, 218, 219, 220, 221
Resource, 218
response file, 226
ressure coefficients, 110
result, 162, 163, 164, 165, 166, 168, 169, 171, 174
Result AHU temperatures, 163
Result Air quality measurement, 169
Result Air temperatures at floor and ceiling, 167
Result Energy totals, 171
Result - Fanger comfort index, 168
Result - Free energy, 175
Result Heat balance, 166
Result - Lost work, 173
Result Main temperatures, 165
Result Primary system indicated power, 165
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Result Primary system temperatures, 164
Result - Used energy, 172
Result Zone temperatures and power, 174
Result Daylight level, 169
result diagram, 163, 164, 165, 166, 167, 168, 169
result report, 171, 174
results, 198
resultsReport, 223
Right button, 245
room, 125, 126, 128, 155
Run, 199
save, 184, 209, 220, 222
Save, 184
scale, 208
schedule, 157, 158, 159, 223, 224
schema, 155
Schema for zone (advanced level), 155
Scheme, 204
Scope, 217
screen, 146, 147
segment, 238, 239
select, 234
Selected exhaust air flow in zone xxx is out of the
recommended bounds, 176
selection, 234
Setpoint errors, 176
shading, 147, 148
shading (external), 146
shading (internal), 145
Shading control, 147
Shading control is not used in xxx, 177
Shape, 226, 227
Shortcut, 245
side fins, 146, 147
Simulation, 199, 200, 201
simulation data, 105, 106
Simulation data, 199, 201
Simulation Results, 161
site plan, 108
Skylight, 148, 149
Snap, 237
source, 196
Source file, 195, 196
Soutce Table Dialog Box, 197
start, 195, 199, 200
status bar, 244
Stop, 201
Sturtup, 195
supply fan, 120
support, 242, 243
surface, 135, 154
surface editor, 135
Symbol, 226, 227, 231
Synthetic climate is only intended for periodic
simulations, 177
Table, 197
temperature, 164, 165, 167
temperature depending input, 124
temperatures, 130, 163, 174

template, 184, 216
Text, 205, 227, 228
The buildings form, 101
The building's geometry, 114
The object xxx is not inside yyy, 178
The shape of overlapping of adjacent zones ~S and ~S
is too complicate, 177
The size of the device was changed ..., 177
The synthetic climate does not correspond to the
selected simulation time, 177
The wall between zones xxx ans yyy is defined with
different construction, 177
The zone ceiling is above the roof, 177
Thermal mass, 134
Tile Horizontal, 242
Tile Vertical, 242
Time Slice, 225
Timestep, 200
Tool, 241
toolbar, 244
Unable to create a zone from non-adjacent IFC spaces,
177
Unproper features, 176
wall, 135, 152, 153
Wall part, 151
wall-U, 176
variable, 194
Variable, 185, 193, 194, 201, 202
variables, 206, 207
water radiator, 141
waterborne, 139
Web, 242
Vector, 191
Vector interfaces, 191
Weights, 119
Well-posed problem, 199
vertex, 238, 239
view, 186, 187, 209, 210
View, 192, 203, 240
View of the connections between two objects, 192
wildcard, 226
wind profile, 104, 105
window, 142, 143, 146
Window, 242, 244, 245
Windows Metafile, 209
wizard level, 182
Wrong temperatures, 176
zone, 125, 126, 127, 128, 135, 155
Zone airflow exceeds 20 air changes per hour, 176
zone cooling, 136
Zone defaults, 117
Zone equipment for cooling and heating, 136
zone heating, 136
zone power, 174
zone temperatures, 174
zone temperatures and power, 174
zoom, 208, 209
Zoom, 208, 209
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